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1 Introduction

● Using this guide

● The printer's main features

● The printer's main components [4020]

● The printer's main components [4520]

● The front panel

● Printer software
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Using this guide
This guide is for the HP Designjet 4020/4520 Printer series and the HP Designjet 4520 Stacker, for
information about the HP Designjet 4520 Scanner, please refer to the Scanner User's Reference Guide
in a separate document.

Using your printer (on CD) and the Quick Reference Guide (on paper) are organized into the following
chapters:

Introduction
This chapter provides a brief introduction to the printer and its documentation for new users.

How do I ...
These chapters help you to carry out various procedures such as loading paper or changing an ink
cartridge. Many of these procedures are illustrated with drawings, and some are also illustrated with
animations (in Using your printer only, on CD).

The problem is ...
These chapters help you to solve problems that may occur while printing. The most complete source
for this type of information is in Using your printer, on CD.

Tell me about ...
Available in Using your printer only, on CD, these chapters contain reference information, including the
specifications of the printer, and the part numbers of paper types, ink supplies and other accessories.

Index
In addition to the table of contents, there is an alphabetical index to help you to find topics quickly.

The printer's main features
Your printer is a color inkjet printer designed for printing high-quality images on paper up to 42 in (1.06
m) wide. Some major features of the printer are shown below:

● Production speeds of up to 1.5 m²/min (16 ft²/min), using HP Universal Inkjet Bond Paper with
the Fast print quality option and the Optimize for Lines and Text option

● Print resolution of up to 2400×1200 optimized dpi, from a 1200×1200 dpi input, using the Best print
quality option, the Maximum Detail and Optimize for Images options and glossy paper (for more
information on print resolution, see Functional specifications on page 208)

● Unattended printing using 400 cm³ color ink cartridges and 775 cm³ black cartridges (see Ink
cartridges on page 196), and rolls of paper up to 300 ft (90 m) in length

NOTE: The HP Designjet 4520 series supports rolls of paper up to 575 ft (175 m) in length.

● High productivity features such as multi-file job submitting, job previewing, queueing and nesting
using the printer's Embedded Web Server (see Tell me about... (Embedded Web Server topics)
on page 187)
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● Ink and paper usage information is available from the front panel, and on the Web from the
Embedded Web Server

● Accurate and consistent color reproduction features:

◦ Press emulations for U.S., European and Japanese standards; and color monitor RGB
emulations (see Color emulation modes on page 190)

◦ Automatic color calibration

The printer's main components [4020]
NOTE: This topic applies to the HP Designjet 4020 Printer series only.

The following front and rear views of the printer illustrate the main components.

Front view

1. Ink cartridge

2. Platen

3. Printhead carriage

4. Printhead

5. Printhead cleaner

6. Front panel

7. Spindle

8. Blue removable paper stop

9. Bin

10. Ink cartridge drawer
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11. Spindle lever

12. Paper load lever

Rear view

1. Power socket and on/off switch

2. Sockets for communication cables and optional accessories

The printer's main components [4520]
NOTE: This topic applies to the HP Designjet 4520 Printer series only.

The following front and rear views of the printer illustrate the main components.
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Front view

1. Ink cartridges

2. Platen

3. Printhead carriage

4. Printhead

5. Printhead cleaner

6. Front panel

7. Paper load lever (roll 1)

8. Spindle

9. Paper load lever (roll 2)

10. Bin

11. Spindle drawer (roll 1)

12. Spindle drawer (roll 2)
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Front view with optional stacker

Rear view

1. Power socket and on/off switch

2. Sockets for communication cables and optional accessories
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The front panel
Your printer's front panel is located on the front of the printer, on the right-hand side. It has the following
important functions:

● It must be used to perform certain operations, such as loading and unloading paper.

● It can display up-to-date information about the status of the printer, the ink cartridges, the
printheads, the paper, the print jobs, etc.

● It can provide guidance in using the printer.

● It displays warning and error messages when appropriate.

● It can be used to change the values of printer settings and thus change the operation of the printer.
However, settings in the printer are overridden by settings in the Embedded Web Server or in the
driver.

The front panel has the following components:

1. The display area, where information, icons and menus are displayed.

2. The Power key turns the printer on and off. If the printer is in sleep mode, this key will wake it up.

3. The Power light is off when the printer is off; amber when the printer is in sleep mode; green when
the printer is on; green and flashing when the printer is in transition between off and on.

4. The Form Feed and Cut key normally ejects the sheet (if a sheet is loaded) or advances and cuts
the roll (if a roll is loaded). However, if the printer is waiting for more pages to be nested, this key
cancels the waiting time and prints the available pages immediately.

5. The Reset key restarts the printer (as if it were switched off and switched on again). You will need
an implement with a narrow tip to operate the Reset key.

6. The Cancel key cancels the current operation. It is often used to stop printing the current print job.

7. The Status light is off when the printer is not ready to print: it may be off, or in sleep mode. It is
green when the printer is ready and idle; green and flashing when the printer is busy; amber when
a serious internal error has occurred; amber and flashing when awaiting human attention.

8. The Up key moves to the previous item in a list, or increases a numerical value.

9. The Select key selects the item that is currently highlighted.
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10. The Back key goes back to the previous menu. If you press it repeatedly, or hold it down, you will
soon return to the main menu.

11. The Down key moves to the next item in a list, or decreases a numerical value.

To highlight an item in the front panel, press the Up or Down key until the item is highlighted.

To select an item in the front panel, first highlight it and then press the Select key.

The four front-panel icons are all found in the main menu. If you need to select or highlight an icon, and
you don't see the icons in the front panel, press the Back key until you can see them.

When this guide shows a series of front panel items like this: Item1 > Item2 > Item3, it means that you
should select Item1, then select Item2, then select Item3.

Information about specific uses of the front panel can be found throughout this guide.

Printer software
The following software is provided with your printer:

● The Embedded Web Server, which runs in the printer and enables you to use a Web browser on
any computer to submit and manage print jobs, and check ink levels and printer status

● The HP-GL/2 and HP RTL driver for Windows

● The PostScript driver for Windows (HP Designjet 4020ps and 4520ps only)

● The PostScript driver for Mac OS X (HP Designjet 4020ps and 4520ps only)
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2 How do I... (software setup topics)

● Choose which connection method to use

● Connect to a network (Windows)

● Connect directly to a computer (Windows)

● Uninstall the printer driver (Windows)

● Connect to a network (Mac OS X)

● Connect directly to a computer (Mac OS X)

● Uninstall the printer software (Mac OS X)
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Choose which connection method to use
The following methods can be used to connect your printer.

Connection type Speed Cable length Other factors

Gigabit Ethernet Very fast; varies according to
network traffic

Long (100 m=328 ft.) Requires extra equipment
(switches).

Jetdirect print server (optional
accessory)

Moderate; varies according to
network traffic

Long (100 m=328 ft.) Requires extra equipment
(switches).

Useful for wireless or
AppleTalk connection, and for
Novell printing.

FireWire (IEEE 1394) Very fast Short (4.5 m=15 ft.) Windows only.

USB 2.0 (optional accessory) Very fast Short (5 m=16 ft.)

NOTE: The speed of any network connection depends on all components used in the network, which
may include network interface cards, hubs, routers, switches and cables. If any one of these components
is not capable of high-speed operation, you will find that you have a low-speed connection. The speed
of your network connection can also be affected by the total amount of traffic from other devices on the
network.

NOTE: There are various possible ways of connecting the printer to a network, but only one of them
can be active at a time; with the exception of the Jetdirect print server, which can be active at the same
time as one other network connection.

Connect to a network (Windows)
Once the network cable is connected and the printer is powered up, it automatically obtains an IP
address. You need to perform the following steps to configure the printer in the network:

1. Go to the front panel and select the  icon.

2. The front panel will display some information, including the printer's IP address. Make a note of the
IP address (16.23.61.128 in this example).

3. Insert the HP Start-Up Kit CD into your computer. If the CD does not autorun, run the
AUTORUN.EXE program in the root folder of the CD.

4. Click the Express Network Install button.

5. The configuration program will look for printers connected to your network. When the search has
finished, a list of printers will be displayed. Identify your printer by its IP address and select it from
the list.

If your printer does not appear in the list, select Help me find my network printer and click
Next. In the next screen, give the IP address of your printer.
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Connect directly to a computer (Windows)
You can connect your printer directly to a computer without going through a network, by using the
printer's built-in FireWire (IEEE 1394) socket or the optional USB 2.0 socket.

1. Do not connect the computer to the printer yet. You must first install the printer driver software
on the computer, as follows.

2. Insert the HP Start-Up Kit CD into your CD drive. If the CD does not autorun, run the
AUTORUN.EXE program in the root folder of the CD.

3. Click the Custom Install button.

4. Follow the instructions on your screen to set up the printer. The following notes will help you to
understand the screens and make appropriate choices.

● When asked how the printer is connected, choose Connected directly to this computer.
Then select a FireWire (IEEE 1394) or USB connection.

● When prompted to do so, connect your computer to the printer, using a FireWire or USB cable.
Ensure that the printer is switched on.

● You may see a message warning that the installer will have to communicate through the
Windows Firewall to search for printers on the network. As you intend to set up a direct
connection, select Continue installation without searching the network and click Next.

Uninstall the printer driver (Windows)
1. Insert the HP Start-Up Kit CD into your CD drive. If the CD does not autorun, run the

AUTORUN.EXE program in the root folder of the CD.

2. Choose Modify Installation, and follow the instructions on your screen to uninstall the printer
driver.

Connect to a network (Mac OS X)
You can connect your printer to a network under Mac OS X using the following methods:

● Bonjour/Rendezvous

● TCP/IP

Before you begin, make sure the following are true:

● The printer is set up and on.

● The Ethernet hub or router is on and functioning properly.

● All computers on the network are on and connected to the network.

● The printer is connected to the network.

Now you can proceed to install the printer driver and connect your printer:

1. Insert the HP Start-Up Kit CD into your CD drive.

2. Open the CD icon on your desktop.

3. Open the Mac OS X HP Designjet Installer.

4. Follow the instructions on your screen.
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5. When the printer driver has been installed, the HP Printer Setup Assistant will start automatically,
to set up a connection to your printer. Follow the instructions on your screen.

6. When the HP Printer Setup Assistant has finished, you can remove the CD from the CD drive.

The HP Printer Setup Assistant can be run separately from the CD, if the printer driver is already
installed.

NOTE: If the HP Printer Setup Assistant does not detect your printer or if you prefer not to set up the
connection manually, click the checkbox My printer is not on the list below the list of discovered
printers in the HP Printer Setup Assistant, and then click Continue to get instructions on how to set up
the connection manually.

Connect directly to a computer (Mac OS X)
You can connect your printer directly to a computer without going through a network, by using the
printer's optional USB 2.0 socket. First, install the printer driver on the computer:

1. Make sure the printer is powered off.

2. Insert the HP Start-Up Kit CD into your CD drive.

3. Open the CD icon on your desktop.

4. Open the Mac OS X HP Designjet Installer.

5. Follow the instructions on your screen.

6. When the printer driver has been installed, the HP Printer Setup Assistant will start automatically,
to set up a connection to your printer. Connect the USB cable, turn on the printer and then follow
the instructions on your screen.

7. When the HP Printer Setup Assistant has finished, you can remove the CD from the CD drive.

The HP Printer Setup Assistant can be run separately from the CD, if the printer driver is already
installed.

NOTE: If the HP Printer Setup Assistant does not detect your printer or if you prefer not to set up the
connection manually, click the checkbox My printer is not on the list below the list of discovered
printers in the HP Printer Setup Assistant, then click Continue to get instructions on how to set up the
connection manually.

Sharing the printer
If your computer is connected to a network, you can make your directly-connected printer available to
other computers on the same network.

1. Double-click the System Preferences icon in the Dock menu bar on your desktop.

2. Enable printer sharing by going to Sharing > Services > Printer Sharing.

3. From the client computer, the printer will now be displayed in the list of available printers in the
Printer Setup Utility.

Uninstall the printer software (Mac OS X)
1. Insert the HP Start-Up Kit CD into your CD drive.

2. Open the CD icon on your desktop.
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3. Open the Mac OS X HP Designjet Installer icon.

4. Select Uninstall, and follow the instructions on your screen to uninstall the printer software.

To delete the print queue:

● Under Mac OS X 10.5: from the system preferences, select the Print & Fax dialog. Select the name
of the printer and click the – button.

● Under Mac OS X 10.4 there are two ways of deleting the print queue:

◦ from the system preferences, select the Printing pane of the Print & Fax dialog. Select the
name of the printer and click the – button.

◦ from the Printer Setup Utility, select the name of the printer and click the Delete icon.

ENWW Uninstall the printer software (Mac OS X) 13
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3 How do I... (printer operation topics)

● Switch on and off

● Restart

● Change the language of the front panel

● Access the Embedded Web Server

● Change the language of the Embedded Web Server

● Password-protect the Embedded Web Server

● Request E-mail notification of specific error conditions

● Set the date and time

● Change the sleep mode setting

● Turn off the buzzer

● Change the front panel contrast

● Change the units of measurement

● Adjust for altitude
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Switch on and off
TIP: The printer is Energy Star compliant and can be left switched on without wasting energy. Leaving
it on improves response time and overall system reliability. When the printer has not been used for a
certain period of time (5 minutes by default), it will save power by going into sleep mode. However, any
interaction with the printer will return it to active mode, and it can resume printing immediately.

If you wish to switch the printer on or off, the normal and recommended method is to use the Power key
on the front panel.

When you switch off the printer this way, the printheads are automatically stored with the printhead
cleaners, which prevents them from drying out.

However, if you plan to leave the printer switched off for a long period of time, you are recommended
to switch it off using the Power key, and then also switch off the power switch at the rear.

To switch it back on later, use the power switch at the rear, and then the Power key.

When the printer is switched on, it will take some time to initialize itself. This time is about three minutes
for the HP Designjet 4020 series, and about three and a half minutes for the Designjet 4520 series.

Restart
In some circumstances you may be advised to restart the printer. Please proceed as follows:

1. Press the Power key on the front panel to switch the printer off, wait a few moments, then press
the Power key again. This should cause the printer to restart; if not, continue with step 2.

2. Use the Reset key on the front panel. You will need an implement with a narrow tip to operate
the Reset key. This normally has the same effect as step 1 above, but may work if step 1 does not.

3. If neither of the above steps seem to have any effect, you should switch off the printer using the
power switch at the rear of the printer.

4. Remove the power cord from the power socket.

5. Wait for 10 seconds.
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6. Insert the power cord into the power socket and switch on the printer using the power switch.

7. Check that the Power light on the front panel comes on. If it does not, use the Power key to switch
the printer on.

Change the language of the front panel
There are two possible ways to change the language of the front-panel menus and messages.

● If you can understand the current front panel language, go to the front panel and select the  icon,
then Printer configuration > Front panel options > Select language.

● If you cannot understand the current front panel language, start with the printer powered off. At the
front panel, press the Select key and hold it down. While holding the Select key down, press the
Power key and hold it down. Continue to hold down both keys until the green light on the left side
of the front panel starts flashing, then release both keys. You can expect a delay of about one
second. If the green light starts flashing without any delay, you may need to start again.

Whichever method you used, the language selection menu should now appear on the front panel.

Highlight your preferred language, then press the Select key.

Access the Embedded Web Server
The Embedded Web Server enables you to manage your printer and your printing jobs remotely using
an ordinary Web browser running on any computer.

NOTE: In order to use the Embedded Web Server, you must have a TCP/IP connection to your printer.
If you have a Novell or USB connection to your printer, you will not be able to use the Embedded Web
Server.

The following browsers are known to be compatible with the Embedded Web Server:

● Internet Explorer 5.5 or later, for Windows

● Firefox 1.5 or later

● Safari.

There are several ways to access the Embedded Web Server:

● On any computer, open your Web browser and give the address of your printer. You can find out
the address of your printer (starting with http:) from the front panel, by highlighting the  icon.

● Select Status of my printer or Manage my printer's queue from the Services tab of your Windows
printer driver, or from the Services panel of your Mac OS printer driver.

If you have followed these instructions but failed to get through to the Embedded Web Server, see I
cannot access the Embedded Web Server from my browser on page 182.
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Change the language of the Embedded Web Server
The Embedded Web Server can work in the following languages: English, Portuguese, Spanish,
Catalan, French, Italian, German, Simplified Chinese, Traditional Chinese, Korean and Japanese. It will
choose whichever language you have specified in your Web browser's options. If you have specified a
language that it cannot support, it will work in English.

To change the language, you must change your Web browser's language setting. For example, in
Internet Explorer version 6, go to the Tools menu and select Internet Options, Languages. Then
ensure that the language you want is at the top of the list in the dialog box.

To complete the change, you must close and reopen your Web browser.

Password-protect the Embedded Web Server
You can restrict access to the Embedded Web Server from the Security page, which you can find in the
Settings tab. There are several different ways to restrict access.

● If you set the administrator username and password, that username and password will be required
in order to perform the following operations.

◦ Cancel, delete or preview a job in the job queue

◦ Delete a stored job

◦ Clear accounting information

◦ Change the printer settings on the Device Setup page

◦ Update the printer's firmware

◦ Change the printer's date and time

◦ Change security settings

◦ View protected printer information pages

NOTE: If you forget the administrator password, see I cannot access the Embedded Web Server
from my browser on page 182.

● If you set the guest username and password, that username and password will be required in order
to perform all other operations with the Embedded Web Server.

● You can completely disable Ethernet or FireWire access to the printer.
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Request E-mail notification of specific error conditions
1. In the Embedded Web Server, go to the E-mail server page, which you can find in the Settings tab,

and ensure that the following fields are correctly filled in:

● SMTP server: the IP address of the outgoing mail server (SMTP) that will process all E-mail
messages from the printer. If the mail server requires authentication, E-mail notifications will
not work.

● Printer E-mail address: each E-mail message sent by the printer must include a return
address, which does not need to be a real, functional E-mail address, but it should be unique,
so that recipients of the message can identify the printer that sent it.

2. Go to the Notification page, which is also in the Settings tab.

3. Click New to request new notifications (or Edit to edit notifications that have already been set up).
Then fill in the E-mail addresses to which notifications should be sent, and select the incidents that
should result in notification messages. Initially the most commonly-specified incidents are shown;
to see all the possibilities, click Show all alerts.

Set the date and time
The printer's date and time settings are mainly useful in job accounting (see Request accounting data
by E-mail on page 108). These settings can be changed using the Embedded Web Server or the
printer's front panel.

● In the Embedded Web Server, go to the Settings tab and select Configuration, then Date &
Time.

● At the front panel, select the  icon, then Printer configuration > Date and time options > Set
date or Set time or Set time zone.

If you are using the HP Designjet 4020 Printer series, and you find that these options are not available,
please download the latest firmware revision (see Update my printer's firmware on page 116).

Change the sleep mode setting
If the printer is left switched on but unused for a certain period of time, it will go automatically into sleep
mode to save power. To change the time the printer waits before it goes into sleep mode, go to the front
panel and select the  icon, then Printer configuration > Sleep mode wait time. Highlight the wait
time you want, then press the Select key.

Turn off the buzzer
To turn the printer's buzzer on or off, go to the front panel and select the  icon, then Printer
configuration > Front panel options > Enable buzzer.

Change the front panel contrast
To change the contrast of the front panel display, select the  icon, then Printer configuration > Front
panel options > Select display contrast, and choose a value using the Up or Down key. Press the
Select key to set the value you have chosen.
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Change the units of measurement
To change the units of measurement displayed in the front panel, select the  icon, then Printer
configuration > Select units, and select English or Metric.

The units of measurement can also be changed in the Embedded Web Server.

Adjust for altitude
Your printer will work better if you tell it roughly at what altitude it is. To set the altitude, go to the front
panel and select the  icon, then Printer configuration > Select altitude, and select a range.
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4 How do I... (paper topics)

● Load a roll onto the spindle [4020]

● Load a roll into the printer [4020]

● Unload a roll from the printer [4020]

● Load a single sheet [4020]

● Unload a single sheet [4020]

● Load a roll onto the spindle [4520]

● Load a roll into the printer [4520]

● Unload a roll from the printer [4520]

● Trim the paper with the manual cutter [4520]

● View information about the paper

● Download media profiles

● Use non-HP paper

● Cancel the drying time

● Change the drying time

ENWW 21

Pa
pe

r



Load a roll onto the spindle [4020]
NOTE: This topic applies to the HP Designjet 4020 Printer series only.

1. Make sure the printer wheels are locked (the brake lever is pressed down) to prevent the printer
from moving.

2. Lower the spindle lever.

3. Remove the right-hand end of the spindle (1) from the printer, then move it to the right in order to
extract the other end (2). Do not insert your fingers into the spindle supports during the removal
process.

The spindle has a stop at each end to keep the roll in position. The stop at the left-hand end can
be removed to mount a new roll, it slides along the spindle to hold rolls of different widths.

4. Remove the blue paper stop (1) from the left-hand end of the spindle.

5. If your roll has a three-inch cardboard core, ensure that the core adaptors supplied with the printer
have been installed. See below:

6. The roll may be very long; rest the spindle horizontally on a table and load the roll on the table.
Bear in mind that you may need two people to handle it.
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7. Slide the new roll onto the spindle. Make sure the paper type is oriented as shown. If it is not,
remove the roll, turn it 180 degrees and slide it back on to the spindle.

NOTE: There is also a label on the spindle showing the correct orientation.

Ensure there is no space between the roll and the fixed stop at the right-hand end of the spindle.

8. Put the blue paper stop on to the upper end of the spindle, and push it towards the end of the roll.

9. Ensure the blue paper stop is pushed in as far as it will go, without using excessive force.

10. With the blue paper stop on the left, slide the spindle into the printer left and then right as shown
by the arrows 1 and 2.
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11. To make sure that the right end of the spindle is in place, check that the spindle lever is in its top
position (horizontal). You can move the lever yourself if necessary.

If you are a regular user of different paper types, you can change rolls more quickly if you pre-load rolls
of different paper types on different spindles. Extra spindles are available for purchase.

Load a roll into the printer [4020]
NOTE: This topic applies to the HP Designjet 4020 Printer series only.

To start this procedure you need to have a roll loaded on the spindle. See Load a roll onto the spindle
[4020] on page 22.

1. At the printer's front panel, select the  icon, then Paper load > Load roll.

2. If the printer is unable to detect the paper type, the front panel displays a list of paper types.

Select the paper type you are using. If it is not clear which you should select, see Supported paper
types on page 200.

3. Select the roll length if known.

NOTE: Specifying the roll length is not obligatory (you can select Unknown) and has no effect
on the printer's behavior. However, if you give the length, subsequently the printer will keep track
of how much paper is used, and will keep you informed of the remaining length (assuming that the
value you originally gave was accurate).
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4. Wait until the front panel prompts you to open the window.

5. Lift the paper load lever.

6. Pull out approximately 1 m (3 ft.) of paper.

7. Carefully insert the leading edge of the roll above the black roller.

WARNING! Take care not to touch the rubber wheels on the platen while loading paper: they
may rotate and trap skin, hair or clothing.

WARNING! Take care not to push your fingers inside the printer's paper path. It is not designed
to accommodate fingers, and the results may be painful.
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8. Wait until the paper emerges from the printer as shown below.

NOTE: If you have an unexpected problem at any stage of the paper loading process, see The
paper cannot be loaded successfully [4020] on page 130.

9. Align the right-hand edge of the paper with the blue line and the left edge of the half-circle on the
right of the platen.

10. When the paper is correctly aligned with the blue line and half-circle, lower the paper load lever.

11. The front panel prompts you to wind excess paper onto the roll.
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12. Wind the excess paper onto the roll. Use the paper stop to turn the roll in the direction shown.

13. Lower the window.

14. The front panel again prompts you to wind excess paper onto the roll.

15. The printer will perform a color calibration, if it has not already calibrated the paper type you are
using, and if color calibration is turned on. See Perform color calibration on page 68.

16. The front panel displays the Ready message and the printer is ready to print.

Unload a roll from the printer [4020]
NOTE: This topic applies to the HP Designjet 4020 Printer series only.

Before unloading a roll, check whether the end of the roll is still attached to the spindle, and follow the
appropriate procedure as described below.

The normal procedure (roll attached to spindle)
If the end of the roll is still attached to the spindle, use the following procedure.

1. At the printer's front panel, select the  icon, then Paper unload > Unload roll.

2. The paper will normally be removed from the printer.

If the paper is not automatically removed from the printer, the front panel will prompt you to lift the
paper load lever and turn the paper stop (1) by hand until the paper is removed from the printer.
When you have finished, lower the paper load lever.

3. Turn the paper stop (1) by hand, until the paper is fully wound onto the roll.

4. Press the Select key.

ENWW Unload a roll from the printer [4020] 27

Pa
pe

r



5. Press the spindle lever (2) down and remove the roll from the printer, pulling out the right-hand end
first. Do not insert your fingers into the spindle supports during the removal process.

Roll detached from spindle
If the end of the roll is visible but no longer attached to the spindle:

1. If you have already selected Paper unload at the front panel, press the Cancel key to cancel that
procedure.

2. Lift the paper load lever. If the front panel displays a warning about the lever, ignore it.

3. Pull out the paper from the front of the printer.

4. Press the spindle lever down and remove the empty spindle from the printer, pulling out the right-
hand end first. Do not insert your fingers into the spindle supports during the removal process.

5. Lower the paper load lever.

6. If the front panel is displaying a warning message, press the Select key to clear it.

No paper visible
If the end of the roll has entirely disappeared into the printer:

1. Press the Form Feed and Cut key on the front panel, and the remaining paper will be ejected.

2. Press the spindle lever down and remove the empty spindle from the printer, pulling out the right-
hand end first. Do not insert your fingers into the spindle supports during the removal process.

Load a single sheet [4020]
NOTE: This topic applies to the HP Designjet 4020 Printer series only.

Any loaded roll must be unloaded before loading a sheet. See Unload a roll from the printer [4020]
on page 27.

1. At the printer's front panel, select the  icon, then Paper load > Load sheet.

NOTE: As usual, you must press the Select key to select this option.

28 Chapter 4   How do I... (paper topics) ENWW

Paper



2. If the printer is unable to detect the paper type, the front panel displays a list of paper types.

Select the paper type you are using. If it is not clear which you should select, see Supported paper
types on page 200.

3. Wait until the front panel prompts you to open the window.

4. Lift the paper load lever.

5. Insert the sheet into the printer as shown below.
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6. Insert the sheet until it reappears from the printer as shown below.

WARNING! Take care not to touch the rubber wheels on the platen while loading paper: they
may rotate and trap skin, hair or clothing.

WARNING! Take care not to push your fingers inside the printer's paper path. It is not designed
to accommodate fingers, and the results may be painful.

7. Pull the sheet out from the top.

8. Align the leading edge of the sheet with the metal bar in the platen.

Align the right-hand edge of the sheet with the left edge of the half-circle on the platen, as shown
below.

9. Lower the window.
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10. Lower the paper load lever.

11. If the paper has been loaded successfully, the front panel displays the Ready message and the
printer is ready to print. If something has gone wrong (paper mispositioned or misaligned), follow
the instructions on the front panel.

NOTE: When printing on sheet paper you are recommended to select Normal or Best print quality,
see Change the print quality on page 57.

NOTE: If you have an unexpected problem at any stage of the paper loading process, see The paper
cannot be loaded successfully [4020] on page 130.

Unload a single sheet [4020]
NOTE: This topic applies to the HP Designjet 4020 Printer series only.

At the printer's front panel, select the icon, then Paper unload > Unload sheet.

To give the ink time to dry, the printer holds the sheet for some time (see Drying time on page 201).

Load a roll onto the spindle [4520]
NOTE: This topic applies to the HP Designjet 4520 Printer series only.

1. Push the grey button and remove the blue paper stop from the spindle.

2. If your roll has a three-inch cardboard core, ensure that the core adaptors supplied with the printer
have been installed. See below:

3. The roll may be long and heavy; rest the spindle horizontally on a table and load the roll on the
table. Bear in mind that you may need two people to handle it.
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4. Slide the new roll onto the spindle. Make sure the paper type is oriented as shown. If it is not,
remove the roll, turn it 180 degrees and slide it back on to the spindle.

NOTE: There is also a diagram on the outside face of each paper stop showing the correct
orientation.

5. Press the roll towards the black paper stop until it clicks into place.

NOTE: If you have difficulty with this, try turning the spindle to a vertical position, so that gravity
presses the roll against the stop.

6. Ensure there is no space between the roll and the black stop.

7. Put the blue paper stop on to the other end of the spindle, and push it towards the end of the roll.
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8. Ensure there is no space between the roll and the blue stop.

If you are a regular user of different paper types, you can change rolls more quickly if you pre-load rolls
of different paper types on different spindles. Extra spindles are available for purchase.

Load a roll into the printer [4520]
NOTE: This topic applies to the HP Designjet 4520 Printer series only.

To start this procedure you need to have a roll loaded on the spindle. See Load a roll onto the spindle
[4520] on page 31.

1. At the printer's front panel, select the  icon, then Paper load > Load roll 1 or Load roll 2.

TIP: This step is optional. You may skip it and start the loading process without using the front
panel, by pulling out the drawer as shown below.
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2. Lift the drawer upwards a little, then pull it towards you.

3. Load the roll and spindle into the drawer. Hold the roll as shown by the paper stops at each end of
the spindle. Try to avoid touching the paper surface.

CAUTION: Two people may be needed to load a heavy roll.

4. Lift the paper load lever. Lift the upper lever if you are loading the upper roll, the lower lever if you
are loading the lower roll.

5. Make sure that the leading edge of the paper is free from wrinkles, tears and excessive curl, as
these defects may cause a paper jam. If necessary, trim the leading edge before loading (see Trim
the paper with the manual cutter [4520] on page 38).
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6. Feed the paper from roll 1 onto the drawer 1 platen. Align the paper parallel with the blue lines on
the right side of the platen. The paper edge does not need to be aligned exactly with a specific blue
line, but between the two outer lines.

7. Feed the paper for a few centimeters more after the printer beeps, then turn the roller backwards
to tension the paper correctly.

8. Lower the paper load lever.

9. Push the drawer back into position.
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10. Wind excess paper back onto the roll. Use the paper stop to turn the roll in the direction shown.

11. If the printer is unable to detect the paper type, the front panel displays a list of paper types.

Select the paper type you are using. If it is not clear which you should select, see Supported paper
types on page 200.

12. The front panel asks you to specify the length of the roll you are loading. After you have done so,
it will start to load the roll.

NOTE: Specifying the roll length is not obligatory (you can select Unknown) and has no effect
on the printer's behavior. However, if you give the length, subsequently the printer will keep track
of how much paper is used, and will keep you informed of the remaining length (assuming that the
value you originally gave was accurate).

13. If the printer's first attempt to load the roll is unsuccessful, it will automatically wind the paper
backwards and try again without requiring any assistance.

If this second attempt is unsuccessful, it will try a third time, but this time the front panel will request
your assistance.

14. The printer will perform a color calibration, if it has not already calibrated the paper type you are
using, and if color calibration is turned on. See Perform color calibration on page 68.

15. The front panel displays the Ready message and the printer is ready to print.

Unload a roll from the printer [4520]
NOTE: This topic applies to the HP Designjet 4520 Printer series only.
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Before unloading a roll, check whether the end of the roll is still attached to the spindle, and follow the
appropriate procedure as described below.

The normal procedure (roll attached to spindle)
If the end of the roll is still attached to the spindle, use the following procedure.

1. At the printer's front panel, select the  icon, then Paper unload > Unload roll 1 or Unload roll
2.

TIP: Alternatively, you may start the unloading process without using the front panel, by lifting
and then lowering the paper load lever.

2. The paper will normally be removed from the printer.

If the paper is not automatically removed from the printer, the front panel will prompt you to lift the
paper load lever and turn the paper stop by hand until the paper is removed from the printer. When
you have finished, lower the paper load lever.

3. Turn the paper stop by hand, until the paper is fully wound onto the roll.

4. Press the Select key.

5. Lift the drawer upwards a little, then pull it towards you.

6. Remove the roll from the printer, pulling out the right-hand end first. Do not insert your fingers into
the spindle supports during the removal process.

Roll detached from spindle
If the end of the roll is visible but no longer attached to the spindle:

1. If you have already selected Paper unload at the front panel, press the Cancel key to cancel that
procedure.

2. Lift the paper load lever.

3. Lift the drive pinch lever.

If the front panel displays a warning about the levers, ignore it.

4. Pull out the paper from the front of the printer.
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5. Lift the drawer upwards a little, then pull it towards you.

6. Remove the empty spindle from the printer, pulling out the right-hand end first. Do not insert your
fingers into the spindle supports during the removal process.

7. Lower the drive pinch and paper load levers.

8. If the front panel is displaying a warning message, press the Select key to clear it.

No paper visible
If the end of the roll has entirely disappeared into the printer:

1. Press the Form Feed and Cut key on the front panel, and the remaining paper will be ejected.

2. Lift the drawer upwards a little, then pull it towards you.

3. Remove the empty spindle from the printer, pulling out the right-hand end first. Do not insert your
fingers into the spindle supports during the removal process.

Trim the paper with the manual cutter [4520]
NOTE: This topic applies to the HP Designjet 4520 Printer series only.

The manual cutter can be used to trim the leading edge of the paper if it is dirty or uneven. This helps
to avoid paper jams during loading.

1. Open the drawer of the roll that you intend to trim.

2. With your left hand, pull the leading edge of the paper over the top of the roll and then down in front
of the drawer.

3. Find the manual cutter on the right side of the drawer.
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4. With your right hand, grip the cutter and rotate it as shown on the cutter's top cover, to make the
initial cut, then pull it gently across the paper.

5. Remove the cut-off piece of paper.

6. Rotate the spindle backwards to move the paper edge out of the way.
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7. Return the cutter to the right-hand side of the drawer.

View information about the paper
At the printer's front panel, select the  or icon, then Paper information, then choose the paper
source on which you want information.

You will see the following information displayed on the front panel:

● The roll or sheet status

NOTE: The HP Designjet 4520 Printer series prints on roll paper only.

● The paper manufacturer's name

● The paper type you have selected

● The width of the paper in millimeters (estimated by the printer)

● The length of the paper in millimeters (estimated by the printer)

If no paper is loaded, the message Out of paper is displayed.

The same information (apart from the manufacturer's name) is displayed on the Embedded Web
Server's Supplies page.

Download media profiles
Each supported paper type has its own characteristics. For optimum print quality, the printer changes
the way it prints on each different paper type. For example, some may need more ink and some may
require a longer drying time. So the printer must be given a description of the requirements of each
paper type. This description is called the “media profile”. The media profile contains the ICC profile,
which describes the color characteristics of the paper; it also contains information on other
characteristics and requirements of the paper that are not directly related to color. Existing media profiles
for your printer are already installed in the printer's software.

However, you would find it inconvenient to scroll through a list of all paper types available for your printer,
so your printer contains media profiles for only the most commonly used paper types. If you buy a paper
type for which your printer has no media profile, you will find that you cannot select that paper type in
the front panel. To download the correct media profile, go to:

● http://www.hp.com/go/4020/paperpresets/ for the HP Designjet 4020 series

● http://www.hp.com/go/4520/paperpresets/ for the HP Designjet 4520 series
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If you do not find the media profile you want on the Web, you may find that it has been added to the
latest firmware for your printer. You can check the firmware release notes for information. See Update
my printer's firmware on page 116.

Use non-HP paper
HP's own paper types have been fully tested with the printer and can be expected to give the best print
quality.

However, you can print on paper from any manufacturer. In that case, you should select (in the front
panel) the HP paper type that is most similar to the paper you will be using. If in doubt, try several different
HP paper type settings, and choose the one that provides you with the best print quality. If results are
not entirely satisfactory with any paper type setting, see General advice on page 150.

Cancel the drying time
Press the Form Feed and Cut key (1) on the front panel.

CAUTION: A print that has had insufficient time to dry can suffer from quality problems.

Change the drying time
You may wish to change the drying time setting to suit special printing conditions.

Select the  icon, then Select drying time. You can select Extended, Optimal, Reduced or None.

See Drying time on page 201.
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5 How do I... (print job topics)

● Submit a job with the Embedded Web Server

● Save a job

● Print a saved job

● Cancel a job

● Manage the print queue

● Nest jobs to save roll paper

● Unattended printing/overnight printing
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Submit a job with the Embedded Web Server
1. Access the Embedded Web Server (see Access the Embedded Web Server on page 17).

2. Go to the Submit job page.

3. Select Add files and browse your computer to select the file to print.

NOTE: Submitting a job to be printed via the Embedded Web Server does not require you to have
the printer driver nor the file's native application installed on your computer.

4. If you want to submit more than one file, select the Add files button again and select the file(s) you
want. You can change the order of multiple files by using the Move Up and Move Down buttons.

5. If you want to change the order in which the files are submitted, use the buttons on the right side
of the screen to move the file up or down in priority.

6. If you are printing multiple copies of a document, by default all copies of page 1 will be printed,
then all copies of page 2, and so on. Check the box called Collate under the Control Settings if
you want one copy of the whole document to be printed, then the next copy of the whole document,
and so on.

NOTE: When Collate is used, each copy of the document is sent to the printer as a separate job.

7. Set the rest of the job options.

If you leave an option set to Default, the setting saved in the job will be used. If the job contains
no setting for that option, the setting in the printer will be used. The setting in the printer can be
changed from the front panel, or in some cases from the Device Setup page in the Embedded Web
Server.

8. Click the Print button at the top of the screen once you have selected all your settings.

Save a job
If you intend to reprint a job later with some changes to the job settings (such as size or quality), you
can store the job inside your printer so that you will not need to resubmit it later.

NOTE: If you want to reprint a job without changes, you can do that from the print queue without
needing to save the job.
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You can save a job only while submitting it for printing:

1. Access the Embedded Web Server (see Access the Embedded Web Server on page 17).

2. Go to the Submit job page.

3. Browse your computer and select the file to print.

4. If you want to submit more than one file, click the Add another file button to add another file. All
files submitted together will have the same job settings.

NOTE: If you are using Windows and Internet Explorer, you can click the Add files button and
select multiple files at once.

5. In the job options, check the Store job in printer option.

6. Set the rest of the job options.

7. Click the Print button.

Print a saved job
1. Access the Embedded Web Server (see Access the Embedded Web Server on page 17).

2. Go to the Stored jobs page.

3. Select the job or jobs that you want to print, using the check box beside each job name.

4. Click the Print button to print the job with the original settings, or Advanced Print to change the
settings.

Cancel a job
A job can be canceled from the front panel by pressing the Cancel key, or from the Embedded Web
Server by selecting the job and clicking the Cancel icon.

The printer advances the paper as though the print were finished.

NOTE: A multi-page job or a big file may take longer to stop printing than other files.

Manage the print queue
Your printer can store pages in a queue while it is printing the current page. The queue may contain
pages from more than one job.

NOTE: This information applies only if you are using one of the drivers that came with your printer or
the Embedded Web Server to submit printing jobs.

Turning on and off the queue
You can turn off the queue from the Web server (Settings tab > Device setup > Queue), or from the
front panel: select the  icon and then Job management options > Enable queue. Use the front
panel to select On or Off.

The When To Start Printing options
NOTE: The When To Start Printing options cannot be used with PostScript jobs.
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You can select at what point you want to print a file you have in the queue. From the Web server, select
the Settings tab > Device setup > When to start printing; or, from the front panel, select the  icon
and then Job management options > When to start printing.

There are three options you can select:

● When After Processing is selected, the printer waits until the whole page has been processed
and then it starts to print. This is the slowest setting but offers the best print quality.

● When Immediately is selected, the printer prints the page as it is processed. This is the quickest
setting, but the printer may stop halfway through a print to process data. This setting is not
recommended for complex images with dense color.

● When Optimized is selected (this is the default setting), the printer calculates the best time to begin
printing the page. It is usually the best compromise between the After Processing and
Immediately settings.

Identifying a job in the queue
The best way to look at the queue is in the Embedded Web Server (Information > Job queue) where
you can manage the queue and get full information on every job (by clicking the name of the file).

However, you can also manage the queue from the front panel. To do so, select the  icon and
then Job queue, where you can see a list of the jobs in the queue.

Each has an identifier, comprising:

<position in queue>: <image name>

The job currently being printed is in position 0. The next job to be printed is in position 1, the previous
job already printed is in position -1.

Prioritizing a job in the queue
When using the Embedded Web Server, to make any job in the print queue the next one to be printed,
select it and choose Reprint or if using the front panel select the option: Move to front.

If nesting is turned on, the prioritized job may still be nested with others. If you really want this job to be
printed next, and on its own on the roll, first turn nesting off and then move it to the front of the queue
as described above.

Deleting a job from the queue
Under normal circumstances, there is no need to delete a job from the queue after printing it, as it will
just fall off the end of the queue as more files are sent. However, if you have sent a file in error, and
want to avoid any chance of it being reprinted, you can simply delete it, by selecting it and choosing
Delete (in the Embedded Web Server or in the front panel).

In the same way, you can delete a job that has not been printed yet.

If the job is currently being printed (Status = printing in the Web server, or its queue position is 0 in the
front panel), and you want both to cancel the job and to delete it, first click the Cancel icon in the Web
server, or press the Cancel key on the front panel, and then delete it from the queue.

Making copies of a job in the queue
To make extra copies of any job in the queue, select the job in the Embedded Web Server and click
the Reprint icon, then specify the number of copies you want. The job will be moved to the top of the
queue.
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You can also do this from the front panel: select the job and choose Copies, then specify the number
of copies required and press the Select key. This overrides any value set by your software.

NOTE: If Rotate was On when you sent the file, every copy will be rotated.

If the job has already been printed, use Move to front to move it to the top of the queue.

Understanding job status
These are the possible job status messages, approximately in the order in which they may be seen:

● receiving: the printer is receiving the job from the computer

● waiting to process: the job has been received by the printer and is waiting to be rendered (for
jobs submitted through the Embedded Web Server only)

● processing: the printer is parsing and rendering the job

● preparing to print: the printer is performing writing system checks before printing the job

● waiting to print: the job is waiting for the print engine to become free to proceed with printing

● waiting for nest: the printer is set up with Nesting=On and is waiting for other jobs in order to
complete the nest and proceed with printing

● on hold: the job was sent with the on hold for preview option and is on hold

NOTE: If the printer hangs up while printing a job, and the queue facility is turned on, the partially
printed job will appear in the queue as on hold when the printer is next turned on. When you resume
the job, it will start printing at the page at which it was interrupted.

● on hold for paper: the job can't be printed because the paper it needs is not loaded in the printer
(see An “on hold for paper” message [4520] on page 178): load the required paper and then
click Continue to resume the job

● on hold for accounting: the job can't be printed because the printer requires all jobs to have an
account ID: enter the account ID and then click Continue to resume the job

● printing

● drying

● cutting paper

● ejecting page

● canceling: the job is being canceled, but will remain in the printer job queue

● deleting: the job is being deleted from the printer

● printed

● canceled: the job has been canceled by the printer

● canceled by user

● empty job: the job does not contain anything to print

Nest jobs to save roll paper
Nesting means placing pages side by side on the paper, rather than one after the other. This is done to
avoid wasting paper.
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1. Direction of paper flow

2. Nesting off

3. Nesting on

4. Paper saved by nesting

When does the printer try to nest pages?
When the following are true:

● The printer is loaded with roll paper, not sheet paper.

● In the front panel's Job Management menu or the Embedded Web Server's Device Setup page,
Nest is On.

● The queue must be set to On.

Which pages can be nested?
All pages can be nested, unless they are so large that two of them cannot fit side by side on the roll, or
unless there are too many of them to fit into the remaining length of the roll. A single group of nested
pages cannot be split between two rolls.

Which pages qualify for nesting?
In order to be in the same nest, the individual pages must be compatible in all of the following ways:

● All pages must have the same print quality setting (Fast, Normal or Best).

● Pages must be all Optimized for Drawings/Text or all Optimized for Images.

● The Maximum Detail setting must be the same on all pages.

● The Margins setting must be the same for all pages (Extended or Normal).

● The Mirror setting must be the same for all pages.

● The Rendering Intent must be the same for all pages.

● The Cutter setting must be the same for all pages.

● The color adjustment settings must be the same for all pages. These are known as Advanced Color
Settings in the Windows driver, and CMYK Settings in the Mac OS driver.

● Pages must be all color, or all grayscale: not some in color and some in grayscale.
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● All pages must be in one or other of the following two groups (the two groups cannot be mixed in
the same nest):

◦ HP-GL/2 and HP RTL, CALS G4

◦ PostScript, PDF, TIFF, JPEG

● JPEG, TIFF and CALS G4 pages with resolutions greater than 300 dpi may not nest with other
pages in some cases.

How long does the printer wait for another file?
So that the printer can make the best nest possible, it waits after a file has been received to check
whether a subsequent page will nest with it or with pages already in the queue. This waiting period is
the nest wait time; the factory default nest wait time is two minutes. This means that the printer waits
for up to two minutes after the last file is received before printing the final nest. You can change this
waiting time from the printer's front panel: select the icon, then Job management options > Nest
options > Select wait time. The available range is 1 to 99 minutes.

While the printer is waiting for nesting to time out, it displays the remaining time on the front panel. You
can print the nest (cancel the nest wait) by pressing the Cancel key.

Unattended printing/overnight printing
The HP Designjet 4520 Printer series, with multiple rolls and optional stacker, plus robust and consistent
image quality, is perfect for long unattended printing jobs.

Here are some recommendations to help you deal with a long queue of printing jobs.

● If feasible, use brand-new long rolls of paper.

● If you want to print on partly-used rolls, you can check the paper type and the remaining length in
the Embedded Web Server or in the front panel, to confirm that you have enough paper to print all
your jobs.

NOTE: Information on the remaining length is available only if you told the printer the length of
the roll when you loaded it.

● Check that you have paper wide enough to print all of your jobs (any jobs that are too wide will be
put “on hold for paper”).

● Check the ink levels remaining in your ink cartridges.

● The standard bin is recommended only for less than 30 separate prints. The stacker can handle
up to 200 prints.

● When you have submitted your print jobs, you can use the Embedded Web Server from a remote
location to monitor their status.

● Drop detection should be set to Intensive.

● Drying time should be set to Optimal.

● We recommend the following settings, depending on the paper type and what kind of prints you
are making.

● Select the  icon, then Paper handling options > Roll switching options> Minimize roll
changes .
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Table 5-1  Recommended settings for unattended printing

Print type Print mode MaxDetail Optimized for Drying time Paper types

Lines Normal Off Lines Optimal Coated, Bond,
Heavyweight
Coated, Glossy

Lines and fills Normal On Lines Optimal Coated, Bond,
Heavyweight
Coated, Glossy

Maps Best On Images Optimal Coated,
Heavyweight
Coated, Glossy

Renderings,
photographs

Best On Images Optimal Coated,
Heavyweight
Coated, Glossy
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6 How do I... (stacker topics) [4520]

NOTE: This chapter applies to the HP Designjet 4520 Printer series only.

The stacker is an optional accessory for the HP Designjet 4520 Printer series. It stacks prints flat, on
top of one another, instead of letting them fall into the bin.

● Install the stacker

● Uninstall the stacker

● Change the temperature

● Change paper rolls while using the stacker

● Clean the exterior of the stacker

● Clean the stacker rollers

● Move or store the stacker
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Install the stacker
1. Connect the cables between the stacker and the printer.

2. Switch on the stacker.

3. Select the  icon on the printer's front panel, then Accessories > Stacker > Install stacker. The
front panel will prompt you to attach the stacker to the printer.

4. There are two latches on the stacker that engage with the printer deflectors. To attach the stacker
to the printer, attach first one side and then the other (because less force is required that way).

Some warm-up time is necessary, especially when the stacker has just been switched on.

NOTE: The stacker operates on cut sheets of paper. When it is switched on, the cutter is automatically
enabled. It cannot work if the cutter is turned off or if the printing material cannot be cut (canvas, for
example).

Uninstall the stacker
1. To uninstall the stacker, select the  icon on the printer's front panel, then Accessories >

Stacker > Uninstall stacker.

2. The front panel will then prompt you to detach the stacker from the printer. Pull the stacker from
one side to detach it on that side, then detach the other side.

3. Disconnect the stacker cables.

Change the temperature
NOTE: This option is only available if the stacker is installed on the printer.
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The stacker contains a heated roller to remove the curl from the paper. To change the temperature of
the roller, select the  icon on the printer's front panel, then Accessories > Stacker > Select
temperature level. There are three options:

● Normal is the default and recommended setting.

● High sets the roller to a higher temperature, which may be useful for particularly stiff paper.

● Low sets the roller to a lower temperature, which may be useful for paper with a particularly
sensitive coating.

Change paper rolls while using the stacker
1. Remove the stack of cut paper from the stacker in order to make the stacker easier to handle.

2. Detach the stacker from the printer: first one side, then the other.

3. Change the rolls in the normal way: see Unload a roll from the printer [4520] on page 36 and Load
a roll into the printer [4520] on page 33.

Clean the exterior of the stacker
See Clean the exterior of the printer on page 112.

Clean the stacker rollers
WARNING! The stacker becomes hot during use. Before cleaning, switch it off and give it time to cool.

Ink tends to stick to the main stacker roller and the small output rollers, which should therefore be cleaned
regularly using a fabric cloth dampened with water.

The frequency with which cleaning is needed depends to some extent on the paper type in use.

● For plain, coated or heavyweight coated paper, once a month may be sufficient.

● For translucent, vellum, glossy or natural tracing paper, cleaning may be required once a week
even with the slowest print modes.
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Move or store the stacker
Before moving or storing the stacker, take a couple of steps to reduce the amount of space it occupies.

1. Undo the screws at either side of the stacker tray, and let the tray hang vertically.

2. Remove the pin from each leg extension, and rotate the leg extension upwards.
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7 How do I... (image adjustment topics)

● Change the page size

● Create a custom page size

● Change the print quality

● Choose print quality settings

● Print at maximum speed

● Adjust the margins

● Print on oversize pages

● Print without added margins

● Select the orientation of the image

● Rotate an image

● Print a mirror image

● Scale an image

● Change the palette settings

● Change the treatment of overlapping lines

● Change the graphic language setting
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Change the page size
The page size can be specified in the following ways:

● Using a Windows printer driver: select the Paper/Quality tab, then Size is.

● Using a Mac OS printer driver: select Page Setup from the File menu, select your printer in the
Format for popup menu, then Paper Size.

NOTE: If there is no Page Setup in the File menu, select Print and then Paper Size.

● Using the Embedded Web Server: go to the Page Size section of the Submit Job page.

● Using the front panel: select the  icon, then Default printing options > Paper options > Select
paper size.

NOTE: If a page size is set with the printer driver or with the Embedded Web Server, it overrides the
page size set with the front panel.

Create a custom page size
You can create a custom page size using a printer driver or the Embedded Web Server.

NOTE: The ability to create custom page sizes will depend on the level of administration privileges
you have.

Using the HP-GL/2 and HP RTL printer driver for Windows
1. Select the Paper/Quality tab.

2. Press the Custom button.

3. Choose one of the selectable names (Custom 1 to Custom 5) for your custom page size.

4. Enter its width and length.

5. Press the OK button.

Using the PostScript printer driver for Windows
There are the following alternative ways to create a custom page size.

● In the driver dialog, click the Custom button in the Paper/Quality tab, then specify the name and
the dimensions of your new page size, then click Save to save your new page size. To see your
new custom size in the list of custom sizes, you need to exit the printer properties, then reenter
them (and use the More button if necessary).

NOTE: The driver will not allow you to create a paper size whose width exceeds its length.

● From the start menu, select Printers and Faxes, then from the File menu select Server
Properties. In the Forms tab, check the Create a new form box, specify the name and dimensions
of the new form, then click Save Form. In the driver dialog, your new custom size is now in the list
of sizes in the Paper/Quality tab (use the More button if necessary).

● In the PostScript driver dialog, select the Advanced tab, then the PostScript Custom Page Size
from the paper size list, then specify the paper dimensions, then click OK to save the new
dimensions of the PostScript Custom Page Size. Your new page size is saved until you exit your
current application, when it reverts to the default size. In the list of sizes in the Paper/Quality tab
you will see the PostScript Custom Page Size entry.
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Using the PostScript printer driver for Mac OS X
1. Select Page Setup from the File menu.

NOTE: If there is no Page Setup in the File menu, select Print.

2. Select Manage Custom Sizes at the end of the Paper Size list.

3. Press the New or + button.

4. Enter your choice of name for your custom page size.

5. Enter its width and length.

Using the Embedded Web Server
1. Go to the Page Size section of the Submit Job page.

2. Select the Custom option.

3. Choose the width and length of your desired page size.

Change the print quality
Your printer has three different print quality options: Best, Normal and Fast. There are also two
supplementary options that have an effect on print quality: Optimize for drawings/text or Optimize for
images, and Maximum detail. See Choose print quality settings on page 57 for guidance on choosing
among these options.

You can specify the print quality in the following ways:

● Using a Windows printer driver: go to the Print Quality section of the Paper/Quality tab.

● Using a Mac OS printer driver: go to the Image Quality panel.

● Using the Embedded Web Server: go to the Image Quality section of the Submit Job page.

● Using the front panel: select the  icon, then Default printing options > Image quality.

NOTE: If a print quality is set with the printer driver or with the Embedded Web Server, it overrides the
print quality setting from the front panel.

NOTE: You cannot change the print quality of pages that the printer is already receiving or has already
received (even if they have not started to print yet).

Choose print quality settings
The following table shows suggested print quality settings and paper types for various different kinds of
prints, assuming that you are using roll paper. You are not obliged to follow these suggestions, but you
may find them helpful.

If you are using sheet paper, you are recommended to set print quality to Best.

If you are not sure how to change the print quality settings, see Change the print quality on page 57.

NOTE: High-density images should be printed on heavier paper (heavyweight or glossy).
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Print content
Image quality settings Paper types

Print quality Optimized for Maximum detail

Lines (draft) Fast Drawings/text Off (or On for
higher quality,
lower speed)

Bright White

Bond Paper

Translucent materials*

Coated Paper

Lines Normal Drawings/text Off Bright White

Bond Paper

Translucent materials*

Coated Paper

Lines and fills (fast) Normal Drawings/text On Bright White

Bond Paper

Translucent materials*

Coated Paper

Heavyweight Coated Paper

Productivity Photo Gloss

Lines and fills Best Drawings/text Off Bright White

Bond Paper

Translucent materials*

Coated Paper

Heavyweight Coated Paper

Productivity Photo Gloss

Lines and images –
high quality maps

Best Drawings/text On Coated Paper

Heavyweight Coated Paper

Productivity Photo Gloss

In-store advertising Normal Images Off Coated Paper

Heavyweight Coated Paper

Productivity Photo Gloss
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Print content
Image quality settings Paper types

Print quality Optimized for Maximum detail

Renderings Best Images Off Heavyweight Coated Paper

Productivity Photo Gloss

Photographs Best Images Off Productivity Photo Gloss

* Translucent materials include Vellum, Translucent Bond, Natural Tracing Paper, Clear Film and Matte
Film.

For technical details of print resolution, see Functional specifications on page 208.

Print at maximum speed
There are two paper type settings in the front panel especially designed for printing at maximum speed.

Print content
Image quality settings Paper types (front panel)

Print quality Optimal for Maximum detail

Lines (draft) Fast Drawings/text Off Max Speed Bright White*

Max Speed Bond Paper†

* To use Max Speed Bright White, load HP Bright White Inkjet Bond Paper and select Max Speed Bright
White from the list of paper types in the front panel.

† To use Max Speed Bond Paper, load HP Universal Inkjet Bond Paper and select Max Speed Bond
Paper from the list of paper types in the front panel.

Adjust the margins
The printer margins determine the printable area of the page that can be used by your application. There
are three margin options: Small, Normal and Extended (see also Print without added margins
on page 60). For the dimensions of the margins, see Functional specifications on page 208.

You can specify the margins in the following ways:

● Using the Windows HP-GL/2 and HP RTL printer driver: Normal margins are selected by default.
To select the other options, select the Paper/Quality tab and press the Margins/Layout button.

● Using the Windows PostScript printer driver: select the Paper/Quality tab, then Size is. You select
the page size and the margins at the same time.
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● Using a Mac OS printer driver: select Page Setup from the File menu, then Paper Size. You select
the page size and the margins at the same time.

NOTE: If there is no Page Setup in the File menu, select Print and then Paper Size.

● Using the Embedded Web Server: select from the Margins list on the Submit Job page.

● With a firmware level of a least FW9, it is possible to reduce the nesting margins to 0. This can be
done via the front panel: Job management > Nesting options > Nest spacing. There are two
settings: Automatic (default) or 0. Selecting 0, it is possible for example to nest three A3 size
documents on a 36" roll.

● Using the front panel: select the  icon, then Default printing options > Paper options > Select
margins.

NOTE: If margins are set with the printer driver or with the Embedded Web Server, they override the
margins set with the front panel.

Print on oversize pages
For technical reasons, it is impossible to print an image that covers the full width or length of the paper.
There must always be a margin around the image. However, if you want to print, for example, an A3-
sized image with no margins around it, you can print on paper larger than A3 (leaving margins around
the image as usual), and then cut off the margins after printing.

Oversize page layouts are designed for this purpose. Each oversize page is large enough to
accommodate a standard paper size plus margins.

You can specify an oversize page layout in the following ways:

● Using the Windows HP-GL/2 and HP RTL printer driver: select the Paper/Quality tab and press
the Margins/Layout button, then select Oversize from the layout options.

● Using the Windows PostScript printer driver: select the Paper/Quality tab, then Size is. You select
the oversize page and the margins at the same time.

● Using a Mac OS X printer driver: select the paper size, and then margins options will appear. Select
the Oversize option.

● Using the Embedded Web Server: on the Submit Job page, select Oversize from the Margin layout
list.

● Using the front panel: select Default printing options > Paper options > Select layout >
Oversize.

When using oversize pages, you can select the width of the margins as usual (see Adjust the
margins on page 59).

See also Print without added margins on page 60.

Print without added margins
For technical reasons, it is impossible to print an image that covers the full width or length of the paper.
There must always be a margin around the image. However, if your image already contains adequate
margins (white space around the edges) then you can tell the printer not to add margins to the image
when printing it. In this case it will, in fact, clip the edges of your image, assuming that the edges contain
nothing that needs to be printed.
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You can request no added margins in the following ways:

● Using the Windows HP-GL/2 and HP RTL printer driver: select the Paper/Quality tab and press
the Margins/Layout button, then select Clip Contents By Margins from the layout options.

● Using the Windows PostScript printer driver: select the Paper/Quality tab, then Size is, and select
an oversize page. Press the Margins/Layout button, then select Clip Contents By Margins from
the layout options.

● Using the Embedded Web Server: on the Submit Job page, select Clip Contents By Margins from
the Margin layout list.

● Using the front panel: select Default printing options > Paper options > Select layout > Clip
contents by margins.

This option is not available from the Windows PostScript driver or the Mac OS drivers.

When using this option, you can select the width of the margins as usual (see Adjust the margins
on page 59). The printer continues to use margins: it just takes them out of the image instead of adding
them to the image.

Select the orientation of the image
The orientation of the image may be portrait or landscape. When you see it on screen:

● The height of a portrait image is greater than its width (a tall image).

● The width of a landscape image is greater than its height (a wide image).

You should select the orientation that your image has when you see it on screen. If you have a landscape
image and you select portrait, or if you have a portrait image and you select landscape, the image may
be clipped when printed.

You can select the orientation using a printer driver or the Embedded Web Server.

● Using the HP-GL/2 and HP RTL printer driver for Windows: go to the Orientation section of the
Finishing tab.

● Using the PostScript printer driver for Windows: go to the Orientation section of the Paper/Quality
tab.

● Using the PostScript printer driver for Mac OS: select Page Setup from the File menu, then go to
the Orientation section of the Page Attributes panel.

NOTE: If there is no Page Setup in the File menu, select Print and then Orientation.

● Using the Embedded Web Server: go to the Orientation section of the Submit Job page.
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Rotate an image
By default, images are printed with their shorter sides parallel to the leading edge of the paper, like this:

You may wish to rotate your images by 90 degrees in order to save paper, like this:

You can do this in the following ways:

● Using the HP-GL/2 and HP RTL printer driver for Windows: select the Finishing tab, then Rotate
by 90 degrees.

● Using the PostScript printer driver for Windows: select the Features tab, then Rotate by 90
degrees.

● Using a Mac OS printer driver: select the Finishing panel, then Rotate by 90 Degrees.

● Using the Embedded Web Server: select the Submit Job page, then Rotate.

● Using the front panel: select the  icon, then Default printing options > Paper options >
Rotate.

NOTE: If rotation is set with the printer driver or with the Embedded Web Server, it overrides the setting
in the front panel.

NOTE: When you rotate a job, the page length may be increased to avoid clipping, because the top
and bottom margins are usually larger than the side margins.

CAUTION: With either rolls or sheets, if you rotate an image to landscape whose original orientation
was portrait, the paper may not be wide enough for the image. For example, rotating a portrait D/A1-
size image on D/A1-size paper by 90 degrees will probably exceed the width of the paper. If you are
using the Embedded Web Server, the preview screen will confirm this with a warning triangle. If you are
using the HP Designjet 4520 Printer series, the job will be put “on hold for paper”.
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Autorotate
The HP-GL/2 and HP RTL printer driver provides an Autorotate option in the Paper/Quality tab, which
will automatically rotate by 90 degrees any oversized portrait images in order to save paper.

Print a mirror image
If you are using clear imaging paper, sometimes called backlit, you may want to print a mirror image of
your drawing, so that when the paper is lit from behind it is in the correct orientation. To do this without
changing the image in your application:

● Using the HP-GL/2 and HP RTL printer driver for Windows: select the Finishing tab, then Mirror
Image.

● Using the PostScript driver for Windows: select the Advanced tab, then Document Options,
Printer Features and set Mirror Image to On.

● Using a Mac OS printer driver: select the Finishing panel, then Mirror Image.

● Using the Embedded Web Server: select the Submit Job page, then Mirror image.

● Using the front panel: select the  icon, then Default printing options > Paper options > Enable
mirror image.

NOTE: If mirror image is set with the printer driver or with the Embedded Web Server, it overrides the
setting in the front panel.

Scale an image
You can send an image to the printer at a certain size but tell the printer to rescale it to a different size
(normally larger). This may be useful:

● If your software does not support large formats

● If your file is too large for the printer's memory—in this case you can reduce the page size in your
software and then scale it up again using the front panel option

You can rescale an image in the following ways:

● Using a Windows printer driver: select the Effects tab, then Resizing Options.

◦ The Print Document On option adjusts the image size to the page size selected for your
printer. For example, if you have selected ISO A2 as the page size and you print an A4-size
image, it will be enlarged to fit the A2 page. If the ISO A3 page size is selected, the printer
would reduce a larger image to fit the A3 size.

◦ The % of Normal Size (HP-GL/2 and HP RTL driver) or % of Actual Size option (PostScript
driver) enlarges the printable area of the original page by the percentage indicated and adds
the printer margins to make up the output page size.

● Using a Mac OS printer driver: select the Finishing panel, then Print Document on.

The driver adjusts the image size to the page size selected for your printer.

● Using the Embedded Web Server: select the Submit Job page, then Resizing.

● Using the front panel: select the  icon, then Default printing options > Paper options >
Scale.

If you are printing to a single sheet, you must ensure that the image can actually fit onto the page,
otherwise clipping will occur.
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Change the palette settings
You cannot change the Factory palette, but you can define Palettes A and B to be whatever you choose.

These palettes will be applied only to HP-GL/2 and HP RTL jobs with no software palette embedded.

NOTE: All HP-GL/2 and HP RTL jobs generated by the HP-GL/2 and HP RTL driver that comes with
the printer will include an embedded software palette, and thus any palette settings in the front panel
will be ignored.

To redefine Palette A:

1. Go to the front panel, select the  icon, then Default printing options > HP-GL/2 options >
Define palette > Palette A.

2. Scroll to the pen number you want to change and press Select.

3. You can see the current width assigned to this pen by selecting Width; for example Width=0.35
mm. If you want to change it:

4. Press Select.

5. Scroll to the width you want.

6. Press Select again.

7. Press Back to get to the previous menu: Color/Width. Otherwise, scroll to Color.

8. When you select Color, the current color assigned to the pen is displayed, for example
Color=110. If you want to change it:

9. Press Select.

10. Scroll to the color you want.

11. Press Select again.

12. Press Back to get to the previous menu.

13. When both width and color are correct, press Back.

14. Scroll to the next pen number you want to change, press Select and then repeat the above process.

15. When all pen definitions are correct, press Back to exit the menus.

NOTE: The palette you have just defined will take effect only when you select it to be the current
palette.

If you do not get the results you expect, see Pen settings seem to have no effect on page 165.
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Change the treatment of overlapping lines
The Merge setting controls the overlapping lines in an image. There are two settings, Off and On.

● If Merge is Off, where the lines cross only the color of the top line is printed.

● If Merge is On, where the lines cross the colors of the two lines are merged.

To turn Merge on, select the  icon, then Default printing options > HP-GL/2 options > Enable
merge. You can set the merge setting from your software in some applications. Settings in your software
override the front-panel settings.

NOTE: Merge settings have no effect on PostScript files.

Change the graphic language setting
Unless you are troubleshooting one of the problems mentioned below, you should not need to change
the default setting (Automatic), and you are not recommended to do so, because setting a specific
graphic language means that you will be able to print only files in that language.

To change the graphic language setting, select the  icon, then Default printing options > Select
graphics language, where the following options are available.

● Select Automatic to let the printer determine which type of file it is receiving. This setting works
for most software applications.

● Select HP-GL/2 if you are not working with PostScript files, and you have experienced image
position problems or timing problems.

● Select PS if you are printing only PostScript files and your PostScript jobs do not start with the
standard PostScript header (%!PS) and do not include PJL language switching commands.

Alternatively, select PS if you have experienced problems while downloading PostScript fonts. In
this case, please reselect Automatic after you have downloaded the fonts.

If you are downloading fonts over a USB connection, select the  icon, then Default printing
options > PS options > Select encoding > ASCII.

● Select TIFF, JPEG, PDF or CALS G4 only if you are sending a file of the appropriate type directly
to the printer without going through a printer driver. This is normally done only from the Embedded
Web Server, in which case the language setting is done by the Embedded Web Server and you
do not have to do it yourself.

NOTE: The PS and PDF options are available with PostScript printers only.
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8 How do I... (color topics)

● Perform color calibration

● Perform black point compensation

● Set the rendering intent

● Select the color emulation mode

● Produce matching prints from different HP Designjets

● Get accurate colors from Adobe Photoshop CS (HP–GL/2 & RTL driver)

● Get accurate colors from Adobe Photoshop CS (PostScript driver)

● Get accurate colors from Adobe InDesign CS

● Get accurate colors from QuarkXPress 6

● Get accurate colors from Autodesk AutoCAD

● Get accurate colors from Microsoft Office 2003

● Get accurate colors from ESRI ArcGIS 9
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Perform color calibration
Color calibration improves color consistency between prints, and from one printer to another.

It is normally performed whenever a printhead is replaced, and whenever a new paper type is introduced
that has not been calibrated yet with the new printhead(s). However, this automatic behavior can be
turned off, and a default color correction used for each of the known paper types.

1. From the front panel, select the  icon, then Printer configuration > Color calibration.

2. The available options for color calibration are:

● On: the printer performs color calibration whenever you introduce a new paper type that has
not yet been calibrated with the current set of printheads. The color correction resulting from
the calibration is then used for subsequent prints on that paper type with the same print quality
setting.

● Off: the printer uses a default color correction, different for each paper type and print quality
setting.

3. The printer calibrates the colors by printing a calibration strip, scanning the strip with a built-in
optical sensor and calculating the color corrections required. The color calibration strip is 269 mm
wide, and 18 mm long when using glossy paper; on other paper types, it is 109 mm long. Color
calibration takes about three to six minutes, depending on the paper type.

NOTE: Color calibration can be requested manually at any time from the front panel, by selecting the
 icon, then Printhead management > Calibrate color.

CAUTION: Color calibration can be performed successfully on opaque materials only. Do not attempt
to calibrate transparent film.

Perform black point compensation
The black point compensation option controls whether to adjust for differences in black points when
converting colors between color spaces. When this option is selected, the full dynamic range of the
source space is mapped into the full dynamic range of the destination space. It can be very useful in
preventing blocking shadows when the black point of the source space is darker than that of the
destination space. This option is allowed only when the relative colorimetric rendering intent is selected
(see Set the rendering intent on page 69).

Black point compensation can be specified in the following ways:

● Using a Windows PostScript printer driver: select the Color tab, then Black point
compensation.

● Using a Mac OS printer driver: select the Color Options panel, then Black Point Compensation.

● Using the Embedded Web Server: select the Submit Job page, then Black point
compensation.

● Using the front panel: select the  icon, then Default printing options > Color options > Black
point compensation.
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Set the rendering intent
Rendering intent is one of the settings used when doing a color transformation. As you probably know,
some of the colors you want to print may not be reproducible by the printer. The rendering intent allows
you to select one of four different ways of handling these so–called out–of–gamut colors.

● Saturation (graphics): best used for presentation graphics, charts or images made up of bright,
saturated colors.

● Perceptual (images): best used for photographs or images in which colors blend together. It tries
to preserve the overall color appearance.

● Relative colorimetric (proofing): best used when you want to match a particular color. This
method is mainly used for proofing. It guarantees that, if a color can be printed accurately, it will
be printed accurately. The other methods will probably provide a more pleasing range of colors but
do not guarantee that any particular color will be printed accurately. It maps the white of the input
space to the white of the paper on which you are printing.

● Absolute colorimetric (proofing): the same as relative colorimetric, but without mapping the
white. This rendering is also used mainly for proofing, where the goal is to simulate the output of
one printer (including its white point).

The rendering intent can be specified in the following ways:

● Using a Windows PostScript printer driver: select the Color tab, then Rendering intent.

● Using a Mac OS printer driver: select the Color Options panel, then Rendering Intent.

● Using the Embedded Web Server: select the Submit Job page, then Rendering intent.

● Using the front panel: select the  icon, then Default printing options > Color options > Select
rendering intent.

Select the color emulation mode
You can set the color emulation mode in the following ways:

● Using a Windows printer driver: select the Color Management section of the Color tab.

● Using a Mac OS printer driver: select the Color Options panel.

● Using the Embedded Web Server: select the Color Management section of the Submit Job page.

● Using the front panel: select the  icon, then Default printing options > Color options.

See Color emulation modes on page 190.

Produce matching prints from different HP Designjets
See Color matching between different HP Designjets on page 157.

Get accurate colors from Adobe Photoshop CS (HP–GL/2
& RTL driver)

This topic outlines one way to have good control over the printed colors you will obtain from your printer;
there are many other ways. Before starting, ensure that your paper type has already been calibrated.
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Application settings
1. Open Adobe Photoshop and select Color Settings from the Edit menu.

● Working spaces: the working space is the color space you want to use when manipulating
the image. We recommend using the color space that comes with the image (see Color
Management Policies below), if any; otherwise, our recommended default settings are: RGB:
Adobe RGB 1998, CMYK: SWOP for the USA and Euroscale Coated v2 for the rest of the
world.

● Color Management Policies: select 'Preserve Embedded Profiles'.

● Rendering Intent: see Set the rendering intent on page 69.

● Black Point Compensation: this option is recommended if you have chosen the Relative
Colorimetric rendering intent. See Perform black point compensation on page 68.
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2. Open the image. Accept the embedded color profile if there is one:

Otherwise accept the default that Adobe Photoshop proposes:

3. Once you have defined the color space in which you are going to work, you can if you like make a
soft proof, which means emulating on the screen how the image will look when printed. To do this,
you will need an ICC profile for your monitor. Select View > Proof Setup > Custom. Use the
following information to select options in the Proof Setup window.

● Profile: choose the profile based on the printer model and paper type you intend to use.

● Preserve Color Numbers: this checkbox tells the application how to simulate the document's
appearance without converting colors from the Document Space to the Proof Profile Space.
It simulates the color shifts that may occur when the document's color values are interpreted
using the Proof Profile instead of the Document Profile. This option is not recommended.

● Intent: this menu allows you to choose a rendering intent for the conversion from document
space to simulation space, letting you preview the effects of different renderings. See Set the
rendering intent on page 69.

● Use Black Point Compensation: this option is recommended if you have chosen the Relative
Colorimetric rendering intent. See Perform black point compensation on page 68.

● Paper White: this checkbox emulates the whiteness of the paper on the monitor. The effect
is the same as using the Absolute Colorimetric rendering intent.

● Ink Black: this checkbox turns off the black point compensation for the rendering from
simulation to the monitor. So, if the simulation space black is lighter than the monitor black,
you will see the washed-out blacks on the monitor. This option is not recommended.

● Preview: if this checkbox is enabled (recommended), the changes you make in this window
are reflected in the image immediately.
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4. When you are ready to print the image, open the Print with Preview window from the File menu. In
the Color Management tab you can select:

● Source Space: 'Document' (automatically assigned for you).

● Profile: select the profile you will use. We recommend using Adobe RGB. If neither Adobe
RGB or sRGB is selected, then choose the appropriate ICC profile for the paper loaded, and
remember to select later on in the driver the option Managed by Application.

● Intent: See Set the rendering intent on page 69.

Driver settings
In the Paper/Quality tab (Windows) or Image Quality panel (Mac OS), set Print Quality to Best.
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In the Color tab (Windows) or Color Options panel (Mac OS), you have the following Color Management
options. Select the same option that you selected in the Print dialog box above (Print Space section,
Profile option).

● sRGB: this is the default color space. The input RGB data are converted to CMYK using the printer's
internal color maps, which depend on the paper type and print quality selected. These are the most
“versatile” color maps, producing saturated colors for CAD and office applications and also
producing good results with photographic images.

● AdobeRGB: similar to sRGB, but using the AdobeRGB to CMYK internal color maps, which are
designed for AdobeRGB input data with a bigger source gamut. Best suited to digital photography.

● Managed by Application: the driver will not perform any color correction. This path can be used
when building custom RGB printer profiles and applying them within the application (the application
is responsible for applying the right color management by using the custom RGB printer profiles).
In this case, make sure that you have selected the right media profile in the "Print Space, Profile"
option in the application print command (see above).

Printer settings
Ensure that the Paper Type setting on the front panel corresponds to the paper you intend to use.

Get accurate colors from Adobe Photoshop CS (PostScript
driver)

This topic outlines one way to have good control over the printed colors you will obtain from your printer;
there are many other ways. Before starting, ensure that your paper type has already been calibrated.

Application settings
1. Open Adobe Photoshop and select Color Settings from the Edit menu (Windows) or from the

Photoshop menu (Mac OS).

● Working spaces: the working space is the color space you want to use when manipulating
the image. We recommend using the color space that comes with the image (see Color
Management Policies below), if any; otherwise, our recommended default settings are: RGB:
Adobe RGB 1998, CMYK: SWOP for the USA and Euroscale Coated v2 for the rest of the
world.

● Color Management Policies: select 'Preserve Embedded Profiles'.
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● Rendering Intent: see Set the rendering intent on page 69.

● Black Point Compensation: this option is recommended if you have chosen the Relative
Colorimetric rendering intent. See Perform black point compensation on page 68.

2. Open the image. Accept the embedded color profile if there is one:

Otherwise accept the default that Adobe Photoshop proposes:
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3. Once you have defined the color space in which you are going to work, you can if you like make a
soft proof, which means emulating on the screen how the image will look when printed. To do this,
you will need an ICC profile for your monitor. Select View > Proof Setup > Custom. Use the
following information to select options in the Proof Setup window.

● Profile: choose the profile based on the printer model and paper type you intend to use.

● Preserve Color Numbers: this checkbox tells the application how to simulate the document's
appearance without converting colors from the Document Space to the Proof Profile Space.
It simulates the color shifts that may occur when the document's color values are interpreted
using the Proof Profile instead of the Document Profile. This option is not recommended.

● Intent: this menu allows you to choose a rendering intent for the conversion from document
space to simulation space, letting you preview the effects of different renderings. See Set the
rendering intent on page 69.

● Use Black Point Compensation: this option is recommended if you have chosen the Relative
Colorimetric rendering intent. See Perform black point compensation on page 68.

● Paper White: this checkbox emulates the whiteness of the paper on the monitor. The effect
is the same as using the Absolute Colorimetric rendering intent.

● Ink Black: this checkbox turns off the black point compensation for the rendering from
simulation to the monitor. So, if the simulation space black is lighter than the monitor black,
you will see the washed-out blacks on the monitor. This option is not recommended.

● Preview: if this checkbox is enabled (recommended), the changes you make in this window
are reflected in the image immediately.

4. When you are ready to print the image, open the Print with Preview window from the File menu. In
the Color Management tab you can select:

● Source Space: 'Document' (automatically assigned for you). This is the color space in which
you have been working while editing the image.

● Profile: select PostScript Color Management (if you do not see this option, select Printer Color
Management). With this option, the application tells the driver which source profile and
rendering intent should be used for the conversion to the print space. In this case the driver
will use the 'Document' profile and the rendering intent selected below. The driver's Input
Profile and Rendering Intent settings are overridden.

● Intent: see Set the rendering intent on page 69.
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Driver settings
The application's PostScript Color Management option will override the color settings of the driver (Input
Profile and Rendering Intent). In this case, the driver will use the application's "Document" profile and
selected rendering intent. Then, we have only to select in the driver:

● In the Paper/Quality tab (Windows) or Image Quality panel (Mac OS), set Print Quality to Best.

● In the Color tab (Windows) or Color Options panel (Mac OS), check the Automatic PANTONE
Calibration or HP Professional PANTONE Emulation box.

Printer settings
Ensure that the Paper Type setting on the front panel corresponds to the paper you intend to use.

Get accurate colors from Adobe InDesign CS
This topic outlines one way to have good control over the printed colors you will obtain from your printer;
there are many other ways. We describe the hard-proofing technique that shows you on your printer
how your colors will appear when reproduced in a press. Before starting, ensure that your paper type
has already been calibrated.

NOTE: EPS, PDF and grayscale images don't allow page-layout applications to manage their colors.
In addition, such images are displayed very poorly on a monitor.
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Application settings
1. Open Adobe InDesign and select Color Settings from the Edit menu.

● Working spaces: the working space is the color space you want to use when manipulating
the image. We recommend using the color space that comes with the image (see Color
Management Policies below), if any; otherwise, our recommended default settings are: RGB:
Adobe RGB 1998, CMYK: SWOP for the USA and Euroscale Coated v2 for the rest of the
world.

● Color Management Policies: select 'Preserve Embedded Profiles'.

● Rendering Intent: see Set the rendering intent on page 69.

● Black Point Compensation: this option is recommended if you have chosen the Relative
Colorimetric rendering intent. See Perform black point compensation on page 68.

2. Create or open the image with its own or the most appropriate color space. Then retouch the image
as needed.

3. When you have the image ready to send to the output device, that is the moment to simulate on
your printer what will appear on the output device. You must convert the image from the source or
work profile to the output CMYK device, and then again from the output CMYK device to the printer
profile (calibrated).

In InDesign we recommend the Proof Setup command (View > Proof Setup -> Custom). This
command lets you select the "proof profile" in the source space when printing. You can also see a
simulation on your monitor. We recommend as follows:
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Each object in InDesign has its own color management. The InDesign elements (native) use the
working spaces (default profiles) and the rendering intent defined in Color Settings, and the placed
objects have their own assigned profile and rendering intent. Then, each element is converted from
its own color space to the simulation color space, using its own rendering intent.

● Profile: select the profile that corresponds to the device you want to emulate (usually a
particular press profile or an standard press profile)

● Paper White: this checkbox emulates the whiteness of the paper on the monitor. The effect
is the same as using the Absolute Colorimetric rendering intent.

● Ink Black: this checkbox turns off the black point compensation for the rendering from
simulation to the monitor. So, if the simulation space black is lighter than the monitor black,
you will see the washed-out blacks on the monitor. This option is not recommended.

4. Select File > Print to print the image, converting it to an output space that depends on the printer,
the paper type and the print quality.

● Select the Output tab (on the left), and then select Composite CMYK, in order to see the
CMYK profiles.

● Select the Color Management tab to see the following options.

● Source Space: select 'Proof' to emulate the proof color space.

● Profile: choose the profile based on the printer model and paper type you intend to use.

● Intent: select Relative or Absolute Colorimetric. The only difference is that Absolute
Colorimetric emulates the background color of the paper to be used by the press, while
Relative Colorimetric maps the paper color of the press to the paper color of the printer.
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Driver settings
The PostScript driver is recommended for page-layout applications because it can color–manage CMYK
data, RGB data or both simultaneously.

In the Paper/Quality tab (Windows) or Image Quality panel (Mac OS), set Print Quality to Best.

In the Color tab (Windows) or Color Options panel (Mac OS), select 'Application Managed Colors' and
check the Automatic PANTONE Calibration box. When the application performs color conversion to the
printer's color space, the printer should accept these colors without changing them. Make sure you have
selected the right media profile in “Print Space, Profile” above.

Printer settings
Ensure that the Paper Type setting on the front panel corresponds to the paper you intend to use.

Get accurate colors from QuarkXPress 6
This topic outlines one way to have good control over the printed colors you will obtain from your printer;
there are many other ways. We describe the hard-proofing technique that shows you on your printer
how your colors will appear when reproduced in a press. Before starting, ensure that your paper type
has already been calibrated.

NOTE: EPS, PDF and grayscale images don't allow page-layout applications to manage their colors.
In addition, such images are displayed very poorly on a monitor.

Application settings

1. Open QuarkXPress and select Preferences from the Edit menu (Windows) or the QuarkXPress
menu (Mac OS). Then select Quark CMS from the Preferences dialog box.

2. Ensure that the Color Management Active box is checked.
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3. The Destination Profiles area lets you choose profiles that correspond to your devices: Monitor
profile, Composite Output profile and Separation Output profile. Select in the Separation Output
profile the profile of your output device (press) which you want to emulate on your printer later.
Select in the Composite Output profile your printer profile; remember that it depends on the printer
model, paper type and print quality option.

4. In the Default Source Profiles you must set the default profiles for solid colors and images that don't
have embedded profiles. The following default profiles are recommended: RGB: Adobe RGB 1998,
CMYK: SWOP for the USA and Euroscale Coated v2 for the rest of the world. Also select the
rendering intent, which QuarkXPress uses for all conversions; if in doubt, select Relative
Colorimetric. See Set the rendering intent on page 69.

5. Check the box Color Manage RGB sources to RGB destinations in the RGB Default Source
Profiles and Color Manage CMYK sources to CMYK destinations in the CMYK Default Source
Profiles.

6. The Display Simulation tells QuarkXPress how the display simulation should behave:

● None means that it doesn't simulate anything on the display.

● Monitor Color Space means that it converts from the source profile to the display profile for
display only.

● Composite Output Color Space makes the display simulate a composite printer: that is, a
printer without separate plates for different colors, such as an inkjet printer.

● Separation Output Color Space makes the display simulate a separations printer: that is, a
printer with separate plates for different colors, such as a digital press.

You can select Monitor Color Space if you want to display only, or you can select the Separation
Output Color Space if you also want to see the simulation of the output device on the monitor.
You can simulate the final output with the printer (hard–proofing) and with the monitor (soft-
proofing ).

7. Open and retouch the document as you like.

8. Select File > Print > Setup > Printer Description, and select your printer.

9. Select File > Print > Profiles.

● Select the appropriate Separation Output Profile (emulation) and Composite Output Profile
(printer).

● Check the Composite Simulates Separation box, then Quark will perform the simulation.
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NOTE: Each object in QuarkXpress has its own color management. The solid colors use the color
profile and rendering intent selected in the default source profiles for Solid Colors (RGB, CMYK or
Hexachrome) of the Color Management Preferences dialog box. The imported objects have their own
assigned profile and rendering intent. QuarkXPress will use the rendering intent assigned to the image
for both conversions, from the image color space to the simulation color space, and from the simulation
color space to the printer color space.

Driver settings
The PostScript driver is the best choice for page-layout applications because it can color–manage CMYK
data, RGB data or both simultaneously.

In the Image Quality panel, set Print Quality to Best.

In the Color Options panel, select Application Managed Colors and check the Automatic PANTONE
Calibration box. When the application performs color conversion to the printer's color space, the printer
should accept these colors without changing them. Make sure you have selected the right media profile
in Composite Output in the Preferences dialog box.

Printer settings
Ensure that the Paper Type setting on the front panel corresponds to the paper you intend to use.

Get accurate colors from Autodesk AutoCAD
AutoCAD has no color management settings, so the best you can do is to configure the driver correctly.
If you are using the HP-GL/2 and HP RTL driver, click the Properties button and configure the driver as
follows.

● In the Paper/Quality tab, set Print Quality to Best.

● In the Color tab, ensure that the Print In Grayscale box is unchecked, and set Color Matching
Method to 'sRGB'.
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Get accurate colors from Microsoft Office 2003
Microsoft Office has no color management settings, so the best you can do is to configure the driver
correctly. If you are using the HP-GL/2 and HP RTL driver, click the Properties button and configure the
driver as follows.

● In the Paper/Quality tab, set Print Quality to Best.

● In the Color tab, ensure that the Print In Grayscale box is unchecked, and set Color Matching
Method to 'sRGB'.

Get accurate colors from ESRI ArcGIS 9
ArcGIS is a scalable system of software for geographic data creation, management, integration, analysis
and dissemination for every organization, from an individual to a globally distributed network of people.

The application always sends RGB data to the printer driver; you can choose between several different
printer engines. The printer engine determines the format and method used by ArcMap to send the print
job to the printer. There are from one to three options available, depending on license and printer
configurations.

● Windows is the default and is always available, regardless of the printer in use. It allows the
application to use the installed HP-GL/2 and HP RTL driver.

● PostScript is available only if your printer supports PostScript and the PostScript driver was
selected in the Name section. This allows you to output the file as a Postscript file. This option may
be useful in certain specific cases, but in general it is not recommended.

● ArcPress is an extension that can be purchased for printing from ArcGIS. It is a software RIP that
takes the original metafile and rasterizes it before sending it to the printer, so that the printer does
not need to rasterize it. This is beneficial because some printers are not capable of rasterization
or do not have enough memory to process large jobs. Use ArcPress always with HP RTL (RGB)
TrueColor.

Printing with the Windows printer engine
1. Ensure that you have installed the HP-GL/2 and HP RTL driver.
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2. When you are ready to print, select File > Page and Print Setup, and select the HP-GL/2 and HP
RTL driver.

3. Click the Properties button and configure the driver as follows.

● In the Paper/Quality tab, set Print Quality to Best.

● In the Color tab, ensure that the Print In Grayscale box is unchecked, and set Color
Matching Method to 'sRGB'.

4. Click the OK button.

5. Select File > Print.

● Printer Engine: select Windows Printer (it will use the selected raster driver).

● Output Image Quality (Resample Ratio): this setting alters the number of pixels sampled
when an ArcMap print file is generated; it determines how many pixels in the map document
will be used to create the file sent to the printer.

◦ Fast = 1:5

◦ Normal = 1:3

◦ Best = 1:1 (as is)

The 'Best' choice requires a lot of resources to process the print job, and could cause long
processing times and perhaps out–of–memory messages, depending on the map size. If you
have these problems, select an Output Image Quality lower than 'Best'. Bear in mind that you
will gain no advantage in print quality by sending an image whose resolution is higher than
the printer's input resolution.

ENWW Get accurate colors from ESRI ArcGIS 9 83

C
ol

or



6. You can print now (click the OK button).

Printing with the ArcPress printer engine
1. You must have the driver you need installed, although it will function only as a port.

2. When you are ready to print, select File > Page and Print Setup, select the driver (the driver
settings have no effect) and click the OK button.

3. Select File > Print.

● Printer Engine: select ArcPress.

● Click the Properties button, select the HP RTL (RGB) TrueColor driver, and select the
resolution that will be sent to the printer.
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● Select the Color Adjustment tab if you want to adjust gamma, brightness, contrast or
saturation. You can preview the changes.

4. You can print now: click the OK button in this dialog box and in the Print dialog box.
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9 How do I... (ink system topics)

● Remove an ink cartridge

● Insert an ink cartridge

● Remove a printhead

● Insert a printhead

● Manage printhead monitoring

● Recover (clean) the printheads

● Clean a printhead's electrical connections

● Align the printheads

● Remove a printhead cleaner

● Insert a printhead cleaner

● Check the status of the ink system

● Get ink cartridge statistics

● Get printhead statistics
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Remove an ink cartridge
There are two types of ink cartridge removal.

● The ink cartridge is very low and you want to replace it with a full cartridge for unattended printing
(you can use up the remaining ink in the first cartridge at a more convenient time).

● The ink cartridge is empty or faulty, and you must replace it to continue printing.

CAUTION: Do not try to remove an ink cartridge while printing.

CAUTION: Remove an ink cartridge only if you are ready to insert another one.

WARNING! Make sure the printer wheels are locked (the brake lever is pressed down) to prevent the
printer from moving.

1. At the printer's front panel, select the  icon, then Replace ink cartridges.

2. The ink cartridge door is on the left-hand side of the printer.
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3. Release the door catch by pressing on the top until it clicks.

4. Pull the door fully open.

5. Grip the blue tab in front of the cartridge you wish to remove.

6. Pull the blue tab down.
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7. Then pull it outwards, towards you.

8. The cartridge comes out, in its drawer.

9. Lift the cartridge out of its drawer.

NOTE: Avoid touching the end of the cartridge that is inserted into the printer, as there may be
ink on the connection.

NOTE: Avoid storing partially used ink cartridges on their ends.

10. The front panel display will identify the missing ink cartridge.
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Insert an ink cartridge
1. Pick up the new ink cartridge and find the label identifying the ink color. Hold the ink cartridge so

that you can see the identifying colored label at the top of the side facing you.

2. Check that the colored label above the empty slot in the printer matches the color of the label on
the cartridge.

3. Insert the ink cartridge into the cartridge drawer.

Position the cartridge at the rear of the drawer as indicated below.

NOTE: A larger black ink cartridge is available that uses the whole length of the drawer.

4. Slide the drawer and cartridge into the slot until it locks into position.

If you have difficulty, see I cannot insert an ink cartridge on page 168.
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5. When all cartridges have been inserted, close the door (push it until it clicks shut).

6. The front panel display confirms that all cartridges have been correctly inserted.

Remove a printhead
WARNING! Make sure the printer wheels are locked (the brake lever is pressed down) to prevent the
printer from moving.

Printhead replacement must be performed with the printer switched on at the power isolation switch.

1. At the printer's front panel, select the  icon, then Printhead management > Replace
printheads.

2. The printer moves the carriage into the correct position.

CAUTION: If the carriage is left in the central part of the printer for more than seven minutes. it
will try to move back to its normal position in the right-hand end.

3. When the carriage has stopped moving, the front panel will ask you to open the window.
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4. Locate the carriage.

5. Pull up and release the latch on top of the carriage.

6. Lift up the cover. This will now give you access to the printheads.

7. To remove a printhead, lift up the blue handle.
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8. Using the blue handle, gently disengage the printhead.

9. Gently pull the blue handle upward until the printhead is released from the carriage.

CAUTION: Do not pull abruptly because this can damage the printhead.

10. The front panel display identifies the missing printhead.

Insert a printhead
1. If the printhead is new:

a. Remove the blue protective cap by pulling down on it.
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b. Remove the clear protective tape from the printhead's nozzles by pulling on the paper tab.

The printhead is designed to prevent you from accidentally inserting it into the wrong position.
Check that the colored label on the printhead matches the colored label of the carriage position
into which the printhead is to be inserted.

2. Insert the new printhead into its correct position in the carriage.

CAUTION: Insert the printhead slowly and vertically, straight down. It may be damaged if you
insert it too fast, or at an angle, or if you turn it as you insert it.

3. Push down as indicated by the arrow shown below.

When installing the new printhead there may be some resistance, so you need to press it down
firmly but smoothly.

If you have difficulty, see I cannot insert a printhead on page 168.
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4. Insert any other printheads that need to be installed, and close the carriage cover.

When all the printheads have been inserted correctly and accepted by the printer, the printer will
beep.

NOTE: If the printer does not beep when you insert the printhead and the Replace message
appears on the front panel, the printhead may need to be reseated.

5. Latch the carriage cover.

When the carriage has been correctly latched, it looks like this:

6. Close the window.
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7. The front panel display confirms that all printheads are correctly inserted.

8. Now replace the printhead cleaners for any printheads that have been changed. See Remove a
printhead cleaner on page 102 and Insert a printhead cleaner on page 103.

CAUTION: Leaving the old printhead cleaner in the printer will shorten the new printhead's life
and possibly damage the printer.

Manage printhead monitoring
The printer automatically checks the status of the printheads from time to time in order to monitor their
health and detect any problems that might affect print quality. The frequency of these checks is optimized
to maintain good throughput.

If you want to increase the frequency of printhead monitoring in order to detect any problems sooner,
select the  icon, then Printer configuration > Printhead monitoring > Intensive. When the printer
is printing and printhead monitoring is set to Intensive, the front panel and the Embedded Web Server
printer status line will display the following message: Printing. Printhead monitoring (instead of just
Printing).

NOTE: When Intensive is selected, the throughput of the printer will be reduced because of the
increased frequency of printhead checks.

To return to the default printhead monitoring frequency, select the  icon, then Printer
configuration > Printhead monitoring > Optimized.

Recover (clean) the printheads
To clean the printheads (which often enables them to recover from problems), go to the printer's front
panel and select the  icon, then Printhead management > Recover printheads. Cleaning takes
about two to four minutes.

Clean a printhead's electrical connections
In some extreme cases it is possible that the printer will not recognize a printhead after it has been
installed. This is due to the build-up of ink deposits on the electrical connections between the printhead
and the printhead carriage. Under these circumstances you are recommended to clean the printhead's
electrical connections. Routine cleaning of the connections when there are no apparent problems is not
recommended.

Included with your printer (in the Maintenance Kit box) is a carriage interconnect wiper.

ENWW Manage printhead monitoring 97

In
k 

sy
st

em



This should be used for cleaning the electrical interconnects of both the printhead carriage and the
printhead, which should be done if the front panel persistently displays the Reseat or Replace message
next to the printhead.

1. Remove a new pre-moistened replacement sponge from its pouch.

A supply of sponges is included in the box with the wiper. If all sponges have been used, more can
be obtained by contacting your customer service representative.

2. Open the carriage interconnect wiper.

3. Load the sponge into the carriage interconnect wiper by positioning the sponge on the face of the
carriage interconnect wiper with the shorter tab in the locating slot.
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4. Close the carriage interconnect wiper, trapping the sponge in place.

5. Open the printhead carriage latch and extract the printhead that has the problem, as indicated on
the front panel. See Remove a printhead on page 92.

6. Insert the carriage interconnect wiper into the printhead slot at the back. Wipe the electrical contacts
by inserting the tool between the electrical connections at the back of the slot and the steel spring
with the sponge facing away from you and towards the electrical contacts. Try to avoid picking up
any ink deposit which may have accumulated on the bottom surface of the slot.

CAUTION: If the carriage is left in the central part of the printer for more than seven minutes. it
will try to move back to its normal position in the right-hand end.

7. Rub the sponge against the contacts with a light force along the entire depth of the flex connector
as allowed by the mechanical stop on the tool.
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8. Take special care to clean all contacts thoroughly, including the ones at the lowest point of the
connector.

9. Using the same sponge, clean the lower strip of electrical contacts on the printhead (unless the
printhead is new), avoid touching the upper set of electrical contacts.

CAUTION: Do not touch the surface of the printhead containing the nozzles, which are easily
damaged.

10. After waiting a few moments to allow both connectors to dry, replace the printhead into the printhead
carriage. See Insert a printhead on page 94.

11. On completion of the cleaning process, open the carriage interconnect wiper by pulling on the
sponge tab.
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12. Remove the soiled sponge from the carriage interconnect wiper.

13. Dispose of the soiled sponge in a safe place to prevent the transfer of ink onto hands and clothing.

If the front panel continues to display the Reseat or Replace message, replace the printhead or contact
your customer service representative.

Align the printheads
The printer will normally perform printhead alignment whenever printheads are replaced. If there is no
paper loaded when a printhead is replaced, the printer will perform the alignment the next time you load
paper.

NOTE: You can turn off these automatic printhead alignments from the front panel: select the  icon,
then Printer configuration > Auto printhead alignment > Off.

In addition, you should align the printheads if the Image Diagnostics Print indicates an alignment error.
See How do I... (Image Diagnostics Print topics) on page 117.

1. Make sure that you have a roll of opaque paper loaded in the printer; the best results will be
achieved with the type of paper that you normally use for printing. Single sheets of paper, and
transparent materials such as translucent bond, clear film, matte film, tracing paper and vellum are
not suitable for printhead alignment.

2. To request printhead alignment (if the alignment is not being performed automatically), go to the
front panel, select the  icon, and then Printhead management > Align printheads.
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3. If you are close to the beginning of a roll, the front panel will report that the printer may need to
feed up to 3 m (≈ 10 ft) of paper before starting the printhead alignment. This is necessary to ensure
a successful alignment. In this case, you will be given the following options:

● To continue with the printhead alignment, allowing the printer to feed as much paper as
necessary

● To schedule the printhead alignment to be performed later, after you have used a few meters
of paper for printing

● To cancel the printhead alignment

4. If you choose to continue with the printhead alignment, the process will start immediately, unless
an image is currently being printed, in which case the alignment will be done as soon as the current
print job is finished.

The alignment process takes about twelve minutes.

Remove a printhead cleaner
After you have replaced a printhead, the front panel will prompt you to replace the printhead cleaner.

CAUTION: When replacing a printhead, always replace the corresponding printhead cleaner. Leaving
the old cleaner in the printer will seriously shorten the new printhead's life and possibly damage the
printer. A new printhead cleaner is provided with each new printhead.

When removing a printhead cleaner:

● Be careful not to get ink on your hands. There may be ink on, around and inside the replaced
printhead cleaner.

● Always handle and store the replaced printhead cleaner upright to avoid spilling any ink.

WARNING! Make sure the printer wheels are locked (the brake lever is pressed down) to prevent the
printer from moving.

1. The printhead cleaners are located in slots underneath the front panel, at the front of the printer.
Press the top of the service station door to release the catch.

102 Chapter 9   How do I... (ink system topics) ENWW

Ink system



2. Open the door.

3. Each printhead cleaner has a handle on the front. To remove the cleaner, press inward and upward
as indicated by the arrow shown here, until the cleaner is released.

4. Lift up the printhead cleaner to remove it from the slot, and slide it out horizontally as shown below.

See also Insert a printhead cleaner on page 103.

Insert a printhead cleaner
The plastic bag in which the new printhead cleaner comes can be used to dispose of the old printhead
and printhead cleaner.
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1. Insert each printhead cleaner into the correct color slot location, in the service station, in the
direction indicated by the arrow shown here.

2. When the printhead cleaner has been pushed all the way in, press inwards and downwards as
indicated by the arrow shown here, until it clicks into place.

If you have difficulty, see I cannot insert a printhead cleaner on page 168.

NOTE: The front panel will not show the new printhead cleaner until the right-hand door is closed.

3. When you have inserted the printhead cleaner(s) into the printer, close the door.

NOTE: The printer needs all the ink cartridges, printheads and printhead cleaners to be installed
before it can continue.

4. If no paper is loaded, the front panel will instruct you to load some.

Whenever you insert a new printhead and cleaner, the printer will normally perform a printhead alignment
and color calibration. Both are recommended for best print quality. In some cases, you may decide to
postpone printhead alignment until after some further printing has been done.
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NOTE: If you prefer to save some time at the expense of print quality, you can turn off these automatic
procedures from the front panel, by selecting the  icon, then Printer configuration > Auto printhead
alignment > Off and Printer configuration > Color calibration > Off.

The front panel may request that you load paper that is suitable for printhead alignment. The printhead
alignment procedure requires a roll of opaque paper: not a single sheet, and not any kind of transparent
or translucent material.

When the front panel displays Ready, you are ready to print.

NOTE: Make sure the printer window and the right-hand door are closed after you replace the supplies.
The printer will not print while these are open.

Check the status of the ink system
1. Access the Embedded Web Server (see Access the Embedded Web Server on page 17).

2. Go to the Supplies page.

The Supplies page shows you the status of the ink cartridges (including the ink levels), the printheads,
the printhead cleaners and the loaded paper.

Get ink cartridge statistics
To get information on your ink cartridges:

1. Go to the front panel and select the  icon.

2. Select Ink cartridge information, then select the cartridge on which you want information.

3. The front panel displays:

● Its color

● Its product name

● Its product number

● Its serial number
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● Its status

● Its ink level, if known

● Its total ink capacity in milliliters

● Its manufacturer

● Its warranty status

You can also get most of this information without leaving your computer by using the Embedded Web
Server.

For an explanation of the ink cartridge status messages, see An ink cartridge status message
on page 169.

Get printhead statistics
To get information on your printheads:

1. Go to the front panel and select the  icon.

2. Select Printhead information, then select the printhead on which you want information.

3. The front panel displays:

● Its color

● Its product name

● Its product number

● Its serial number

● Its status

● The volume of ink it has used

● Its warranty status

● The status of its cleaner

You can also get most of this information without leaving your computer by using the Embedded Web
Server.

For an explanation of the printhead and printhead cleaner status messages, see A printhead status
message on page 169 and A printhead cleaner status message on page 169.
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10 How do I... (accounting topics)

● Get accounting information from the printer

● Check printer usage statistics

● Check ink and paper usage for a job

● Request accounting data by E-mail
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Get accounting information from the printer
There are various different ways of getting accounting information from your printer.

● View printer usage statistics for the whole lifetime of the printer, or for particular periods. See Check
printer usage statistics on page 108.

● View ink and paper usage for each of your recent jobs by using the Embedded Web Server or the
printer's front panel. See Check ink and paper usage for a job on page 108.

● Request accounting data by E-mail. The printer sends data in XML at regular intervals to a specified
E-mail address; the data may be interpreted and summarized by a third-party application, or
displayed as an Excel spreadsheet. See Request accounting data by E-mail on page 108.

● Use a third-party application to request printer status, printer usage or job accounting data from
the printer through the Internet. The printer provides data in XML to the application whenever
requested. HP provides a Software Development Kit to facilitate the development of such
applications.

Check printer usage statistics
1. Access the Embedded Web Server (see Access the Embedded Web Server on page 17).

2. Go to the Usage page.

3. Go to the Historical tab to see the accumulated usage of the printer since the first day.

4. Go to the Snapshot tab to save a record of the accumulated usage since the first day, and reset
the Accumulated tab's counters to zero.

5. Go to the Accumulated tab to view the accumulated usage since the last snapshot.

NOTE: The accuracy of these usage statistics is not guaranteed.

Check ink and paper usage for a job
1. Access the Embedded Web Server (see Access the Embedded Web Server on page 17).

2. Go to the Accounting page, which shows you all the information regarding the jobs recently printed
by the printer.

Alternatively, go to the Jobs Queue page, and click on the name of the job on which you want
information. Its properties page will then be displayed.

Request accounting data by E-mail
1. Ensure that the printer's date and time have been set correctly. See Set the date and time

on page 19.

2. In the Embedded Web Server's Settings tab, check that the E-mail server has been set correctly.

3. Also in the Settings tab, select Device setup and choose settings in the Accounting section. You
must enter an E-mail address to which accounting files can be sent, and the frequency with which
they will be sent.

4. You may also choose to require an account ID with every print job. In this case, anyone sending
a print job must provide an account ID, otherwise the printer will hold the job in the queue until an
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ID is provided. You can supply an account ID when submitting a job with the Embedded Web Server
or with a printer driver (using the Accounting tab).

5. When you have completed the above steps, the printer will send accounting data by E-mail with
the frequency that you specified. The data are provided in XML and can easily be interpreted by a
third-party program. The data provided on each job include the job name, the account ID if any,
the user name, when the job was submitted, when the job was printed, the printing time, the type
of image, the number of pages, the number of copies, the paper type and size, the amount of each
color of ink used and various other attributes of the job.

Images are categorized into four types:

● A: Low-coverage lines (less than 0.5 ml/m²)

● B: High-coverage lines (0.5 to 2 ml/m²)

● C: Maps and low-coverage renders (2 to 5 ml/m²)

● D: Photographs (more than 5 ml/m²)

You can download an Excel template from HP's Web site (http://www.hp.com/go/graphic-arts/) that will
enable you to display the XML data more readably in the form of a spreadsheet.

Analysis of the accounting data will enable you to bill customers precisely and flexibly for the use of your
printer. You can, for instance:

● Bill each customer for the total amount of ink and paper used by that customer over a particular
period.

● Bill each customer separately per job.

● Bill each customer separately for each project, broken down by job.

ENWW Request accounting data by E-mail 109

A
cc

ou
nt

in
g

http://www.hp.com/go/graphic-arts/


110 Chapter 10   How do I... (accounting topics) ENWW

A
ccounting



11 How do I... (printer maintenance topics)

● Clean the exterior of the printer

● Clean the input rollers

● Clean the platen

● Lubricate the printhead carriage

● Maintain the ink cartridges

● Move or store my printer

● Update my printer's firmware

● Update my printer's software
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Clean the exterior of the printer
Clean the outside of the printer and all other parts of the printer that you regularly touch as part of normal
operation (e.g. ink cartridge drawer handles) as required with a damp sponge or a soft cloth and a mild
household cleaner such as non-abrasive liquid soap.

WARNING! To avoid an electric shock, make sure that the printer is switched OFF and unplugged
before you clean it. Do not let water get inside the printer.

CAUTION: Do not use abrasive cleaners on the printer.

Clean the input rollers
You should plan to clean your printer's input rollers on a regular basis, once a year or when you notice
a loss of roll switching performance.

1. Unload all paper from the printer.

2. Go to the front panel and select the  icon then Printer configuration > Clean drawer roller.
This command will rotate the roller so that the whole circumference can be cleaned.

3. Use a clean, absorbent lint-free cloth, slightly dampened with isopropyl alcohol, to wipe off any dirt
or paper particles from the input rollers.

NOTE: Isopropyl alcohol is not provided in the Maintenance Kit.

4. When you have finished cleaning a roller, press the Select key on the front panel to stop the rotation.

Clean the platen
You should plan to clean your printer's platen on a regular basis, every few months or when needed.

NOTE: If you print on wide paper after using narrower paper for some time, you may find that the left
side of the platen has become dirty and will leave marks on the back of the paper if not cleaned.

Follow these instructions to clean the platen.

1. Unload all paper from the printer.
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2. Open the window.

3. With a dry brush, remove ink deposits from the cutter groove.

4. With the same dry brush, remove ink deposits from the platen surface.

5. At the front panel, select the  icon, then Paper handling options > Clean roller > Clean
platen. This command will rotate the small rollers on the platen so that the whole circumference
can be cleaned.

NOTE: If you find that this command is not available, please download the latest firmware revision
(see Update my printer's firmware on page 116). This option is available from Fall 2007.
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6. Use a clean, absorbent lint-free cloth, slightly dampened with isopropyl alcohol, to wipe off loosened
ink deposits from the platen.

NOTE: Isopropyl alcohol is not provided in the Maintenance Kit.

CAUTION: Do not use commercial cleaners or abrasive cleaners. Do not wet the platen directly
because you will leave too much moisture behind.

7. Clean the cutter ramp with the damp cloth.

8. Clean the exposed part of the wheels with a dry cloth. Ideally you should clean the whole
circumference of these wheels.

Lubricate the printhead carriage
The printhead carriage occasionally (about once a year) needs lubrication to slide easily along the slider
rod.

1. To gain access to the carriage, go to the front panel and select the  icon, then Printhead
management > Replace printheads. The carriage will slide into the middle section of the printer.

CAUTION: If the carriage is left in the central part of the printer for more than seven minutes. it
will try to move back to its normal position in the right-hand end.

2. Take the bottle of oil from the Maintenance Kit that is supplied with your printer. A replacement kit
can be ordered if necessary.
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3. Open the window and apply a few drops of oil from the Maintenance Kit to the pads on either side
of the carriage.

4. Apply a few drops of oil directly to the slider rod on either side of the carriage.

5. Close the window.

Maintain the ink cartridges
During the normal lifetime of a cartridge, no specific maintenance is required. However, in order to
maintain the best print quality, you should replace a cartridge when it has reached its expiration date,
which is the date marked on the cartridge plus 6 months.

Move or store my printer
If you need to move your printer or store it for an extended period of time, you need to prepare it properly
to avoid possible damage to it. To prepare your printer, follow the instructions below.

1. Do not remove the ink cartridges, printheads or printhead cleaners.

2. Make sure that no paper is loaded.

3. Make sure that the printhead carriage is located in the service station (the right-hand end of the
printer).

4. Make sure that the front panel displays Ready.

5. Switch off the power using the Power key on the front panel.

6. Also switch off the power switch at the rear of the printer.
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7. Disconnect the printer's power cable and any cables connecting the printer to a network, a computer
or a scanner.

8. If you have the HP Designjet 4520 stacker, disconnect and detach it.

NOTE: We strongly recommend that you do not try to disassemble the HP Designjet 4520 roll module.

Update my printer's firmware
Your printer's various functions are controlled by software that resides in the printer, otherwise known
as firmware.

From time to time firmware updates will be available from Hewlett-Packard. These updates increase
your printer's functionality and enhance the features that your printer already possesses. Firmware can
be downloaded from the Internet and installed into your printer using the Embedded Web Server's
Firmware update page (found in the Settings tab).

If you are unable to use the Embedded Web Server because you do not have a TCP/IP connection to
your printer (for instance, when using USB or AppleTalk), you can obtain HP Designjet 4020 series
firmware updates and installation software from these Web pages:

● http://www.hp.com/go/4020/firmware/

● http://www.hp.com/go/4020ps/firmware/

And you can obtain HP Designjet 4520 series firmware updates and installation software from:

● http://www.hp.com/go/4520/firmware/

● http://www.hp.com/go/4520ps/firmware/

● http://www.hp.com/go/4520mfp/firmware/

The firmware includes a set of the most commonly used media profiles. Extra media profiles can be
downloaded separately; see Download media profiles on page 40.

Update my printer's software
From time to time software updates will be available from Hewlett-Packard. The latest printer software
can be downloaded from the following Web pages.

● http://www.hp.com/go/4020/drivers/

● http://www.hp.com/go/4020ps/drivers/

● http://www.hp.com/go/4520/drivers/

● http://www.hp.com/go/4520ps/drivers/

● http://www.hp.com/go/4520mfp/drivers/

116 Chapter 11   How do I... (printer maintenance topics) ENWW

M
aintenance

http://www.hp.com/go/4020/firmware/
http://www.hp.com/go/4020ps/firmware/
http://www.hp.com/go/4520/firmware/
http://www.hp.com/go/4520ps/firmware/
http://www.hp.com/go/4520mfp/firmware/
http://www.hp.com/go/4020/drivers/
http://www.hp.com/go/4020ps/drivers/
http://www.hp.com/go/4520/drivers/
http://www.hp.com/go/4520ps/drivers/
http://www.hp.com/go/4520mfp/drivers/


12 How do I... (Image Diagnostics Print
topics)

● Print the Image Diagnostics Print

● Respond to the Image Diagnostics Print

● Interpret Image Diagnostics part 1

● Interpret Image Diagnostics part 2

● Interpret Image Diagnostics part 3

● If I still have a problem
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Print the Image Diagnostics Print
The Image Diagnostics Print consists of patterns designed to highlight print quality problems. It helps
you to check whether you have a print quality problem, and if you have, what the cause of the problem
is and how to resolve it.

Before using the Image Diagnostics Print, check that you have been using appropriate print quality
settings (see Choose print quality settings on page 57).

To print the Image Diagnostics Print:

1. Ensure that you have paper of at least A3 size (29.7 × 42 cm = 11.7 × 16.5 in) loaded into the
printer. Use the same paper type that you were using when you detected a problem.

2. Ensure that the front panel has the same print quality settings that you were using when you
detected the problem (see Change the print quality on page 57). In the Image Diagnostics Print,
the only difference between drawings/text and images is that the latter uses more ink in part 2,
so that the colors appear darker.

To print the Image Diagnostics Print will take about two minutes if you choose images; sometimes
less if you choose drawings/text (depending on the paper type).

3. At the printer's front panel, select the  icon, then Internal prints > Image diagnostics prints
> Optim. for drawings/text or Optimize for images.

When the print is ready, see Respond to the Image Diagnostics Print on page 118.

Respond to the Image Diagnostics Print
The Image Diagnostics Print is in three numbered parts.

1. Part 1 tests printhead alignment. See Interpret Image Diagnostics part 1 on page 118.

2. Part 2 tests printhead performance and the paper advance mechanism. See Interpret Image
Diagnostics part 2 on page 119.

3. If Part 2 has revealed a printhead problem, Part 3 identifies which of the eight printheads is
responsible for it. See Interpret Image Diagnostics part 3 on page 121.

If Part 2 has not revealed any problem, you can and should ignore Part 3.

Interpret Image Diagnostics part 1
The purpose of part 1 is to identify color-to-color alignment and bidirectional alignment problems.
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If you have horizontal misalignment, you will see something like this:

If you have vertical misalignment, you will see something like this:

If you have bidirectional misalignment, you will see something like this:

Corrective action
1. Align the printheads, using the same paper type with which you were experiencing unacceptable

print quality, if feasible (some paper types are not suitable for printhead alignment). See Align the
printheads on page 101.

2. If there is no improvement in print quality, contact your customer service representative.

Interpret Image Diagnostics part 2
The purpose of part 2 is to test whether the printheads and the paper advance mechanism are working
correctly. This part of the print should not be used to check for color consistency or accuracy.
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Banding
Banding has occurred when you see repetitive horizontal bands within the printed image. They can
appear as light bands:

or dark bands:

or as a more gradual wave effect:

Horizontal bands across strips of one color only
If a printhead is faulty, you will see horizontal bands across strips of one color only; or at least the
horizontal bands will be much more noticeable in one color than in the others.

NOTE: Banding in the green strips is more difficult to see; and it may be caused by a yellow printhead
or by a cyan printhead. If you see banding only in the green strip, it is caused by a yellow printhead; if
you see banding in the green and cyan strips, it is caused by a cyan printhead.
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Corrective action
1. Check that you are using appropriate print quality settings. See Choose print quality settings

on page 57.

2. Clean the printheads. See Recover (clean) the printheads on page 97.

3. Reprint the Image Diagnostics Print. If you still see banding, continue with steps 4 and 5.

4. As there are two printheads for each color, check exactly which printhead is responsible for the
problem, using Part 3 of the Image Diagnostics Print. See Interpret Image Diagnostics part 3
on page 121Part 3.

5. Replace the printhead that shows the problem. See Remove a printhead on page 92 and Insert a
printhead on page 94.

Horizontal bands across all the colored strips
If the printer has paper advance problems you will see horizontal bands across all the colored strips.

NOTE: Banding in the green strips is more difficult to see.

Corrective action
1. Check that you are using appropriate print quality settings. See Choose print quality settings

on page 57.

2. If you are using low-quality paper, try better-quality paper. The performance of your printer can be
guaranteed only if you use recommended papers. See Supported paper types on page 200.

3. Perform paper advance calibration with the same paper type that you intend to use for the final
print. See How do I... (paper advance calibration topics) on page 125.

4. If there is no improvement in print quality, contact your customer service representative.

Interpret Image Diagnostics part 3
If part 2 has revealed a printhead problem, the purpose of part 3 is to identify which particular printhead
is faulty. Each rectangle in this plot is labelled with the number of the printhead that produced it.
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Here are three examples of a black rectangle in close-up, showing the fine lines of which it is made:

In the first two examples above, there are so many missing lines that the printhead may be faulty. In the
third case there are only a few missing lines, which are acceptable, because the printer can compensate
for such minor problems.

Corrective action
If part 3 shows a problem with one printhead, but part 2 shows no problem, there is no immediate need
to take any corrective action, because the printer is able to compensate for the problem and maintain
print quality. However, if part 2 also shows a problem, continue as follows:

1. Clean the printheads. See Recover (clean) the printheads on page 97.

2. If there is no improvement in print quality, replace the printhead that shows the problem. See
Remove a printhead on page 92 and Insert a printhead on page 94.

If I still have a problem
If the entire Image Diagnostics Print contains no defects and you still experience print quality problems,
here are some things to check:

● Try using a higher print quality option. See Choose print quality settings on page 57 and Change
the print quality on page 57.

● Check the driver you are using to print with. If it is a non-HP driver, download the correct HP driver
from the Web: see Update my printer's software on page 116.

● If you are using a non-HP RIP, its settings may be incorrect. Refer to the documentation that came
with the RIP.

● Check that your printer's firmware is up to date. See Update my printer's firmware on page 116.
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● Check that you have the right settings in your software application.

● If you are seeing a problem only at the top of the page, see A defect near the start of a print
on page 154.
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13 How do I... (paper advance calibration
topics)

Your printer was calibrated at the factory to ensure that it advances the paper accurately when using
supported paper types in normal environmental conditions. However, you may find it useful to recalibrate
in certain circumstances:

● Unsupported paper: different paper manufacturers provide papers with a wide range of properties
such as paper thickness or stiffness, which may benefit from calibration. You can expect the best
print quality when using HP's recommended papers (see Supported paper types on page 200).

● Abnormal but stable environmental conditions: if you are printing in unusual conditions of
temperature or humidity (see Environmental specifications on page 210), and those conditions
are expected to remain stable, recalibration may be worthwhile.

However, paper advance calibration assumes that you have an image quality problem and that you have
already followed the appropriate troubleshooting procedure for that problem. If you have no particular
problem, there is no need to perform the calibration.

Before performing paper advance calibration, use the Image Diagnostics Print to check that the
printheads are correctly aligned (see Print the Image Diagnostics Print on page 118).

NOTE: In theory, paper advance calibration should improve print quality. However, if you find the
calibration print difficult to interpret, you may choose the wrong paper advance setting and thus degrade
print quality. In this case, you can restore the original factory settings by selecting the  or  icon at
the front panel, and then Paper advance calibration > Optim. for drawings/text or Optimize for
images > Select Pattern > Factory Default.

● Overview of the calibration process

● The calibration process in detail

● After calibration

Overview of the calibration process
1. Use the front panel to print a colored pattern stored in the printer seven times, each time with a

different paper advance setting.

2. Decide which pattern has been printed most successfully.

3. Use the front panel to tell the printer which pattern was best—and therefore which paper advance
setting to use in future.

NOTE: There are separate paper advance settings for each paper type name in the front panel: each
must be calibrated separately. When you calibrate a particular paper type, the settings for all other paper
types are unaffected.
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NOTE: There are separate paper advance settings for Optimized for drawings/text and Optimized
for images: each must be calibrated separately.

NOTE: Papers from different manufacturers may require different paper advance settings even if they
are of the same type, therefore the calibration will be useful only for the particular paper you calibrated.
Remember that, when you perform the calibration, you will overwrite any previous paper advance
settings for this paper type.

The calibration process in detail
Step 1. Load the printer with the type of paper that you plan to use for printing subsequently. The paper
must be at least 41 cm wide (16 in) and 75 cm long (30 in).

Step 2. At the front panel, highlight the  or  icon. If you are using an HP Designjet 4520 series
printer, and you have two rolls loaded, make sure that the roll you intend to calibrate is ready to print (it
should be highlighted on the front panel).

Step 3. Press the Select key, then Paper advance calibration.

Step 4. Select Optim. for drawings/text or Optimize for images, depending on the type of prints you
wish to make subsequently.

NOTE: It is very important to use the same setting that you will later use for printing in the driver, the
Embedded Web Server or the front panel (Optimized for drawings/text or Optimized for images).
Otherwise the calibration has no effect.

Step 5. Select Print Patterns. The printer will print a series of numbered patterns (1 to 7), each looking
like this if you selected Drawings/text:

or like this if you selected Images:

The Optim. for drawings/text print takes about three minutes, the Optimize for images print takes
about five minutes. When the calibration print has finished printing, the printer will cut the paper.

Step 6. Look at each of the printed patterns (1 to 7) and decide which one shows the best quality. Each
pattern has one part on the left that is a continuous color gradient (A), and another part on the right (B).
Either part can be used to help you decide which is the best of the series of patterns; it will depend on
your circumstances. However, if you are using glossy paper or canvas, you are recommended to ignore
part A and make your selection by looking at part B only.
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In the color gradient, part A, you should look for light or dark horizontal bands (banding), which indicate
that the paper advance is not quite right. Usually you will see dark bands across the first pattern and
light bands across the last pattern (see the examples below). The best pattern is one with no banding;
if in doubt, select the pattern in the middle, between the last pattern with dark bands and the first pattern
with light bands.

If you find it difficult to identify the best pattern, the following scenario descriptions may help you.

● Where you have only one pattern which is clearly the best and the ones above and below contain
light/dark bands, select this pattern.
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● Where you have two patterns next to each other which do not show signs of banding, see below,
use the patterns above and below these two to help you select. For example, if the pattern above
the two equal ones contains less banding then choose the pattern just below it.

● Where you have three patterns which show no signs of banding, select the middle pattern.

If you look at part B of the print, you will probably see that it appears darker in some patterns than in
others. The best pattern is the one that appears lightest, most uniform and least grainy.

Step 7. Select the  or  icon, and then Paper advance calibration > Optim. for drawings/text
or Optimize for images > Select pattern.

Step 8. Select the number of the pattern (1 to 7) that printed best. If you found it difficult to choose
between two patterns e.g. patterns 3 and 4, then select “Between pattern 3 and 4”.

The calibration is complete.

After calibration
If you find that the paper advance calibration has reduced but not eliminated your print quality problem,
you could try step 7 again and select a different number. If you are seeing light bands, try selecting a
lower number than your original selection; if you are seeing dark bands, try a higher number.

If you later want to cancel your calibration and restore the paper advance setting with which the printer
left the factory, select the  or  icon, and then Paper advance calibration > Optim. for drawings/
text or Optimize for images > Select pattern > Factory default.
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14 The problem is... (paper topics)

● The paper cannot be loaded successfully [4020]

● The paper cannot be loaded successfully [4520]

● A paper jam (paper stuck in the printer) [4020]

● A paper jam (paper stuck in the printer) [4520]

● A paper jam in drawer 2 [4520]

● Prints do not stack properly in the bin

● The printer uses a lot of paper to align the printheads

● The paper moves while the printer is in standby mode [4520]

● The printer unloads or trims the paper after a long period of disuse [4520]

● The printer unloads the paper while switched off [4520]

● The printer unloads the paper when switched on [4520]
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The paper cannot be loaded successfully [4020]
NOTE: This topic applies to the HP Designjet 4020 Printer series only.

● The paper may be loaded at an angle (skewed or mislocated). Check that the right-hand edge of
the paper is aligned with the half-circle on the right-hand side of the platen and, particularly in the
case of sheet paper, that the leading edge is aligned with the metal bar in the platen.

● The paper may be crumpled or warped, or may have irregular edges.

Rolls
● If the paper gets stuck in the paper path to the platen, it may be that the leading edge of the paper

is not straight or clean, and needs to be trimmed. Remove the initial 2 cm (1 in) from the roll and
try again. This may be necessary even with a new roll of paper.

● Check that the spindle is correctly inserted. The spindle lever on the right should be in the horizontal
position.

● Check that the paper is correctly loaded on the spindle, and that it loads over the roll towards you.

● Check that the paper is wound tightly on the roll.

Sheets
● Check that the leading edge of the sheet is aligned with the cutter channel in the platen.

● Do not use hand-cut sheets, which may be of irregular shapes. Use only purchased sheets.

Here is a list of front panel messages related to paper loading, with the suggested corrective action.

Front panel message Suggested action

Right edge of roll too far from load line. The roll has not been loaded correctly, the right–hand edge was not aligned
with the half–circle on the platen. Press the Select key to try to load the roll
again.

Right edge of sheet too far from load
line.

The sheet has not been loaded correctly, the right–hand edge was not aligned
with the half-circle on the platen. Press the Select key to try to load the sheet
again.

Right edge not found. The printer cannot locate the right–hand edge of the paper, the paper may be
badly positioned. Press the Select key and try to load the roll again.

Sheet edge not found. The printer cannot locate the edges of the paper, the paper may be badly
positioned. Press the Select key and try to reload the sheet.

Paper not found. During the paper load process the printer did not detect any paper. Press the
Select key to retry.

Paper loaded with too much skew. During the paper load process the printer detected that the paper had too much
skew. Press the Select key to try to load the paper again.

Paper too small. During the load process the printer detected that the paper is too narrow or too
short to be loaded in the printer. Press the Cancel key to stop the load process.
See Functional specifications on page 208.

Paper too big During the load process the printer has detected that the paper is either too
wide or too long (sheet only) to be loaded properly. Press the Cancel key to
stop the load process. See Functional specifications on page 208.
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Front panel message Suggested action

Sheet too long. During the load process the printer has detected that the sheet is too long to be
loaded properly. Make sure that the printer expects sheet and not roll. Press
the Select key to try to load the paper again. See Functional specifications
on page 208.

Lever lifted. During the load process the paper load lever was lifted. This prevents the printer
from loading the paper. Press the Select key to load the paper again.

The paper cannot be loaded successfully [4520]
NOTE: This topic applies to the HP Designjet 4520 Printer series only.

● The paper may be loaded at an angle (skewed or mislocated).

● The paper may be crumpled or warped, or may have irregular edges.

● If the paper gets stuck in the paper path to the platen, it may be that the leading edge of the paper
is not straight or clean, and needs to be trimmed (see Trim the paper with the manual cutter
[4520] on page 38). Remove the initial 2 cm (1 in) from the roll and try again. This may be necessary
even with a new roll of paper.

● Check that the drawer is correctly closed.

● Check that the spindle is correctly inserted.

● Check that the paper is correctly loaded on the spindle, and that it loads over the roll towards you.

● Check that the paper is wound tightly on the roll.

● Check that the roll is not separated from the black hub on the right side of the spindle.

Here is a list of front panel messages related to paper loading, with the suggested corrective action.

Front panel message Suggested action

Right edge not found. The printer cannot locate the right–hand edge of the paper, the paper may be badly
positioned. Press the Select key and try to load the roll again.

Paper not found. During the paper load process the printer did not detect any paper. Press the
Select key to retry.

Paper loaded with too much skew. During the paper load process the printer detected that the paper had too much
skew. Press the Select key to try to load the paper again.

Paper too small. During the load process the printer detected that the paper is too narrow or too short
to be loaded in the printer. Press the Cancel key to stop the load process. See
Functional specifications on page 208.

Lever lifted. During the load process the paper load lever was lifted. This prevents the printer
from loading the paper. Press the Select key to load the paper again.

A paper jam (paper stuck in the printer) [4020]
NOTE: This topic applies to the HP Designjet 4020 Printer series only.

When a paper jam occurs, you will normally see the Possible paper jam message in the front panel,
with one of two error codes:

● 81:01 indicates that paper cannot advance into the printer.

● 86:01 indicates that the printhead carriage cannot move from side to side.
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Check printhead path
1. Switch off the printer at the front panel, then also switch off the power switch at the rear.

2. Open the window.

3. Try to move the printhead carriage out of the way.
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4. Lift the paper load lever as far up as it will go.

5. Carefully remove any of the jammed paper that you can lift up and out from the top of the printer.

6. Carefully pull the rest of the roll or sheet down and out of the printer.

7. Switch on the printer.

8. Reload the roll, or load a new sheet. See Load a roll into the printer [4020] on page 24 or Load a
single sheet [4020] on page 28.

9. If you find that there is still some paper causing an obstruction within the printer, it can often be
cleared by loading a rigid paper type into the printer.

10. If you find that you have print quality problems after a paper jam, try realigning the printheads.
See Align the printheads on page 101.

Check paper path
● This problem can occur when a roll has finished and the end of the roll is stuck to the cardboard

core. If this has happened, cut the end of the roll away from the core; you should then be able to
feed the paper through the printer, and load a new roll.

● Otherwise, follow the procedure described above, under Check printhead path on page 132.

A paper jam (paper stuck in the printer) [4520]
NOTE: This topic applies to the HP Designjet 4520 Printer series only.

When a paper jam occurs, you will normally see the Possible paper jam message in the front panel,
with one of the following error codes:

● 81:01 indicates that paper cannot advance into the printer.

● 84.1x:01 indicates a paper jam in drawer 1.
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● 84.2x:01 indicates a paper jam in drawer 2 (see A paper jam in drawer 2 [4520] on page 142).

● 86:01 indicates that the printhead carriage cannot move from side to side.

If you press the Select key, the front panel will display an animation showing how to recover from the
paper jam. This animation can be viewed at any time by selecting the  icon, then > Printer
configuration > Clean drawer roller. Alternatively, you can refer to this document (see below).

Check printhead path
1. Switch off the printer at the front panel, then also switch off the power switch at the rear.

2. Disengage the bin or stacker from the printer.

3. Open the window.
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4. Lift the drive pinch lever as far up as it will go.

5. Lift the roll 1 paper load lever.

6. Lift the roll 2 paper load lever.

7. Lift the lower drawer upwards a little, then pull it towards you as far as it will go.
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8. Cut the paper.

9. Remove the roll.

10. Lift the upper drawer upwards a little, then pull it towards you as far as it will go.

11. Cut the paper.
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12. Remove the roll.

13. Lower the lock lever on the left.

14. Lower the lock lever on the right.

15. Pull the front path towards you as far as it will go.
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16. Try to move the printhead carriage out of the way.

17. Carefully remove any of the jammed paper that you can lift up and out from the top of the printer.

18. Push paper inwards on the platen.
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19. Carefully pull the rest of the paper down and out of the printer. Look to see if there any loose pieces
of paper left in the paper path.

20. Push the front path back into place.

21. Lift the lock lever on the left.
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22. Lift the lock lever on the right.

23. Push the upper drawer back into place.

24. Push the lower drawer back into place.

25. Lower the drive pinch lever.
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26. Lower the roll 1 paper load lever.

27. Lower the roll 2 paper load lever.

28. Close the window.

29. Switch on the printer.

30. Reload the rolls. See Load a roll into the printer [4520] on page 33.

If you find that there is still some paper causing an obstruction within the printer, it can often be
cleared by loading a rigid paper type into the printer.

31. Re-engage the bin or stacker with the printer.

32. If you find that you have print quality problems after a paper jam, try realigning the printheads.
See Align the printheads on page 101.
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Check paper path
● This problem can occur when a roll has finished and the end of the roll is stuck to the cardboard

core. If this has happened, cut the end of the roll away from the core; you should then be able to
feed the paper through the printer, and load a new roll.

● Otherwise, follow the procedure described above, under Check printhead path on page 134.

A paper jam in drawer 2 [4520]
NOTE: This topic applies to the HP Designjet 4520 Printer series only.

A paper jam in drawer 2 is indicated on the front panel by a Possible paper jam message with the error
code 84.2x:01.

If you press the Select key, the front panel will display an animation showing how to recover from the
paper jam. Alternatively, you can refer to this document (see below).

To clear the paper jam:

1. Switch off the printer at the front panel, then also switch off the power switch at the rear.

2. Disengage the bin or stacker from the printer.

3. Open the window.
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4. Lift the drive pinch lever as far up as it will go.

5. Lift the roll 2 paper load lever.

6. Lift the lower drawer upwards a little, then pull it towards you as far as it will go.

7. Cut the paper.
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8. Remove the roll.

9. Lift the upper drawer upwards a little, then pull it towards you as far as it will go.

10. Carefully remove the cut-off lower end of the paper.

11. Carefully remove any paper that you can lift up and out from the top of the printer.

144 Chapter 14   The problem is... (paper topics) ENWW

Paper problem
s



12. Investigate the front of the roll module, behind the drawers.

13. Remove any paper that you see there.

14. Remove any paper trapped between the roll and the small plastic rollers.

15. Go behind the printer and find the three vertical slits at the rear of the roll module.
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16. If you can see paper through the slits, try to remove it by pushing it upwards or downwards.

17. Return to the front of the printer, and push the upper drawer back into place.

18. Push the lower drawer back into place.

19. Lower the drive pinch lever.
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20. Lower the roll 2 paper load lever.

21. Close the window.

22. Switch on the printer.

23. Reload the rolls. See Load a roll into the printer [4520] on page 33.

If you find that there is still some paper causing an obstruction within the printer, it can often be
cleared by loading a rigid paper type into the printer.

24. Re-engage the bin or stacker with the printer.

25. If you find that you have print quality problems after a paper jam, try realigning the printheads.
See Align the printheads on page 101.

Prints do not stack properly in the bin
● Prints at the bottom of the bin may be damaged by the weight of the prints above them. For this

reason, you are recommended to collect prints from the bin before it becomes full.

● Coated paper with high ink content may be crumpled when falling into the bin. In this case, you are
recommended to collect prints from the bin more frequently than usual.

The printer uses a lot of paper to align the printheads
In order to align the printheads accurately, the printer sometimes needs to feed through up to 3 m (≈10
ft) of paper before starting the printhead alignment process. This is normal behavior and you should not
try to interrupt or prevent it. See Align the printheads on page 101.

The paper moves while the printer is in standby mode
[4520]

NOTE: This topic applies to the HP Designjet 4520 Printer series only.
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While the printer is in standby mode, it may briefly come to life and move the paper slightly from time to
time in order to maintain the paper in the best possible condition. This is done only with certain specific
paper types (film, glossy paper and heavyweight coated paper).

The printer unloads or trims the paper after a long period
of disuse [4520]

NOTE: This topic applies to the HP Designjet 4520 Printer series only.

The printer may automatically unload or trim a roll if it has not been used for several days, in order to
maintain the paper in the best possible condition. This is done only with certain specific paper types
(glossy and heavyweight coated paper).

The printer unloads the paper while switched off [4520]
NOTE: This topic applies to the HP Designjet 4520 Printer series only.

While the printer is switched off at the front panel, it may automatically unload a roll in order to maintain
the paper in the best possible condition. This is done only with certain specific paper types (glossy paper
and heavyweight coated paper).

The printer unloads the paper when switched on [4520]
NOTE: This topic applies to the HP Designjet 4520 Printer series only.

If the printer is switched off using the switch at the rear, or by disconnecting the power cable, or by a
power cut, whenever it is switched on again it may automatically unload a roll in order to maintain the
paper in the best possible condition. This is done only with certain specific paper types (glossy paper
and heavyweight coated paper).

CAUTION: If you want to turn off the printer, you are strongly recommended to use the Power button
on the front panel before using the switch at the rear or disconnecting the power cable.
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15 The problem is... (print quality topics)

● General advice

● Banding (horizontal lines across the image)

● Lines are missing or thinner than expected

● Solid bands or lines printed over the image

● Graininess

● The paper is not flat

● The print smudges when touched

● Ink marks on the paper

● A defect near the start of a print

● Lines are stepped

● Lines are printed double or in wrong colors

● Lines are discontinuous

● Lines are blurred (ink bleeds from lines)

● Lines are slightly warped

● Color accuracy

● PANTONE color accuracy

● Color matching between different HP Designjets

● Improving gray neutrality
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General advice
When you have any print quality problem:

● To achieve the best performance from your printer, use only genuine manufacturer's supplies and
accessories, whose reliability and performance have been thoroughly tested to give trouble-free
performance and best-quality prints. For details of recommended papers, see Supported paper
types on page 200.

● Make sure that the paper type selected in the front panel is the same as the paper type loaded
into the printer. To check this, highlight the  or  icon on the front panel.

● Bear in mind that roll paper will generally give better print quality than a single sheet of the same
kind of paper. When you are using single sheets of paper, we strongly recommend that you always
set the print quality to Best.

● Check that you are using the most appropriate print quality settings for your purposes (see Choose
print quality settings on page 57). You are most likely to see print quality problems if you have set
the print quality to Fast.

● To maintain the best print quality at the expense of speed, change the Printhead monitoring
setting to Intensive. See Manage printhead monitoring on page 97.

● Check that your environmental conditions (temperature, humidity) are suitable for high-quality
printing. See Environmental specifications on page 210.

Banding (horizontal lines across the image)
If your printed image suffers from added horizontal lines as shown (the color may vary):

1. Check that you are using appropriate print quality settings. See Choose print quality settings
on page 57.

2. If the problem persists, clean the printheads. See Recover (clean) the printheads on page 97.

3. Consider changing to a heavier paper type: we recommend HP Heavyweight Coated Paper or HP
Productivity Photo Gloss when printing dense colors.

4. If the problem persists, use the Image Diagnostics Print to find out more about it. See How do I...
(Image Diagnostics Print topics) on page 117.
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Lines are missing or thinner than expected

1. Check that the line thickness and color settings are correct in your application.

2. Check that you are using appropriate print quality settings. See Choose print quality settings
on page 57.

3. If the problem persists, clean the printheads. See Recover (clean) the printheads on page 97.

4. If the problem persists, use the Image Diagnostics Print to find out more about it. See How do I...
(Image Diagnostics Print topics) on page 117.

Solid bands or lines printed over the image
This kind of problem can show itself in several different ways, illustrated below in magenta:

1. A thick colored band

2. Thinner colored bands

3. Discontinuous colored blocks

4. Thin lines

In each case the recommended procedure is as follows:

1. Clean the electrical connections of the printhead that seems to be responsible (in this example,
the magenta printhead). See Clean a printhead's electrical connections on page 97.

2. Clean the printheads. See Recover (clean) the printheads on page 97.
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3. Reprint your image with the same settings as before.

4. If the problem persists, replace the printhead that seems to be causing the problem. If you are not
sure which printhead is responsible, use the Image Diagnostics Print to identify it. See How do I...
(Image Diagnostics Print topics) on page 117.

Graininess

1. Check that you are using appropriate print quality settings. See Choose print quality settings
on page 57.

2. Use the Image Diagnostics Print to find out more about the problem. See How do I... (Image
Diagnostics Print topics) on page 117.

The paper is not flat
If the paper does not lie flat when it comes out of the printer, but has shallow waves in it, you are likely
to see visible defects in the printed image, such as vertical stripes. This can happen when you use thin
paper that becomes saturated with ink.

Try changing to a heavier paper type: we recommend HP Heavyweight Coated Paper or HP Productivity
Photo Gloss for printing dense colors. See also Choose print quality settings on page 57.

The print smudges when touched
The black ink pigment can smudge when touched by a finger or pen. This is particularly noticeable on
the following materials: vellum, translucent bond, films, productivity photo paper and natural tracing
paper.
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To reduce the smudging:

● Try to print in an environment which is not too humid for the printer. See Environmental
specifications on page 210.

● Change pure black objects in your image to a dark color, such as dark brown, so that they will be
printed with colored inks instead of black ink.

● Use HP Heavyweight Coated Paper.

● Increase the drying time (see Change the drying time on page 41).

Ink marks on the paper
This problem may occur for several different reasons.

Smears on the front of coated paper
If a lot of ink is used on coated paper, the paper absorbs the ink quickly and expands. As the printheads
move over the paper, the printheads come into contact with the paper and the printed image is smeared.

Whenever you notice this problem, you should cancel the printing job immediately. Press the Cancel
key and also cancel the job from your computer application. Otherwise the soaked paper may damage
the printheads.

Try the following suggestions to avoid this problem:

● Use a recommended paper type (see Supported paper types on page 200).

● If the image you are printing contains intense color, try using HP Heavyweight Coated Paper.

● Use extended margins (see Adjust the margins on page 59), or try to increase the margins by
relocating the image within the page using your software application.

● If necessary, try changing to a non-paper-based material such as transparent film.

Smears or scratches on the front of glossy paper
Glossy paper may be extremely sensitive to the bin or to anything else that it contacts soon after printing.
This will depend on the amount of ink printed and the environmental conditions at the time of printing.
Avoid any contact with the paper surface and handle the print with care.

Ink marks on the back of the paper
Ink residues on the platen or on the input rollers are likely to mark the back of the paper. See Clean the
platen on page 112 and Clean the input rollers on page 112.

Ink marks when the stacker is in use [4520]
NOTE: The stacker is available with the HP Designjet 4520 Printer series only.

Try the following suggestions:

● Clean the stacker roller. See Clean the stacker rollers on page 53.

● Check that the paper you're using is compatible with the stacker. See Using paper with the stacker
[4520] on page 201.

● When printing in Fast mode on Translucent Bond, Vellum or Natural Tracing Paper, there could be
some ink transfer marks in highly inked areas. Select Normal or Best mode to avoid this problem.
See Change the print quality on page 57.
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A defect near the start of a print
There is a type of defect that affects only the start of a print, within 5.5 cm of the leading edge of the
paper. You may see a thin or thick band of inconsistent color:

To avoid this problem:

1. The easiest solution is to select the Extended Margins option in the driver, the Embedded Web
Server or the front panel. This means that the area of the paper affected by the problem (at the
start of the page) will no longer be printed on. See Adjust the margins on page 59.

2. Align the printheads. See Align the printheads on page 101.

3. Check that you are using appropriate print quality settings. See Choose print quality settings
on page 57.

Lines are stepped
If lines in your image appear stepped or jagged when printed:

1. The problem may be inherent in the image. Try to improve the image with the application you are
using to edit it.

2. Check that you are using appropriate print quality settings. See Choose print quality settings
on page 57.

3. Turn on the Maximum Detail option.

Lines are printed double or in wrong colors
This problem can have various visible symptoms:

● Colored lines are printed double, in different colors.
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● The borders of colored blocks are wrongly colored.

To correct this kind of problem:

1. Align the printheads. See Align the printheads on page 101.

2. Check that you are using appropriate print quality settings. See Choose print quality settings
on page 57.

Lines are discontinuous
If your lines are broken in the following way:

1. Check that you are using appropriate print quality settings. See Choose print quality settings
on page 57.

2. You are more likely to get good vertical lines with roll paper than with sheet paper. If you must use
sheet paper, set the print quality to Best.

3. Consider changing to a heavier paper type, such as HP Heavyweight Coated Paper or HP
Productivity Photo Gloss. SeeChoose print quality settings on page 57.

4. Align the printheads. See Align the printheads on page 101.

Lines are blurred (ink bleeds from lines)
If you see that the ink is soaking into the paper, making the lines blurred and fuzzy, this could be because
of humidity in the air. Try the following:

1. Check that your environmental conditions (temperature, humidity) are suitable for high-quality
printing. See Environmental specifications on page 210.

2. Try changing to a heavier paper type, such as HP Heavyweight Coated Paper or HP Productivity
Photo Gloss. SeeChoose print quality settings on page 57.

NOTE: Glossy photo paper types are especially difficult to dry. Take extra care with them.

3. Check that the paper type selected in the front panel is the same as the paper type you are using.
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4. Perhaps you have adjusted the drying time at the front panel to speed up the printer output. Select
the  icon, then Select drying time, and make sure it is set to Optimal.

5. Allow the prints time to dry separately; do not cover or stack them.

Lines are slightly warped
The paper itself may be warped. This can happen if it has been used or stored in an extreme
environment. See Environmental specifications on page 210.

Color accuracy
There are two basic requirements for color accuracy:

1. Ensure that your paper type has been calibrated, which will give you consistency from print to print,
and from printer to printer. See Perform color calibration on page 68.

2. Select suitable options in your application: see How do I... (color topics) on page 67.

NOTE: If you are not using PostScript, remember that your printer may be configured to use one of
its internal pen palettes instead of your software's palette (which is the default). See Pen settings seem
to have no effect on page 165.

Color accuracy using EPS or PDF images in page layout applications
Page layout applications such as Adobe InDesign and QuarkXPress do not support color management
of EPS, PDF or grayscale files.

If you have to use such files, try to ensure that the EPS, PDF or grayscale images are already in the
same color space that you intend to use later on in Adobe InDesign or QuarkXPress. For instance, if
your final goal is to print the job in a press that follows the SWOP standard, at the time of creating the
EPS, PDF or grayscale you should convert the image into SWOP.

PANTONE color accuracy
Spot colors are special premixed inks to be used directly in the press, and the best-known spot colors
are PANTONE colors.

If you have the PostScript model, your printer provides a facility called Automatic PANTONE Calibration,
which can easily match most of the PANTONE Solid Coated spot colors. When an application sends a
PANTONE color to print, it sends the PANTONE name together with its own estimate of equivalent
CMYK values. The Automatic PANTONE Calibration facility recognizes the PANTONE name and
converts it to CMYK in a way that depends on the printer model and the selected paper type, enabling
the color to be rendered with greater precision than is possible with the generic CMYK values sent by
the application.

Even when using Automatic PANTONE Calibration, you cannot expect the printer to match the
PANTONE colors exactly. Your printer is certified by Pantone for some papers, but this does not mean
that it can reproduce 100% of the PANTONE colors.

Using Automatic PANTONE Calibration (the best choice)
In order to use Automatic PANTONE Calibration, you need an application that recognizes the PANTONE
colors, and a calibrated PostScript printer.

The Automatic PANTONE Calibration facility emulates PANTONE Solid Coated colors only (suffix C).
Other PANTONE colors will be printed using the CMYK values sent by the application.
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Converting PANTONE colors manually
If you have a non-PostScript printer, or if you are using an application (such as Adobe Photoshop) that
does not send the name of the PANTONE color to the printer, you will not be able to use Automatic
PANTONE Calibration. Instead, if you wish, you can convert each PANTONE color manually to CMYK
values in the application, using tables produced especially for your printer and paper type.

If your application has a facility to convert PANTONE colors to CMYK values automatically, it probably
does not take account of printer or paper type, so you will get better results with a manual conversion
using the tables.

You can also obtain a PANTONE calibrated color chart in EPS, TIFF and PDF format, which can be
convenient if your application has an eyedropper tool with which you can pick up colors from an imported
graphic.

Tips
● Automatic PANTONE Calibration works with PostScript printers only.

● Ensure that Automatic PANTONE Calibration is turned on in the driver.

● Some applications may not support PANTONE colors fully; for example, Photoshop 7.0 does not
send the PANTONE Color with its name, it sends only the CMYK values from its standard table.

● Some colors may be out of gamut and impossible to match precisely with your printer and paper
type.

Color matching between different HP Designjets
If you print an image on two different printer models (for instance, on an HP Designjet 4020 Printer series
and an HP Designjet 1000 Printer series), you may find that the colors of the two prints do not match
well.

Matching two printing devices that use different ink chemistry, paper chemistry and printheads is unlikely
to be completely successful. The information provided here is the best way to emulate one printer with
another. Even so, the end result may not be a perfect match.

Printing via separate PostScript drivers
The situation is that you are printing on each printer using the PostScript driver installed for that printer.
In this example, we are using an HP Designjet 4020 Printer series and an HP Designjet 1000 Printer
series.

1. Ensure that both printers have been updated to the latest firmware version. See Update my printer's
firmware on page 116.

2. Ensure that you have the latest printer driver for both printers. You can download the latest drivers
for the HP Designjet 4020ps from http://www.hp.com/go/4020ps/drivers/.

3. Ensure that Color Calibration is turned on. At the front panel of the HP Designjet 4020 series, select
the  icon, then Printer configuration > Color calibration > On .

4. Load the printers with similar paper types.

5. Ensure that the Paper Type setting on the front panel corresponds to the paper you have loaded.

6. Print your image on the HP Designjet 1000 Printer series using your normal settings.

7. Now prepare to print the same image on the HP Designjet 4020 Printer series.
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8. In your application, set the color space of the image to emulate the HP Designjet 1000 Printer
series and the specific paper type that you used in that printer. The data sent to the driver must be
already converted to this emulation color space, which is a CMYK color space. See your
application's online help for information on how to do this. In this way, the 4020 series will emulate
the colors that the 1000 series can produce when printing on that paper type.

9. In the PostScript driver for the HP Designjet 4020 Printer series, go to the Color Management
section and set the CMYK input profile to the same HP Designjet 1000 Printer series color space
that you selected in the application (the emulation color space).

NOTE: When trying to emulate another printer you should always use CMYK colors, not RGB.

10. Set the rendering intent to Relative Colorimetric, or to Absolute Colorimetric if you want to emulate
the whiteness of the paper.

11. Print the image on the HP Designjet 4020 Printer series.

Printing via separate HP-GL/2 and HP RTL drivers
The situation is that you are printing on each printer using the HP-GL/2 and HP RTL driver installed for
that printer.

1. Ensure that both printers have been updated to the latest firmware version. See Update my printer's
firmware on page 116.

2. Ensure that you have the latest printer driver for both printers. You can download the latest drivers
for the HP Designjet 4020 from http://www.hp.com/go/4020/drivers/.

3. Ensure that Color Calibration is turned on. At the front panel of the HP Designjet 4020 Printer series,
select the  icon, then Printer configuration > Color calibration > On .

4. Load the printers with similar paper types.

5. Ensure that the Paper Type setting on the front panel corresponds to the paper you have loaded.

6. With the HP-GL/2 and HP RTL driver for the HP Designjet 4020 Printer series, select the Color tab,
and select Printer Emulation from the list of color management options. Then choose the
Designjet 1000 series from the list of emulated printers.

7. With the HP-GL/2 and HP RTL driver for the HP Designjet 1000 series, select the Options tab,
then Manual Color > Color Control > Match Screen. You should also select the Paper Size tab,
then Paper Type.

Printing the same HP-GL/2 and HP RTL file
The situation is that you have produced an HP-GL/2 and HP RTL file (also known as a PLT file) using
the HP-GL/2 and HP RTL driver installed for one printer, and you intend to send the same file to both
printers.

1. Ensure that both printers have been updated to the latest firmware version. See Update my printer's
firmware on page 116.

2. Ensure that Color Calibration is turned on. At the front panel of the HP Designjet 4020 Printer series,
select the  icon, then Printer configuration > Color calibration > On .

3. Load the printers with similar paper types.
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4. Ensure that the Paper Type setting on the front panel corresponds to the paper you have loaded.

5. If you have an HP-GL/2 and HP RTL file produced for an HP Designjet 1000 Printer series and you
want to print it on an HP Designjet 4020 Printer series, proceed as follows using the Embedded
Web Server or the front panel.

● Using the Embedded Web Server: leave the color options set to Default.

● Using the front panel: select the  icon, then Default printing options > Color options >
Select RGB input profile > HP Designjet 1000 Series.

For other HP Designjet printers, set both printers to match the screen colors (sRGB if selectable),
as when printing with separate HP-GL/2 and HP RTL drivers.

Improving gray neutrality
There are two ways to improve the gray neutrality in printed plots:

● Use the setting Optimized Gray Neutrality, which is applicable to HP-GL/2 and HP RTL files only.

This setting will mainly improve the neutrality of the light gray area fills by changing the ink
composition of the gray areas, putting more black ink and less color ink (the area fills will be printed
with less composite colors, and with more black ink only). One possible side effect: the image
quality may be reduced as less composite color ink is used to print. If this happens, try selecting
better image quality settings (for example, changing from Normal to Best), or doing only the visual
gray calibration without enabling optimized gray neutrality.

● Use a specific Visual Gray Calibration, applicable to any file format.

This calibration can be performed from the front panel by printing some gray patterns of different
neutrality, and by selecting the best one. This calibration is optimized for one specific image quality
setting and specific paper. So it is very important, before printing the pattern, to set, within the front
panel, the default image quality settings that you normally use and to load the right paper type. If
you are using different image quality settings and different papers, different calibrations have to be
done, one calibration for each image quality setting and paper.

The two calibrations are independent, and can be applied both at the same time, or only one. When
setting the Optimized Gray neutrality, and doing a visual calibration, finding the difference between
the different color patterns can be difficult. Just select the one that is nearest your preference.

Optimized gray neutrality calibration
To select optimized gray neutrality for HP-GL/2 and HP RTL prints.

1. On the printer's front panel, select then Default printing options > HP-GL/2 Options >
Optimized Gray Neutrality.

2. Select when you want the setting applied from one of the following options:

● Never (default option)

● Drawings/text only

● Images only

● Always

Example: If you select Drawings/text only, optimized gray neutrality will be applied only if, within
the image quality settings of the plot sent, Optimized for is set to Drawings/text.

3. Please validate this setting with some sample gray plots before performing the visual gray
calibration described in next section.
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NOTE: This option only applies to HP-GL/2 and HP RTL prints and it is designed to improve
medium to low density gray area fills.

Visual gray calibration
This calibration will be optimized for the Image Quality options that are selected in the front panel at the
time the calibration is done.

1. It is important to select from the front panel menu the image quality settings you normally use.
Select the  icon, then Default Printing Options > Image quality.

● Select print quality: (Best, Normal, Fast).

● Select optimize for: (Drawings/text, Images).

● Enable maximum detail: (On, Off).

2. Make sure that the paper loaded is the paper on which you want to print the neutral gray.

3. Print the first pattern to select the best gray, go to the front panel, select the  icon, then
Printhead > Visual gray calibration > Print first pattern.

4. The pattern will contain a set of images printed with different corrections of CMYK, if one of these
patterns provides the desired gray neutrality go to step 6, if there is not an exact match, choose
the number of the pattern closest to the desired gray neutrality.

5. Print the second pattern that you select from the previous step, identify the closest pattern to the
gray neutrality you want:

● Print pattern 1

● Print pattern 2

● Print pattern 3

● Print pattern 4

● Print pattern 5

● Print pattern 6

● Print pattern 7

6. Enable the calibration: Select the  icon, then Printhead > Visual gray calibration > Enable
calibration.

7. Enter the CMYK values printed on the selected pattern into in the front panel menu: Select the
 icon, then Printhead > Visual gray calibration > Select Pattern.

Some cautionary notes
When using the above procedure bear in mind the following information:

● The process applies the CMYK correction to all paper types loaded, and to all image quality
settings, but it can guarantee gray neutrality only for the paper type and front-panel print-quality
settings that were used while doing the calibration. The calibration should be run again with any
other print-quality settings and paper types that you might use (one calibration per print-quality
settings + paper).

● If you change the printheads, you should recalibrate.

● When selecting the different gray patterns, make sure that you use the lighting conditions in which
you want the final image to be viewed, fluorescent light or sunlight for example.
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● The gray neutrality patterns tend to change with time (mainly during the first day), so, before
selecting the right gray pattern, consider waiting a day to get the perfect gray neutrality.

● For advanced users (specific configuration): HP-GL/2 and HP RTL using the CMYK contone path
will not be affected by this calibration.

Important note about using the stacker: Remove the stacker if it is connected while printing the
patterns. If the stacker is installed when printing the calibration sheets for gray neutrality, seven different
sheets will be printed and each of them will be 42 cm long and at least 50% of the paper will not be
printed, this is because the minimum length per plot that can be printed through the stacker is 42 cm.

How to remove the stacker:

1. Disconnect the stacker from the front of the printer.

2. Uninstall the stacker: select the  icon on the printer's front panel, then Accessories > Stacker
> Uninstall stacker.

3. Once you have printed the patterns, reconnect the stacker, and install the stacker through the front
panel, the front panel will automatically ask you to reinstall (again, less than a ten second
operation).

Options
The Windows and Mac OS drivers provide a preset facility that enables you to skip steps 6 and 7 in the
visual gray calibration procedure (do not enable the visual gray calibration from the front panel) and
store the CMYK settings as a ‘Quick Set’, 'Printing Shortcut’ or ‘Preset’ within the driver.

Quick Sets/Printing Shortcuts under Windows
1. Go to Printing Preferences (in the driver).

2. Select the Color tab.

3. Select Advanced Color Settings (HP-GL/2 and HP RTL driver) or Advanced color
adjustments (PostScript driver).

4. Enter the CMYK values in the color sliders and press OK.

5. Select the Paper/Quality tab.

6. Enter the Print Quality settings used in the front panel while printing the gray patterns (steps 1 to
5 of the Visual gray calibration procedure).

7. In the HP-GL/2 and HP RTL driver, enter a name in the text box Print Task Quick Sets and
press Save. The new Quick Set is then stored for future use.

In the PostScript driver, select the Printing Shortcuts tab, press Save As and enter a name. The
new Printing Shortcut is then stored for future use.

Whenever a new print is required with the selected gray neutrality settings, follow these steps:

1. Go to Printing Preferences (in the driver).

2. In the HP-GL/2 and HP RTL driver, select the stored Quick Set and press OK.

In the PostScript driver, select the Printing Shortcuts tab, then the stored shortcut, and press OK.

3. Press OK.
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Presets under Mac OS
1. Open the printing dialog.

2. Select the Color Options panel.

3. Press Show Advanced Options.

4. Select the CMYK Settings tab.

5. Enter the CMYK values in the color sliders.

6. Select the Image Quality panel.

7. Enter the Print Quality settings used in the front panel while printing the gray patterns (steps 1 to
5 of the Visual gray calibration procedure).

8. Save these settings as presets on the drop-down list.

Whenever a new print is required with the selected gray neutrality settings, follow these steps:

1. Open the printing dialog.

2. Select the stored preset from the Presets drop-down list.
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16 The problem is... (image error topics)

● The print is completely blank

● The output contains only a partial print

● The image is clipped

● The image is in one portion of the printing area

● The image is unexpectedly rotated

● The print is a mirror image of the original

● The print is distorted or unintelligible

● One image overlays another on the same sheet

● Pen settings seem to have no effect

● Some objects are missing from the printed image

● A PDF file is clipped or objects are missing

● No output when printing from Microsoft Visio 2003
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The print is completely blank
If the front-panel graphic language setting is Automatic (the default), try the other settings:
PostScript for a PostScript file, HP-GL/2 for an HP-GL/2 and HP RTL file, etc. (see Change the graphic
language setting on page 65). Then send the file again.

When you have finished this particular print, remember to reset the graphic language to Automatic.

The output contains only a partial print
● Did you press Cancel before all the data were received by the printer? If so, you have ended the

data transmission and will have to print the page again.

● The I/O timeout setting may be too short. From the front panel, you can increase the I/O
timeout setting to a longer period and then send the print again. Select the  icon, then I/O
setup > Select I/O timeout.

● There may be a communications problem between your computer and the printer. Check your
interface cable.

● Check to make sure that your software settings are correct for your current page size (e.g. long-
axis prints).

● If you are using network software, make sure it has not timed out.

The image is clipped
Clipping normally indicates a discrepancy between the actual printable area on the loaded paper and
the printable area as understood by your software.

● Check the actual printable area for the paper size you have loaded.

printable area = paper size – margins

The Windows HP-GL/2 and HP RTL driver displays the printable area in the Paper/Quality tab.

● Check what your software understands to be the printable area (which it may call "printing area"
or "imageable area"). For example, some software applications assume standard printable areas
that are larger than those used in this printer.

● If your image contains its own margins, you may be able to print it successfully by telling the printer
not to add margins to it (see Print without added margins on page 60). In this case:

printable area = paper size

● If you are trying to print a very long image on a roll, check that your software is capable of printing
an image of that size.

● Check that the orientation of the paper is the same as that assumed by your software. The front-
panel Default printing options > Paper options > Rotate option changes both the orientation of
a print and the orientation of the page. It is possible that a rotated image on a roll may be slightly
clipped in order to retain the correct page size.

● You may have asked to rotate the page from portrait to landscape on a paper size that is not wide
enough.

● If necessary, change the printable area in your software.

There is another possible explanation for a clipped image. Some applications, such as Adobe
Photoshop, Adobe Illustrator and CorelDRAW, use an internal 16-bit coordinate system which means
that they cannot handle an image of more than 32,768 pixels. If you try to print an image larger than this
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from these applications, the bottom of the image will be clipped. In this case, the only way to print the
whole image is to reduce the resolution so that the whole image requires fewer than 32,768 pixels. The
HP-GL/2 and HP RTL printer driver contains an option called Compatibility with 16-bit applications,
which can be used to reduce the resolution of such images automatically. You can find this option by
selecting the driver's Services tab, then the Troubleshoot Software Problems icon.

The image is in one portion of the printing area
● Have you selected too small a page size in your application?

● Does your application think that the image is in one portion of the page?

The image is unexpectedly rotated
At the front panel, select the  icon, then Default printing options > Paper options > Rotate. Check
that the setting is what you wanted.

For non-PostScript files: if Nesting is On, pages may be automatically rotated to save paper. See Rotate
an image on page 62.

The print is a mirror image of the original
At the front panel, select the  icon, then Default printing options > Paper options > Enable mirror
image. Check that the setting is what you wanted.

The print is distorted or unintelligible
● The interface cable connecting your printer to your network (or to your computer) could be faulty.

Try another cable.

● If the front-panel graphic language setting is Automatic (the default), try the other settings:
PostScript for a PostScript file, HP-GL/2 for an HP-GL/2 and HP RTL file etc. (see Change the
graphic language setting on page 65). Then send the file again.

● Depending on the software, drivers and RIPs you are using with your printer, there will be different
ways of solving this problem. Refer to the vendor's user documentation for details.

One image overlays another on the same sheet
The I/O timeout setting may be too long. From the front panel, decrease the setting and print again.
Select the  icon, then I/O setup > Select I/O timeout.

Pen settings seem to have no effect
Here are some possible explanations:

● You have changed the settings in the front panel by selecting the  icon followed by Default
printing options > HP-GL/2 options > Define palette, but you have forgotten to select that palette
in Default printing options > HP-GL/2 options > Select palette.

● If you want the software-driven pen settings, you must remember to go to the front panel and select
the  icon followed by Default printing options > HP-GL/2 options > Select palette >
Software.
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Some objects are missing from the printed image
Large quantities of data may be necessary to print a high-quality large-format print job, and in some
specific workflows there may be issues that can lead to some objects missing from the output. If you
are using the HP-GL/2 and HP RTL driver for Windows, try selecting the Troubleshoot Software
Problems icon in the Services tab, and turning on all troubleshooting options: Compatibility with 16-
bit applications, Send Job as a Bitmap, and Enable SpoolSmart.

The above settings are mentioned for troubleshooting purposes and may adversely affect the final output
quality or the time necessary to generate the print job. Therefore, they should be restored to their default
values if they do not help to solve the problem.

A PDF file is clipped or objects are missing
In older versions of Adobe Acrobat or Adobe Reader, large PDF files could be clipped or lose some
objects when printing with the HP-GL/2 and HP RTL driver at high resolution. In order to avoid such
problems, please upgrade your Adobe Acrobat or Adobe Reader software to the latest version. From
version 7 onwards, these problems should be solved.

No output when printing from Microsoft Visio 2003
For more information about problems when printing large images (more than 129 inches long) from
Microsoft Visio 2003, see Microsoft's online knowledge base (http://support.microsoft.com/search/).

To avoid these problems, it is possible to scale the image down in Visio to a size shorter than 129 inches
and then to scale the drawing up in the driver by using the Resizing Options in the Effects tab of the
Windows HP-GL/2 and HP RTL or PostScript drivers. If the downscaling in the application and the
upscaling in the driver match, the result will be as originally intended.
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17 The problem is... (ink system topics)

● I cannot insert an ink cartridge

● The printer will not accept a large black ink cartridge

● I cannot remove an ink cartridge

● I cannot insert a printhead

● I cannot insert a printhead cleaner

● The front panel keeps telling me to reseat or replace a printhead

● An ink cartridge status message

● A printhead status message

● A printhead cleaner status message
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I cannot insert an ink cartridge
1. Check that you have the correct type of cartridge (model number).

2. Check that the colored label on the cartridge is the same color as the label on the slot.

3. Check that the cartridge is correctly oriented, with the colored label at the top.

CAUTION: Never clean inside the ink cartridge slots.

The printer will not accept a large black ink cartridge
Black ink cartridges of 775 cm³ capacity are supported by the HP Designet 4520 series, and by the HP
Designjet 4020 series with firmware release 4.1.1.5 or later. If you experience this problem with an HP
Designjet 4020 series printer, try updating the firmware (see Update my printer's firmware
on page 116).

I cannot remove an ink cartridge
In order to remove an ink cartridge, you should first select Remove ink cartridges at the front panel
(see Remove an ink cartridge on page 88). If you try to remove the cartridge without using the front
panel, the cartridge may get stuck, and the front panel will display an error message.

To recover from this situation, press on the cartridge itself (not on the drawer or the blue tab) to push it
back into place. The error message should then disappear (it will disappear after a short time even if
you have not corrected the problem), and you can then restart the process in the correct way by
selecting Remove ink cartridges.

I cannot insert a printhead
1. Check that you have the correct type of printhead (model number).

2. Check that you have removed the blue protective cap and the clear protective tape from the
printhead.

3. Check that the colored label on the printhead is the same color as the label on the slot.

4. Check that the printhead is correctly oriented (compare with the others).

5. Check that you have closed and latched the printhead cover.

I cannot insert a printhead cleaner
1. Check that you have the correct type of cleaner (model number).

2. Check that the colored label on the cleaner is the same color as the label on the slot.

3. Check that the cleaner is correctly oriented (compare with the others).

The front panel keeps telling me to reseat or replace a
printhead

1. Remove the printhead and check that its protective film has been removed.

2. Try cleaning the electrical connections between the printhead and the carriage. See Clean a
printhead's electrical connections on page 97.
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3. Reinsert the printhead into the carriage and check the front panel message.

4. If the problem remains, try a new printhead.

An ink cartridge status message
These are the possible ink cartridge status messages:

● OK: the cartridge is working normally, with no known problems

● Missing: there is no cartridge present, or it is not properly connected to the printer

● Low: the ink level is low

● Very low: the ink level is very low

● Empty: the cartridge is empty

● Reseat: you are recommended to remove the cartridge and then reinsert it

● Replace: you are recommended to remove the cartridge and then reinsert it; if that fails, replace
the cartridge with a new cartridge

● Altered: there is something unexpected about the cartridge's status—perhaps it has been refilled

A printhead status message
These are the possible printhead status messages:

● OK: the printhead is working normally, with no known problems

● Missing: there is no printhead present, or it is not properly installed in the printer

● Reseat: you are recommended to start the printhead removal process from the front panel (see
Remove a printhead on page 92), but instead of removing the printhead, just press the Select key
on the front panel

● Replace: you are recommended to remove the printhead and then reinsert it; if that fails, clean the
electrical connections; if that fails, replace the printhead with a new printhead

● Remove: the printhead is not a suitable type for use in printing (for instance, a setup printhead)

A printhead cleaner status message
These are the possible printhead cleaner status messages:

● OK: the cleaner is working normally, with no known problems

● Missing: there is no cleaner present, or it is not properly installed in the printer

● Reseat cleaner: you are recommended to remove the cleaner and then reinsert it

● Wrong stall: the cleaner has been installed in the wrong place

● End of life: the cleaner has reached the end of its planned lifetime

● Not replaced with printhead: you have installed a new printhead without installing the new cleaner
that came with it

If a printhead cleaner needs to be removed or reseated, you must start the printhead replacement
process (see Remove a printhead on page 92). Open the window when prompted to do so by the front
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panel. If the front panel shows the printheads with no printhead blinking, you do not need to touch the
printheads. Just close the window again, and the printer will proceed to printhead cleaner replacement.
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18 The problem is... (stacker topics) [4520]

NOTE: This chapter applies to the HP Designjet 4520 Printer series only.

● Paper scrolling

● The trailing edge of the paper curling up

● The paper is not completely ejected

● The front panel displays that the stacker is disconnected
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Paper scrolling
When printing in Fast mode with highly curled paper, the paper may scroll when ejected to the stacker
tray. To avoid this problem, you are recommended to switch to Normal mode or use a paper roll with a
3 inch core.

The trailing edge of the paper curling up
Use the Optimize for images setting: see Change the print quality on page 57.Th

The paper is not completely ejected
Check for any obstruction in the paper path, such as loose objects or other pieces of paper.
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The front panel displays that the stacker is disconnected
If the front panel constantly or intermittently claims that the stacker is disconnected from the printer,
there may be a problem with the height of the stacker. Use the following procedure to adjust the height
of the stacker.

1. Using an hexagonal wrench, loosen the upper hexagonal nut on both of the stacker's wheels that
are closest to the printer.

2. Adjust the height of the stacker by rotating the lower hexagonal nut clockwise or anti-clockwise.
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3. When the correct height has been achieved, tighten the upper hexagonal nut.
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19 The problem is... (other topics)

● The printer's start-up process does not complete

● A front panel message

● A “printhead monitoring” message

● A “printheads are limiting performance” message

● An “on hold for paper” message [4520]

● The printer does not print

● The printer seems slow

● The application slows down or hangs up while generating the print job

● Communication failures between computer and printer

● I cannot access the Embedded Web Server from my browser

● An out-of-memory error

● An AutoCAD 2000 memory allocation error

● The platen rollers squeak
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The printer's start-up process does not complete

If the printer's start-up process stops when the front panel is displaying the number 17, this indicates
that there is a problem with the file system on the printer's hard disk, so the printer is checking the whole
file system and making any necessary corrections. This problem can arise when there has been a power
cut while the printer was switched on, or if there is a physical problem with the hard disk.

Checking the whole file system normally takes about half an hour. There is nothing you can do to speed
it up. If you turn off the printer, the file system check will restart whenever you turn it on again.

If you experience this problem repeatedly when there has been no power cut, contact your customer
service representative.

A front panel message 
The front panel displays messages of many kinds; some allow you to continue using the printer while
others require you to take action before you can continue.

● If the printer detects a condition of which you should be aware, it displays a message for your
information. Examples of information messages are performance limiting conditions and printer
maintenance requirements. Once you have read the message you can remove it by pressing
the Select key and continue to use the printer.

● If the printer detects an error, an error code and short message are displayed on the front panel.
The following table provides suggested actions to recover from these error conditions:

Code Short message Suggested action

01.3:01 RM2 Not Connected Check the cable at the rear between Roll Module 2 and the
Printer is correctly connected.

13:01 Reseat all cartridges Remove and re-insert all the print cartridges; see Remove an ink
cartridge on page 88 and Insert an ink cartridge on page 91. If
the problem persists, please contact your customer service
representative.

26.0:01 Reseat yellow cartridge The yellow cartridge is not detected, please try to re-install it;
see Remove an ink cartridge on page 88 and Insert an ink
cartridge on page 91. If the problem persists, please contact your
customer service representative.

26.1:01 Reseat magenta cartridge The magenta cartridge is not detected, please try to re-install it;
see Remove an ink cartridge on page 88 and Insert an ink
cartridge on page 91. If the problem persists, please contact your
customer service representative.

26.2:01 Reseat black cartridge The black cartridge is not detected, please try to re-install it;
see Remove an ink cartridge on page 88 and Insert an ink
cartridge on page 91. If the problem persists, please contact your
customer service representative.

26.3:01 Reseat cyan cartridge The cyan cartridge is not detected, please try to re-install it;
see Remove an ink cartridge on page 88 and Insert an ink
cartridge on page 91. If the problem persists, please contact your
customer service representative.
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Code Short message Suggested action

27:03 Restart the printer. If problem persists, call
HP support.

An error has been detected during printhead detection. Reseat
all the printheads; see Remove a printhead on page 92 and Insert
a printhead on page 94 and Restart on page 16. If the problem
persists, please contact your customer service representative.

38.1:01 Stacker communication error

Check connections

No communications have been received from the stacker. Check
that the stacker is switched on and connected to the printer. If
necessary, you can remove the stacker completely and continue
printing without it (if printing has not started yet) or cancel a half-
printed job and restart. If you cancel a half-printed job, the paper
will be cut, and ejected when the stacker is restarted.

38.2:01 Status mismatch. Reset stacker. The stacker has been switched off and on in the middle of a print
job. The job is automatically canceled, the paper is cut and
ejected.

39:01 Input rollers 1 and 2 need cleaning. Press
Enter to quit, or Cancel to continue.

See Clean the input rollers on page 112.

61:01 Wrong file format. The printer cannot
process the job.

The file format is wrong and the printer cannot process the job.
Check the graphic language setting of your printer (see Change
the graphic language setting on page 65). If you are sending
PostScript from Mac OS over a USB connection, select ASCII
encoding in both the driver and the application. Check for the
latest firmware and driver releases.

61:04.1 Update system software (firmware) Even if you have the latest version installed on your printer, you
are recommended to repeat the update process to clear this
error. See Update my printer's firmware on page 116.

61:08.1 File with password cannot be printed. Resend this file without password protection.

62:04 Restart the printer. If problem persists, call
HP support.

An error has been detected with the parallel port. See Restart
on page 16 If the problem persists, check for the latest firmware
release.

63:04 Restart the printer. If problem persists, call
HP support.

An error has been detected with a LAN port. See Restart
on page 16 If the problem persists, check for the latest firmware
release.

64:04 Restart the printer. If problem persists, call
HP support.

An error has been detected with the USB port. See Restart
on page 16 If the problem persists, check for the latest firmware
release.

66:08 Please resubmit the job as the paper type
has changed

The paper type has changed since the job was submitter. The
job cannot be printed on the paper that is loaded; please resubmit
the job or change the paper.

71:03 Restart the printer. If problem persists, call
HP support.

Out of memory failure. You are recommended to remove any
unnecessary files from the hard disk using the Embedded Web
Server. See Restart on page 16.

76:03 Restart the printer. If problem persists, call
HP support.

The hard disk is full. If the problem persists, you are
recommended to remove any unnecessary files from the hard
disk, using the Web server. See Restart on page 16.

77:04 Restart the printer. If problem persists, call
HP support.

The Embedded Web Server does not seem to be working.
See Restart on page 16 If the problem persists, check for the
latest firmware release.

79:04 Generic firmware error. Turn off the printer and disconnect the power cord. Reconnect
the power cord and switch on the printer. If the problem persists,
check for the latest firmware release.

81:01 Possible paper jam A paper jam has been detected within the printer. See A paper
jam (paper stuck in the printer) [4020] on page 131 or A paper
jam (paper stuck in the printer) [4520] on page 133.
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Code Short message Suggested action

83.y:1x Stacker internal error

Reset stacker

The print job is automatically canceled and cut. Switch the
stacker off and then on again. If the problem remains, remove
the stacker and continue printing without it.

84.1x:01 Possible paper jam A paper jam has been detected in drawer 1. See A paper jam
(paper stuck in the printer) [4520] on page 133.

84.2x:01 Possible paper jam A paper jam has been detected in drawer 2. See A paper jam in
drawer 2 [4520] on page 142.

86:01 Possible paper jam A paper jam has been detected in the platen area. See A paper
jam (paper stuck in the printer) [4020] on page 131 or A paper
jam (paper stuck in the printer) [4520] on page 133.

Stacker communication error. Check
connections.

No communication received from the stacker. Connect the
stacker or turn it on.

Stacker disengaged. Attach it to printer. Switch off the stacker, attach it to the printer, then switch it on
again. Check that the height of the stacker is correctly adjusted.

Stacker full of media Remove the accumulated pile of paper from the stacker.

Stacker paper jam Remove the accumulated pile of paper from the stacker. Turn it
off and then on again.

If your printer front panel is displaying an error code which is not in the list above, try the following: restart
the printer (see Restart on page 16) and/or check to make sure you have the latest firmware and driver
versions (see Update my printer's firmware on page 116). If the problem persists, contact your customer
service representative.

A “printhead monitoring” message
This is not an error message. The message is displayed whenever the Printhead monitoring option is
set to Intensive. If you change the setting to Optimized, the message will not appear. See Manage
printhead monitoring on page 97.

A “printheads are limiting performance” message
This message appears on the front panel during printing when the printer has detected that one or more
printheads are not performing optimally, and so it needs to make extra passes to maintain print quality.
To eliminate this message, choose one of the following:

● Select a higher print quality; see Change the print quality on page 57.

● Clean the printheads; see Recover (clean) the printheads on page 97.

● Use the Image Diagnostics Print to identify which printhead is causing the problem; see How do
I... (Image Diagnostics Print topics) on page 117.

An “on hold for paper” message [4520]
NOTE: This topic applies to the HP Designjet 4520 Printer series only.
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NOTE: To see the job queue at the front panel, select the  icon and then Job queue.

Based on a set of criteria that you can set when sending a job, the HP Designjet 4520 will decide which
of the rolls of paper loaded in the printer is more suitable to print the job. If there is no roll of paper
available that meets all the conditions set previously, the HP Designjet 4520 will then put the job on hold
for paper. You can manually resume the job and forces it to print on a paper different from the one that
was set when the job was sent, otherwise it will stay on hold.

Which criteria are used to decide to which roll a job will be printed?
When a user sends a job, the paper type that is desired can be set (in the driver or in the Embedded
Web Server). The printer will print this job on a roll of paper of the chosen paper type and one that is
wide enough to print the drawing without clipping. In case there is more than one roll where the job could
be printed meeting all the criteria, the roll will be chosen according to your preferences. These can be
set by using a setting in the printer’s Front Panel: Paper Menu > Paper handling options > Roll
switching options which has two possible values:

● Minimize paper waste. If this option is chosen, the printer will choose the narrowest roll that meets
all the criteria, to avoid wasting paper due to trimming.

● Minimize roll change. If this option is chosen, the printer will choose the roll that is currently loaded
on the print platen, to avoid wasting time with a roll switch.

The default option is Minimize paper.

When is a job put on hold for paper?
A job is put on hold for paper in the following cases:

● The paper type that has been selected by the user is not currently loaded on the printer.

● The paper type that has been selected by the user is loaded on the printer, but the drawing is too
wide to fit on any of the rolls of this paper type without clipping.

If I load a new roll of paper, will jobs that were on hold for paper be
automatically printed?

Yes. Since firmware 8.1.1.3, every time a new roll of paper is loaded, the printer will check if there are
any jobs on hold for paper that could be printed on the loaded roll. In case the answer is yes, the printer
will ask if these jobs should be automatically resumed with the following message:

● Would you like to print the jobs that are on hold for paper? Yes/No

I don’t like jobs being put on hold for paper. Can I prevent it?
Yes, this can be done from the front panel: select the  icon and then Job management options >
Enable on hold for paper. There are two options:

● When needed (default value). Jobs are put on hold for paper when there is no paper loaded on
the printer that meets the necessary conditions: correct paper type and correct paper size.

● Never. Jobs are never put on hold for paper. If there is no paper loaded that meets all the conditions
set by the user, the job is printed on whichever roll seems most suitable for it.

I set the option “Enable on hold for paper” to Never, but some jobs are still
put on hold

If the Show print preview option is selected in the driver or the Embedded Web Server, jobs are put
on hold until you have checked the preview and resumed the job. Check that the Show print preview
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option is not checked in the driver, and that there are no pending preview windows waiting for
confirmation to continue printing.

My job is exactly as wide as the roll of paper that is loaded on the printer,
but is put on hold for paper

Margins are managed in different ways depending on the file type:

● For HP-GL/2 and HP RTL files, by default, margins are included inside the drawing, so a 36 inches
HP-GL/2 and HP RTL file can be printed with margins in a 36 inches roll of paper and will not be
put on hold for paper.

● For other file formats however, like PostScript, PDF, TIFF or JPEG, by default, the printer considers
that margins need to be added outside of the drawing (as in many cases, these formats are used
for photographs and other contents where margins are not included). This means that to print a 36
inches TIFF, the printer needs to add some margins and the drawing needs 36.4 inches of paper
to be printed; this would cause the job to be put on hold if the paper that is loaded on the printer is
only 36 inches wide.

For these file formats, if it is desired to print them without adding extra margins outside of the
drawing, the Clip contents by margins option can be used. This option will force the margins to be
set inside of the drawing, so a 36 inches TIFF can be printed in a 36 inches roll of paper without
being put on hold. However, it needs to be taken into account that, if there is no white space already
included in the drawing’s borders, some contents could be clipped because of the margins.

The printer does not print
If all is in order (paper loaded, all ink components installed and no file errors), there are still reasons
why a file you have sent from your computer may not start printing when expected, this is because the
file has been put on hold for paper:

● You may have an electrical power problem. If there is no activity at all from the printer, and the front
panel does not respond, check that the power cable is connected correctly and that there is power
available at the socket.

● You may be experiencing unusual electromagnetic phenomena, such as strong electromagnetic
fields or severe electrical disturbances, which can cause the printer to behave strangely, or even
stop working. In this case, turn off the printer using the Power key on the front panel, wait until the
electromagnetic environment has returned to normal and then turn it on again. If you still experience
problems, please contact your customer service representative.

● You may have the wrong graphic language setting. See Change the graphic language setting
on page 65.

● You may not have installed in your computer the correct driver for your printer. See the Setup
instructions.

● The right paper may not be available to print the job, perhaps because:

◦ The selected roll is not loaded.

◦ The selected paper type is not loaded on any roll.

◦ There is not enough paper of the selected type to print the whole job.

On the HP Designjet 4520 series, a job may be held in the queue for one of these reasons, while
other jobs in the queue are printed because the right paper is available for them. In this case, you
can print the held job by loading the correct paper and using the front panel or the Embedded Web
Server to continue the job.
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● If you are using Mac OS with a USB connection, you may find that you need to change the data
encoding. Select the  icon, then Default printing options > PS options > Select encoding
> ASCII. Then configure your application to send ASCII data.

● The print file may lack a proper file terminator and the printer is therefore waiting for the specified
I/O timeout period before assuming it is complete.

● Nesting may be on and the printer is waiting for the specified nest wait timeout period before
calculating the appropriate nests. In this case, the printer display shows the remaining time for the
nesting timeout.

● You may have requested a print preview from your printer driver. This is a function you can use to
check that the image is the one you want. In this case, the preview is displayed in a Web browser
window, and you must click a button to start printing.

The printer seems slow
Here are some possible explanations.

● Did you set the print quality to Best? Best-quality prints take longer.

● Did you specify the correct paper type when loading the paper? To find out the printer's current
paper type setting, see View information about the paper on page 40.

● Do you have a network connection to your printer? Check that all components used in the network
(network interface cards, hubs, routers, switches, cables) are capable of high-speed operation. Is
there a lot of traffic from other devices on the network?

● Did you specify Extended drying time in the front panel? Try changing the drying time to Optimal;
see Drying time on page 201.

● Are your printheads in good condition? The printer may print slower to maintain print quality when
a printhead is faulty. Check the printhead status in the front panel or in the Embedded Web Server,
and recover or replace printheads if necessary.

● Do you have high-density black areas in your image? In this case, the printer may change
temporarily to a slower print quality option in order to maintain quality.

The application slows down or hangs up while generating
the print job

Large quantities of data may be necessary to generate a high-quality large-format print job. In some
cases, this may cause your application to slow down very noticeably (taking several minutes to generate
the print job) or even to hang up.

To avoid this behavior in the Windows HP-GL/2 and HP RTL driver, select the Services tab, then the
Troubleshoot Software Problems icon, then try turning on the Compatibility with 16-bit applications
option. However, we recommend turning off this option for most jobs, because it may adversely affect
final print quality.

Communication failures between computer and printer
Some symptoms are:

● The front-panel display does not show the “Receiving” message when you have sent an image to
the printer.

● Your computer displays an error message when you are trying to print.
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● Your computer or printer “hangs” (stays idle) while communication is taking place.

● Your printed output shows random or inexplicable errors (misplaced lines, partial graphics etc.)

To solve a communication problem:

● Ensure that you have selected the correct printer in your software.

● Ensure that the printer works correctly when printing from other software.

● Remember that very large prints may take some time to receive, process and print.

● If the printer is connected to a network, try using it when connected directly to your computer
through a FireWire or USB cable. See Connect the printer on page 191.

● If your printer is connected to your computer through any other intermediate devices, such as switch
boxes, buffer boxes, cable adapters, cable converters, etc., try using it when connected directly to
your computer.

● Try another interface cable. See Connect the printer on page 191.

● Ensure that the graphic language setting is correct. See Change the graphic language setting
on page 65.

I cannot access the Embedded Web Server from my
browser

If you have not done so already, please read Access the Embedded Web Server on page 17.

● Have you set an administrator password for the Embedded Web Server on the Security page, and
then forgotten the password? If so, select the  icon, then Printer configuration > Resets >
Reset EWS password.

● At the printer's front panel, select the  icon, then Printer configuration > Allow EWS > On.

● Check that you have a TCP/IP (network or FireWire) connection to your printer. If you connect
directly to your printer with a USB cable, you cannot use the Embedded Web Server.

● If you are using a FireWire connection, make sure that your computer's operating system supports
IP over IEEE-1394 (FireWire). For example, Windows XP and Windows 2003 Server support IP
over FireWire, but Windows 2000 does not. Make sure that your operating system is configured to
use IP over FireWire.

● At the printer's front panel, check that IP is enabled for the type of connection you are using. Select
the  icon, then I/O setup, then the type of connection you are using, then View information,
and check that you see IP enabled. If not, you may need to use a different type of connection.

● If you normally access the Web through a proxy server, try bypassing the proxy server and
accessing the Web server directly. You can do this by modifying your browser settings.

For instance, if you are using Internet Explorer 6 for Windows, go to Tools > Internet Options
> Connections > LAN Settings and check the 'Bypass proxy server for local addresses' box.
Alternatively, for more precise control, click the Advanced button and add the printer's IP address
to the list of Exceptions for which the proxy server is not used.

● Try switching off the printer (with the Power key on the front panel) and then switching it on again.
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An out-of-memory error
There is no direct relationship between the size of a file in your computer and the amount of memory
needed in the printer to print the file. In fact, because of file compression and other complicating factors
it is often impossible to estimate how much memory will be needed. So it is possible that a print will fail
for lack of memory even though you may have successfully printed larger files in the past. In this case
you may need to consider adding more memory to your printer.

If you are using the Windows HP-GL/2 and HP RTL driver, you can often solve printer memory problems
by selecting the Services tab, then the Troubleshoot Software Problems icon, then turning on the Send
Job as a Bitmap option.

NOTE: If you select this option, the time needed to process the job in your computer may be
considerably longer.

An AutoCAD 2000 memory allocation error
After installing the printer driver, when you try to print for the first time from AutoCAD 2000, you may
see a message saying Memory allocation error, after which your image is not printed.

This is due to a problem in AutoCAD 2000, and it can be fixed by downloading the Plotting Update Patch
(plotupdate.exe) from the Autodesk Web site, http://www.autodesk.com/.

This patch is also worth trying if you have any other strange problems when printing from AutoCAD
2000.

The platen rollers squeak
It may occasionally be necessary to oil the rollers. The Maintenance Kit, which came with your printer,
contains a bottle of suitable oil.

1. Turn off the printer using the Power key on the front panel.

2. Open the window.
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3. There are small holes in the platen beside some of the rollers.

Using the bottle of oil supplied with the Maintenance Kit, insert the pointed end of the bottle into
each hole in turn, and put three drops of oil into each hole.

4. Repeat the process until all of the holes in the platen have had three drops of oil placed in them.

5. Be careful not to spill oil onto the platen.

6. If there is oil on the platen, wipe it away with the cloth supplied with the kit.
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7. Lower the window.
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20 Tell me about... (Embedded Web Server
topics)

The Embedded Web Server is the control center for remote management of your printer. From any
computer, you can use an ordinary Web browser to contact your printer's Embedded Web Server
(see Access the Embedded Web Server on page 17).

With the Embedded Web Server, you can:

● Submit jobs to the printer in various file formats (HP-GL/2 and HP RTL, PostScript, PDF, JPEG,
TIFF, CALS G4) without the need of a driver nor an application: see Submit a job with the
Embedded Web Server on page 44.

NOTE: PostScript and PDF formats can be used with PostScript printers only.

● Control and manage all aspects of your print jobs: see Manage the print queue on page 45.

● View the status of the ink cartridges, the printheads, the printhead cleaners and the paper: see
Check the status of the ink system on page 105.

● View statistics on ink and paper usage: see Check printer usage statistics on page 108.

● Request E-mail notification when specified warning or error conditions occur (such as low ink level):
see Request E-mail notification of specific error conditions on page 19.

● Update the printer's firmware: see Update my printer's firmware on page 116.

● Change various printer settings (on the Device Setup page)

● Set a password to restrict Web access to the printer: see Password-protect the Embedded Web
Server on page 18.

ENWW 187

Em
be

dd
ed

 W
eb

 S
er

ve
r



188 Chapter 20   Tell me about... (Embedded Web Server topics) ENWW

Em
bedded W

eb Server



21 Tell me about... (printer topics)

● Color emulation modes

● Connect the printer

● The printer's rear lights

● The printer's internal prints

● Preventive maintenance
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Color emulation modes
Your printer can emulate the color behavior of other devices: RGB devices such as monitors, and CMYK
devices such as presses and printers. See Select the color emulation mode on page 69.

If you have problems making your printer emulate another HP Designjet printer, seeColor matching
between different HP Designjets on page 157.

For a good emulation, the printer needs a specification of the colors these devices can reproduce. The
standard way of encapsulating such information is in ICC profiles. As part of the solution, we provide
the most common standards for the different devices. Apart from selecting the appropriate ICC profile,
you should select the appropriate rendering intent depending on the type of print: business presentation,
photography or proof. See Set the rendering intent on page 69. For reference information on the broader
aspects of color printing refer to: http://www.hp.com/hpinfo/community/environment/productinfo/
psis_inkjet.htm

The options are as follows.

NOTE: PDF and PostScript files can be used with PostScript printers only.

CMYK color emulation
All CMYK emulation options apply to PDF, PostScript, TIFF and JPEG files only.

● None (Native): no emulation, for use when the color conversion is done by the application or
operating system, and therefore the data arrive at the printer already color–managed.

● HP CMYK Plus: a set of HP proprietary re-rendering rules that will produce a good result for most
digital commercial printing jobs, by expanding the reduced gamut of your press into the wider gamut
of your printer.

● U.S. Sheetfed Coated 2 uses specifications designed to produce quality separations using U.S.
inks under the following printing conditions: 350% total area of ink coverage, negative plate, bright
white offset stock

● U.S. Sheetfed Uncoated 2 uses specifications designed to produce quality separations using U.S.
inks under the following printing conditions: 260% total area of ink coverage, negative plate,
uncoated white offset stock

● U.S. Web Coated (SWOP) 2 uses specifications designed to produce quality separations using
U.S. inks under the following printing conditions: 300% total area of ink coverage, negative plate,
coated publication-grade stock

● U.S. Web Uncoated 2 uses specifications designed to produce quality separations using U.S. inks
under the following printing conditions: 260% total area of ink coverage, negative plate, uncoated
white offset stock

● Euroscale Coated 2 uses specifications designed to produce quality separations using Euroscale
inks under the following printing conditions: 350% total area of ink coverage, positive plate, bright
white coated stock

● Euroscale Uncoated 2 uses specifications designed to produce quality separations using
Euroscale inks under the following printing conditions: 260% total area of ink coverage, positive
plate, uncoated white offset stock

● JMPA: Japanese standard for offset press

● Photoshop 4 Default CMYK

● Photoshop 5 Default CMYK

● Other HP Designjet printers can be emulated
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In the front panel and the Embedded Web Server, some further options are available:

● Japan Color 2001 Coated uses the Japan Color 2001 specification for type 3 (coated) paper. It
is designed to produce quality separations using 350% total ink coverage, positive film and coated
paper

● Japan Color 2001 Uncoated uses the Japan Color 2001 specification for type 4 (uncoated) paper.
It is designed to produce quality separations using 310% total ink coverage, positive film and
uncoated paper

● Japan Web Coated (Ad) uses specifications developed by the Japan Magazine Publisher
Association for digital proofing of images in the Japanese magazine/advertising market

● Toyo is designed to produce quality separations for Toyo printing presses

● DIC is designed to produce quality separations for Dainippon Ink Company printing presses

NOTE: These options have no effect if the application is defining its own CMYK space, known as
calibrated CMYK or CIEBasedDEFG in PostScript terminology.

RGB color emulation
These options apply to PDF, PostScript, TIFF and JPEG files. For HP-GL/2 and HP RTL files, only sRGB
and AdobeRGB are supported.

If you want to print an RGB image, it must be converted to CMYK data (although you may be able to do
it in the application or operating system). To perform this conversion, your printer is provided with the
following color profiles:

● None (Native): no emulation. The printer will use its default internal conversion from RGB to CMYK,
without following any color standard. This does not imply that results will be bad.

● sRGB IEC61966-2.1 emulates the characteristics of the average PC monitor. This standard space
is endorsed by many hardware and software manufacturers, and is becoming the default color
space for many scanners, printers and software applications.

● ColorMatch RGB emulates the native color space of Radius Pressview monitors. This space
provides a smaller gamut alternative to Adobe RGB (1998) for print production work.

● Apple RGB emulates the characteristics of the average Apple monitor, and is used by a variety of
desktop publishing applications. Use this space for files that you plan to display on Apple monitors,
or for working with old desktop publishing files.

● Adobe RGB (1998) provides a fairly large gamut of RGB colors. Use this space if you need to do
print production work with a broad range of colors.

Connect the printer
Your printer comes with a 1000base-TX (Gigabit Ethernet) interface for network connections and a
FireWire interface for direct connection to your computer.

A USB 2.0 interface or Jetdirect print server may be installed as optional accessories.

If you are not sure which interface to use, see Choose which connection method to use on page 10.

To find the sockets for these interfaces on your printer, see the Assembly Instructions.

To set up your operating system to use the printer, see one of the following:

● Connect to a network (Windows) on page 10

● Connect to a network (Mac OS X) on page 11
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● Connect directly to a computer (Windows) on page 11

● Connect directly to a computer (Mac OS X) on page 12

The printer's rear lights
At the rear of the printer, above the power switch, are three small lights:

● The amber light on the left is on when the printer is in sleep mode.

● The blue light in the center is on when the printer is on (when it has electrical power).

● The green light on the right is on when the printer is printing.

NOTE: You should never see all three lights on at the same time, because the printer cannot print in
sleep mode.

The printer's internal prints
The internal prints give various kinds of information about your printer. They can be requested from the
front panel without using a computer.

Before requesting any internal print, make sure that paper is loaded (roll or sheet), and that the front
panel displays the Ready message. The paper should be at least 36 in (91.44 cm) wide, otherwise the
print may be clipped (HP Designjet 4020 series) or put “on hold for paper” (HP Designjet 4520 series).

To print any internal print, select the  icon, then Internal prints, then select whichever internal print
you want.

The following internal prints are available:

● Demo: shows some of the capabilities of the printer.

● Menu map: shows details of all the front panel menus.

● Configuration: shows all the current front panel settings.

● Usage report: shows estimates of the total number of prints, number of prints by paper type, number
of prints by print quality option and total amount of ink used per color. The accuracy of these
estimates is not guaranteed.
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● HP-GL/2 palette: shows the color or grayscale definitions in the currently-selected color palette.

● PostScript font list: lists the PostScript fonts installed in the printer (PostScript printers only).

● Image diagnostics: helps you to solve print quality problems. See How do I... (Image Diagnostics
Print topics) on page 117.

● Service information: provides information needed by service engineers.

Preventive maintenance
During the life of your printer, components that are used constantly can wear out with time and use.

To avoid these components being so worn that the printer breaks down, the printer keeps track of the
number of cycles the printer carriage makes across the axis of the printer and on the total quantity of
ink printed.

The printer uses this number to advise you of the need for preventive maintenance, displaying one of
the following messages on the front panel:

● Maintenance #1 required

● Maintenance #2 required

These messages mean that some components are nearing the end of their lives. You can continue
printing for quite some time, depending on your use of the printer. However it is strongly recommended
that you contact your customer service representative and arrange for a preventive maintenance on-
site visit. The service engineer can then replace the worn parts, which will prolong the life of the printer
for a further period.

The benefits of arranging a service engineer's visit when the front panel displays these messages are
two-fold:

● The printer components can be replaced at a time that is convenient for you and so will not disturb
your daily workflow.

● When the service engineer performs a preventive maintenance visit he will replace several parts
at once. This will avoid the need for repeat visits.
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22 Tell me about... (ink system topics)

● Ink cartridges

● Printheads

● Printhead cleaners

● Ink system tips
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Ink cartridges
The printer's four ink cartridges provide yellow, magenta, black and cyan ink to the printheads. The color
cartridges have a capacity of 225 and 400 cm³, the black cartridge has a capacity up to 775 cm³.

NOTE: The 225 cm³ and 400 cm³ cartridges are physically the same size: only the internal capacity
varies. The 775 cm³ black cartridge is longer.

Ink cartridges require no maintenance or cleaning. As long as each ink cartridge is inserted correctly
into its slot, the ink will flow to the printheads. Because the printheads control the amount of ink
transferred to the page, you will continue to see high-quality printing results even when the ink levels
are getting low.

Replacing ink cartridges
You can highlight the  icon at any time to check the ink levels of all the ink cartridges (as illustrated
below).

The front panel warns you when a cartridge's ink level is low. When a cartridge is empty, the printer
stops printing and the front panel explains why:

You are recommended to replace the empty cartridge with a new HP cartridge: see Remove an ink
cartridge on page 88 and Insert an ink cartridge on page 91.

Although it is possible to use refilled or non-HP ink cartridges, either choice has several serious
disadvantages:
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● There is some risk of damaging the printer. In this case the printer warranty will not be valid for any
printer repairs that are related to the cartridge, nor for any problems due to ink contamination.

● You will invalidate the warranty of all printheads of the same color used in the printer subsequently,
unless and until the whole ink system (including ink tubes) is replaced.

● Print quality may be impaired.

● The printer will be unable to estimate the ink level in the cartridge, and will report it as empty.

If you decide to use refilled or non-HP ink cartridges, you will need to follow these instructions to make
the printer use a cartridge that it believes to be empty.

1. Install the cartridge in the printer (see Insert an ink cartridge on page 91).

2. The front panel will complain that the cartridge is empty, and the cartridge removal process will
start. Press the Cancel key to stop this automatic process.

3. At the front panel, select the  icon.

4. Highlight Replace ink cartridges, but do not select it.

5. Press the Cancel key and the Up key at the same time, and hold them down for at least two seconds.

6. The front panel will display a series of warning messages. In response to each message, press
the Cancel key to cancel the process, or the Select key to confirm that you wish to continue.

When you have pressed Select in response to all warning messages, the front panel will give the usual
ink cartridge status display, but the refilled or non-HP cartridge will be shown as empty with a warning
sign.

Printheads
In order to increase printing speed, two printheads are connected to each ink cartridge, giving eight
printheads in total.

The printheads are extremely durable and do not need to be replaced every time an ink cartridge is
replaced. They will continue giving excellent results even if the ink cartridges are low in ink.

To maintain optimum print quality, the printheads are automatically tested at regular intervals, and
automatically serviced if necessary. This takes a little time and will occasionally delay printing.

When a printhead eventually needs to be replaced, the front panel will tell you so.

CAUTION: Whenever you buy a new printhead, you get a new printhead cleaner with it. When you
replace a printhead, always replace the printhead cleaner at the same time. Leaving the old printhead
cleaner in the printer will shorten the new printhead's life and possibly damage the printer.
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Printhead cleaners
Each printhead has its own printhead cleaner, so there are eight printhead cleaners in the printer.
Printhead cleaners are used to clean and maintain the printheads, to ensure the best possible print
quality and to seal the printheads when they are not in use to prevent them from drying out.

CAUTION: Whenever you buy a new printhead, you get a new printhead cleaner with it. When you
replace a printhead, always replace the printhead cleaner at the same time. Leaving the old printhead
cleaner in the printer will shorten the new printhead's life and possibly damage the printer.

NOTE: In some circumstances, the printer may ask you to replace a printhead cleaner even though
the corresponding printhead is not due for replacement. This is done in order to maintain the printer's
image quality and reliability.

Ink system tips
For best results, always follow these guidelines:

● Install the ink cartridges, printheads and printhead cleaners before the install-by date, which is
printed on the packaging.

● Install a new printhead cleaner every time you install a new printhead.

● Follow the instructions on the front panel during installation.

● Allow the printer and printhead cleaners to clean the printheads automatically.

● Avoid unnecessary removal of the ink cartridges and printheads.

● The ink cartridges should never be removed while the printer is printing. They should be removed
only when the printer is ready for you to replace them. The front panel will guide you through the
removal and installation procedures (or see Remove an ink cartridge on page 88 and Insert an ink
cartridge on page 91).
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23 Tell me about... (paper topics)

● Using paper

● Supported paper types

● Drying time

● Using paper with the stacker [4520]
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Using paper
Choosing the correct paper type for your needs is an essential step in ensuring good print quality. For
best printing results, use only recommended papers (see Supported paper types on page 200), whose
reliability and performance have been developed and thoroughly tested. All printing components (printer,
ink system and paper) have been designed to work together to give trouble-free performance and
optimal print quality.

Here are some further tips about paper usage:

● Always keep unused rolls wrapped in the plastic wrap to prevent discoloration. Rewrap partially
used rolls if they are not being used.

● Do not stack rolls.

● Allow all paper types to adapt to room conditions out of the packaging for 24 hours before printing.

● Handle film and glossy paper by the edges or wear cotton gloves. Skin oils can be transferred to
the printing material, leaving fingerprint marks.

● Keep the paper tightly wound on the roll throughout the loading and unloading procedures. If it
starts to unwind, it can become difficult to handle.

● Whenever you load a roll or a sheet, the front panel prompts you to specify the paper type you are
loading. For good print quality, it is essential to specify this correctly. If paper is already loaded,
you can check the paper type at the front panel by highlighting the  or  icon.

● The quality of some images may be reduced if you use a paper type that is unsuitable for your
image.

● Make sure the appropriate print quality setting (Fast, Normal or Best) is selected. You can set the
print quality from the driver, from the Embedded Web Server or from the front panel. Driver or
Embedded Web Server settings override front panel settings. The combination of paper type and
print quality settings tells the printer how to place the ink on the paper—for example, the ink density,
halftoning method and number of passes of the printheads. See Choose print quality settings
on page 57.

● Although the ink systems supplied with this printer have good light-fastness, colors will eventually
fade or change if exposed to sunlight over a long period of time.

Supported paper types
The following table lists the HP paper types that are most suitable for use with your printer, and show
the name that you should select in the front panel when loading each paper type. These recommended
paper types have been thoroughly tested and are known to provide the best print quality when used
with your printer. For the part numbers, widths and weights of these papers, see Ordering paper
on page 214.

Other supported paper types can be used with your printer but are not guaranteed to provide the best
print quality.

NOTE: The following list is likely to change over the course of time. For the latest information about
recommended and other supported paper types, see http://www.hp.com/info/DesignjetInkMedia/.

Table 23-1  Recommended paper types

Product name Front panel name 4020 4520

HP Bright White Inkjet Bond Paper Bright White Yes Yes

HP Universal Bond Paper Bond Paper Yes Yes
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Product name Front panel name 4020 4520

HP Coated Paper Coated Paper Yes Yes

HP Inkjet Coated Paper Coated Paper Yes Yes

HP Universal Coated Paper Coated Paper Yes Yes

HP Universal Heavyweight Coated Paper Heavyweight Coated Paper Yes Yes

HP Heavyweight Coated Paper Heavyweight Coated Paper Yes Yes

HP Natural Tracing Paper Natural Tracing Paper Yes Yes

HP Translucent Bond Paper Translucent Bond Yes Yes

HP Vellum Paper Vellum Yes Yes

HP Clear Film Clear Film Yes Yes

HP Matte Film Matte Film Yes Yes

HP Universal Semi-gloss Photo Paper High-Gloss Photo Paper Yes No

HP Universal Instant-dry Gloss Photo Paper Instant Dry Photo Gloss Yes Yes

HP Universal High-gloss Photo Paper High-Gloss Photo Paper Yes Yes

HP Canvas Paper Canvas Yes No

HP Colorfast Adhesive Vinyl High-Gloss Photo Paper Yes No

Drying time
With some printing materials and environmental conditions the ink needs some time to dry before the
printing material is unloaded. The following settings are available.

● Optimal: the printer automatically determines the appropriate drying time, based on the printing
material you have selected and the current temperature and humidity. If any drying time is required,
a “drying time to go” countdown will be displayed on the front panel.

● Extended: the default drying time is extended. This can be used if you find that the default drying
time is not enough to dry the ink sufficiently in your environment.

● Reduced: the default drying time is reduced. This can be used if you are keen to get prints as fast
as possible, and you find that the reduced drying time causes no significant problem in your
environment.

● None: no drying time is provided. This can be used, for example, if you are manually removing the
prints as fast as the printer is producing them.

To change the drying time, see Change the drying time on page 41.

Using paper with the stacker [4520]
NOTE: This topic applies to the HP Designjet 4520 Printer series only.

The stacker can handle cut sheets of paper between 420 mm (16.5 in, A3 portrait) and 1189 mm (46.8
in, A0 portrait) in length. Shorter prints will be enlarged to the minimum length with extra white space;
longer prints risk falling off the stacker.

Table 23-1  Recommended paper types (continued)
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Some printing materials are not compatible with the stacker, including:

● Matte and clear film

● Glossy paper (except instant-dry glossy paper, which may be used)

When printing in Fast mode on Translucent Bond, Vellum or Natural Tracing Paper, there could be some
ink transfer marks in highly inked areas. Select Normal or Best mode to avoid this problem. See Change
the print quality on page 57.

NOTE: You will have to remove the accumulated pile of cut sheets from the stacker every now and
then.

If you retrieve just one job from the stack, try to leave the stack in a tidy condition, otherwise you may
experience stacking problems and paper jams.

202 Chapter 23   Tell me about... (paper topics) ENWW

A
bout paper



24 Tell me about... (multiroll topics) [4520]

NOTE: This chapter applies to the HP Designjet 4520 Printer series only.

● The uses of a multiroll printer

● How the printer allocates jobs to paper rolls

● Roll switching policy
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The uses of a multiroll printer
A multiroll printer can be useful in several different ways:

● You can switch between different paper types quickly and without touching the printer.

● You can switch between different paper widths quickly and without touching the printer. This
enables you to save paper by printing smaller images on narrower paper.

● If you load two identical rolls into the printer, you can leave it printing unattended for a long time,
because it can switch from one roll to the other automatically when the first is exhausted. See
Unattended printing/overnight printing on page 49.

How the printer allocates jobs to paper rolls
When you submit a print job from the Embedded Web Server or the printer driver, you can specify (using
the Paper type or Type is option) that you want it to be printed on a particular paper type; you can even
specify (using the Paper source, Source is or Paper Feed option) that you want it to be printed on a
particular roll (1 or 2). The printer will try to satisfy these requirements, and it will also look for a paper
roll wide enough to print the image without clipping.

● If the job can be printed on either of the available rolls, the roll will be chosen according to the roll
switching policy. See Roll switching policy on page 205.

● If the job can be printed on just one of the available rolls, it will be printed on that roll.

● If the job cannot be printed on either of the available rolls, it will be held in the job queue with the
status “On hold for paper”, and not printed until you intervene. In this case, you can either change
rolls so that your requirements can be met, or you can tell the printer to go ahead and print the job
on whatever paper is available. See An “on hold for paper” message [4520] on page 178.

The printer driver for Windows will tell you which paper types and widths are currently loaded in the
printer.

Here are some settings that might be used in typical situations:

● With different paper types loaded:

◦ Type is: select the paper type you require

◦ Source is: Automatically select / Predetermined

◦ Roll switching policy: doesn't matter

● With different paper widths loaded:

◦ Type is: Any

◦ Source is: Automatically select / Predetermined

◦ Roll switching policy: Minimize paper waste

TIP: You can also save paper in some cases by rotating or nesting your images. See Rotate an
image on page 62 and Nest jobs to save roll paper on page 47.

● With identical rolls loaded:

◦ Type is: Any

◦ Source is: Automatically select / Predetermined

◦ Roll switching policy: Minimize roll changes
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Roll switching policy
If the printer has two rolls of paper and it receives a job that could be printed on either roll, it will normally
print on the currently loaded roll because there is no reason to change.

However, if the current roll is much wider than the job requires, to print on the current roll will mean some
waste of paper. If the other roll is narrower, but wide enough for the job, then paper can be saved by
printing the job on the other roll.

In these circumstances, the roll switching policy determines whether the printer changes to the narrower
roll or continues to print on the wider roll.

To set the roll switching policy at the printer's front panel, select the  icon, then Paper handling
options > Roll switching options. There are two options:

● Minimize paper waste means that, in the above circumstances, the printer will change to the
narrower roll.

● Minimize roll changes means that, in the above circumstances, the printer will continue to print
on the current roll.
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25 Tell me about... (printer specifications
topics)

● Functional specifications

● Physical specifications

● Memory specifications

● Power specifications

● Ecological specifications

● Environmental specifications

● Acoustic specifications
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Functional specifications
Table 25-1  HP No. 90 ink supplies

Printheads Yellow, magenta, black and cyan (two of each)

Printhead cleaners Yellow, magenta, black and cyan (two of each)

Ink cartridges Yellow, magenta and cyan cartridges containing 225 or 400 cm³ of ink, and black
cartridges containing up to 775 cm³ of ink

Table 25-2  Paper sizes

Minimum Maximum

Width (Designjet 4020 series) 11 in (279 mm) 42 in (1.066 m)

Width (Designjet 4520 series) 16.5 in (420 mm) 42 in (1.066 m)

Length (Designjet 4020 series) 16.5 in (420 mm) 60 in (1.5 m) for sheet and 300 ft (90 m) for
roll

Length (Designjet 4520 series) 16.5 in (420 mm) 575 ft (175 m)

Table 25-3  Print resolution

Print
quality

Max
detail

Optimized for lines and text Optimized for images

Rendering
resolution (dpi)

Printing resolution (dpi) Rendering
resolution (dpi)

Printing resolution (dpi)

Best On 1200×1200 2400×1200 (High-Gloss
Photo Paper, Canvas*)

1200×1200 (other papers)

1200×1200 2400×1200 (Productivity
Photo Gloss, High-Gloss
Photo Paper, Canvas*)

1200×1200 (other papers)

Off 600×600 1200×1200 (High-Gloss
Photo Paper, Canvas*)

1200×600 (other papers)

600×600 1200×1200 (High-Gloss
Photo Paper, Canvas*)

1200×600 (other papers)

Normal On 600×600 1200×1200 (High-Gloss
Photo Paper, Canvas*)

1200×600 (other paper
types)

600×600 1200×1200 (High-Gloss
Photo Paper, Canvas*)

1200×600 (other paper
types)

Off 600×600 1200×1200 (High-Gloss
Photo Paper, Canvas*)

1200×600 (other paper
types)

300×300 1200×1200 (Productivity
Photo Gloss, High-Gloss
Photo Paper, Canvas*)

1200×600 (other paper
types)
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Print
quality

Max
detail

Optimized for lines and text Optimized for images

Rendering
resolution (dpi)

Printing resolution (dpi) Rendering
resolution (dpi)

Printing resolution (dpi)

Fast On 600×600 1200×1200 (High-Gloss
Photo Paper)

1200×600 (other paper
types)

600×600 1200×1200 (High-Gloss
Photo Paper)

600×600 (Max Speed, Bright
White, Bond Paper)

1200×600 (other paper
types)

Off 300×300 1200×1200 (High-Gloss
Photo Paper)

600×600 (Max Speed)

1200×600 (other paper
types)

300×300 1200×1200 (High-Gloss
Photo Paper)

600×600 (Max Speed, Bright
White, Bond Paper)

1200×600 (other paper
types)

* Canvas is supported by the HP Designjet 4020 series only.

Table 25-4  Margins

Side margins 5 mm = 0.2 in (small, normal)

15 mm = 0.6 in (extended)

Top margin (leading edge) 5 mm = 0.2 in (small)

11.5 mm = 0.6 in (normal)

55 mm = 2.2 in (extended)

Bottom margin (trailing edge) 5 mm = 0.2 in (roll)

25 mm = 1 in (sheet, normal)*

55 mm = 2.2 in (sheet, extended)*

* Sheet paper is supported by the HP Designjet 4020 series only.

Table 25-5  Mechanical accuracy

±0.1% of the specified vector length or ±0.1 mm (whichever greater) at 23°C (73°F), 50-60% relative humidity, on A0 printing
material in Best or Normal mode with HP Matte Film.

Table 25-6  Graphic languages supported

HP Designjet 4020 and 4520 Printer series HP-GL/2 and HP RTL, TIFF, JPEG, CALS G4

HP Designjet 4020ps, 4520ps and 4520mfp only Adobe PostScript level 3, PDF 1.5

Physical specifications
Table 25-7  Printer physical specifications

Weight (including stand) ≈ 115 kg (Designjet 4020 series)

≈ 185 kg (Designjet 4520 series)

Table 25-3  Print resolution (continued)
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Width < 1930 mm

Depth < 800 mm

Height ≈ 1350 mm

Table 25-8  Stacker physical specifications

Weight 53 kg

Width 1286 mm

Depth 1002–1569 mm

Height 1135 mm

Memory specifications
Table 25-9  Memory specifications

Memory (DRAM) supplied 608 MB

Memory (DRAM) maximum 1120 MB

Hard disk 160 GB

Power specifications
Table 25-10  Printer power specifications

Source 100–240 V ac ±10%, autoranging

Frequency 50–60 Hz

Current < 6 A

Consumption < 1 kW

Table 25-11  Stacker power specifications

Source 115 V ac ±10% 230 V ac ±10%

Frequency 60 Hz 50 Hz

Current < 10 A < 6 A

Consumption < 1.1 kW < 1.1 kW

Ecological specifications
For the up-to-date ecological specifications of your printer, please go to http://www.hp.com/ and search
for “ecological specifications”.

Environmental specifications
Table 25-12  Printer environmental specifications

Relative humidity range for best print quality 20–80%, depending on paper type

Table 25-7  Printer physical specifications (continued)
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Temperature range for best print quality 15 to 30°C (59 to 86°F), depending on paper type

Temperature range for printing 5 to 40°C (41 to 104°F)

Temperature range when not in operation -20 to +55°C (-4 to +131°F)

Maximum altitude when printing 3000 m

Table 25-13  Stacker environmental specifications

Relative humidity range 20–80%

Temperature range for printing 5 to 40°C (41 to 104°F)

Temperature range when not in operation -20 to +50°C (-4 to +122°F)

Acoustic specifications
Table 25-14  Printer acoustic specifications

Idle sound power ≤ 5.8 B (A)

Operating sound power ≤ 7.0 B (A)

Idle sound pressure ≤ 41 dB (A)

Operating sound pressure ≤ 53 dB (A)

Table 25-15  Stacker acoustic specifications

Idle sound power < 4.5 B (A)

Operating sound power < 5.5 B (A)

Idle sound pressure < 35 dB (A)

Operating sound pressure < 57 dB (A)

Table 25-12  Printer environmental specifications (continued)
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26 Tell me about... (ordering supplies and
accessories topics)

● Ordering ink supplies

● Ordering paper

● Ordering accessories
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Ordering ink supplies
The following ink supplies can be ordered for your printer.

Table 26-1  Ink cartridges

Cartridge Capacity (cm³) Part number

HP 90 Cyan 225 C5060A

HP 90 Magenta 225 C5062A

HP 90 Yellow 225 C5064A

HP 90 Black 400 C5058A

HP 90 Cyan 400 C5061A

HP 90 Magenta 400 C5063A

HP 90 Yellow 400 C5065A

HP 90 Black 775 C5059A

HP 90 Cyan Multipack 400 × 3 C5083A

HP 90 Magenta Multipack 400 × 3 C5084A

HP 90 Yellow Multipack 400 × 3 C5085A

HP 90 Black Multipack 775 × 3 C5095A

Table 26-2  Printheads and printhead cleaners

Printhead & cleaner Part number

HP 90 Black C5054A

HP 90 Cyan C5055A

HP 90 Magenta C5056A

HP 90 Yellow C5057A

Table 26-3  Printhead cleaners

Printhead cleaner Part number

HP 90 Black C5096A

Ordering paper
The following paper types are currently provided for use with your printer.

NOTE: This list is likely to change over the course of time. For the latest information, see
http://www.hp.com/go/graphic-arts/.

Key to availability:

● :A indicates papers available in Asia (excluding Japan)

● :E indicates papers available in Europe, the Middle East and Africa

● :J indicates papers available in Japan
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● :L indicates papers available in Latin America

● :N indicates papers available in North America

If the part number is not followed by a colon, the paper is available in all regions.

Table 26-4  Premium Technical

Name g/m² 24 in wide 36 in wide 42 in wide 23.39 in
wide (A1)

33.11 in
wide (A0)

HP Bright White Inkjet Bond Paper 90 C1860A:LN

C6035A:AE

C1861A:LN

C6036A:AE

none Q1445A:EJ Q1444A:EJ

HP Bright White Inkjet Bond Paper
(300 ft)

90 none C6810A none none none

HP Matte Film 160 51642A:AEN 51642B none none none

HP Clear Film 170 C3876A:AEN C3875A none none none

HP Natural Tracing Paper 90 C3869A C3868A none Q1439A:J Q1438A:J

HP Translucent Bond 67 C3860A:AN C3859A:ALN none none none

HP Polyester Film Opaque White
Glossy

170 C7955A:EN C7956A:EN C7957A:EN none none

HP Vellum 75 C3862A:N C3861A:LN none none none

HP Coated Paper 96 C6019B C6020B C6567B Q1442A:EJ Q1441A:EJ

HP Coated Paper (300 ft) 96 none C6980A none none none

HP Heavyweight Coated Paper 131 C6029C:AEN C6030C C6569C none none

HP Heavyweight Coated Paper (225
ft)

131 none none Q1956A:EN none none

Table 26-5  Premium Photographic

Name g/m² 24 in wide 36 in wide 42 in wide

HP Productivity Photo Gloss 244 none Q1938A:AEN Q1939A:AEN

HP Productivity Photo Semi-Gloss 244 none Q1943A:AEN Q1944A:AEN

HP Photo Paper RC Matte 200 none C7946A:AEN none

HP Proofing Paper RC Satin 200 none C7952A:AEN none

Table 26-6  Universal Line

Name g/m² 24 in wide 36 in wide 42 in wide 23.39 in
wide (A1)

33.11 in
wide (A0)

HP Universal High-Gloss Photo
Paper

190 Q1426A:AEN Q1427A:AEN Q1428A:AEN none none

HP Universal Semi-Gloss Photo
Paper

190 Q1420A:AEN Q1421A:AEN Q1422A:AEN none none

HP Universal Instant-Dry Photo
Gloss

190 Q6574A:AEN Q6575A:AEN Q6576A:AEN none none

HP Universal Instant-Dry Photo
Semi-Gloss

190 Q6579A:AEN Q6580A:AEN Q6581A:AEN none none
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Name g/m² 24 in wide 36 in wide 42 in wide 23.39 in
wide (A1)

33.11 in
wide (A0)

HP Universal Inkjet Bond Paper 80 Q1396A:AEN Q1397A:AEN Q1398A:AEN Q8003A:J none

HP Universal Inkjet Bond Paper (300
ft)

80 none none none Q8004A:EJ Q8005:EJ

HP Universal Inkjet Bond Paper (500
ft)

(Designjet 4520 series only)

80 none Q8002A:AEN none none none

HP Universal Coated Paper 95 Q1404A:AEN Q1405A:AEN Q1406A none none

HP Universal Heavyweight Coated
Paper

120 Q1412A:AEN Q1413A Q1414A:AEN none none

Table 26-7  Display Graphics

Name g/m² 24 in wide 36 in wide 42 in wide

HP Super Heavyweight Plus Matte Paper 210 Q6626A Q6627A Q6628A

HP Banners with Tyvek

(Designjet 4020 series only)

140 none C6787A:AEN none

HP Colorfast Adhesive Vinyl

(Designjet 4020 series only)

328 none C6775A none

HP Backlit Film Reverse Print Matte 160 none C7960A:AEN none

HP Studio Canvas

(Designjet 4020 series only)

368 none C6771A none

HP Outdoor Billboard Paper Blue Back 140 none C7949A:EN none

HP Outdoor Paper 145 none C1730A:EN none

HP Indoor Paper Self-Adhesive 170 none C1733A:EN none

Table 26-8  Graphics Arts/Indoor/Fine Art

Name g/m² 24 in wide 36 in wide 42 in wide

HP Canvas Matte

(Designjet 4020 series only)

340 C7966A:AEN C7967A:AEN C7968A:AEN

HP Canvas Paper 140 gsm

(Designjet 4020 series only)

140 none Q1718A:EN none

HP Canvas Paper 180 gsm

(Designjet 4020 series only)

180 none Q1724A:AEN none

HP Fine Art Paper Aquarella

(Designjet 4020 series only)

240 none Q1703A none

HP Fine Art Paper Cream 140 none Q1709A none

HP Fine Art Paper Sahara 140 none Q1715A:EN none

Table 26-6  Universal Line (continued)
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Ordering accessories
The following accessories can be ordered for your printer.

NOTE: Accessories for the 4000 series are also suitable for the 4500 series, except for the HP
Designjet 4000 Roll Feed Spindle.

Name Product number

HP Jetdirect 630n IPV6 Gigabit Print Server J7997G

HP Jetdirect 635n IPV6/IPSec Print Server J7961G

HP Designjet 4000 printer series High Speed USB 2.0 Card (provides a high speed direct
connection to your printer)

Q5680A

HP Designjet 4020 printer series 512 MB Memory Upgrade (to increase the memory capacity of
your printer to work with complex files)

CM973A

HP Designjet 4000 Roll Feed Spindle 42” (spare spindles ease the process of switching between
different types of roll paper)

Q5675A

HP Designjet 4500 – 42 inch Roll Feed Spindle (spare spindles ease the process of switching
between different types of roll paper)

Q5676A

HP Designjet 4500 Stacker Q5677A

HP Designjet 45x0 Stacker 110V Q5677B

HP Designjet 4520 Scanner CM770A

Serif PosterDesigner Pro for HP software CN088A
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27 Tell me about... (getting help topics)

● HP Instant Support

● HP Customer Care

● HP Designjet Online

● Other sources of information
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HP Instant Support
HP Instant Support is HP's suite of troubleshooting tools that collect diagnostic information from your
printer and match it with intelligent solutions from HP's knowledge bases, allowing you to resolve
problems as quickly as possible.

You can start an HP Instant Support session by clicking on the link provided by your printer's Embedded
Web Server. See Access the Embedded Web Server on page 17.

To be able to use HP Instant Support:

● You must have a TCP/IP connection to your printer, because HP Instant Support is accessible only
through the Embedded Web Server.

● You must have access to the World Wide Web, because HP Instant Support is a Web–based
service.

HP Instant Support is currently available in English, Korean, Simplified Chinese and Traditional Chinese.

HP Customer Care
As your strategic support partner, we make it our business to help keep your business running smoothly.
HP Customer Care offers award-winning support to ensure you get the most from your HP Designjet.

HP Customer Care provides comprehensive, proven support expertise and leverages new technologies
to give customers unique end-to-end support. Services include setup and installation, troubleshooting
tools, warranty upgrades, repair and exchange services, phone and Web support, software updates and
self-maintenance services. To find out more about HP Customer Care, please visit us at:

http://www.hp.com/go/graphic-arts/

or call the phone number in the Customer Service Guide provided with your printer.

What to do before you call:

● Review the “The problem is” troubleshooting suggestions in this guide.

● Review the relevant driver documentation supplied with this printer (for users sending PostScript
files or those using Microsoft Windows).

● If you have installed third-party software drivers and RIPs, refer to their documentation.

● If the problem appears to be related to your software application, first contact your software vendor.

● If you still have difficulty, refer to the HP Support Services booklet provided with your printer. This
document contains a comprehensive list of various support services available to help solve printer
problems.

● If you call one of the Hewlett-Packard offices, please have the following information available to
help us answer your questions more quickly:

◦ The printer you are using (the product number and the serial number, found on the label at
the back of the printer)

◦ The printer's Service ID: select the  icon, and then View printer information

◦ If there is an error code on the front panel, note it down; see “Status codes and error
messages”

◦ The computer you are using
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◦ Any special equipment or software you are using (for example, spoolers, networks, switch-
boxes, modems or special software drivers)

◦ The cable you are using (by part number) and where you purchased it

◦ The type of interface used on your printer (FireWire, USB or network)

◦ The software name and version you are currently using

◦ If the problem is a system error it will have a error number; record the error number and have
it ready

◦ If possible, print out the following reports; you may be asked to fax them to the support center
helping you: Configuration, Usage Report and “all pages above” from Service Information
(see The printer's internal prints on page 192)

HP Designjet Online
Enjoy a world of dedicated services and resources to ensure you always get the best performance from
your HP Designjet products and solutions.

Register at HP Designjet Online, your large-format printing community at http://www.hp.com/go/graphic-
arts/ for unrestricted access to:

● Downloads — the latest printer firmware, drivers, software, media profiles, etc.

● Technical support — online troubleshooting, customer care contacts and more

● Forums for direct contact with the experts, both HP and your colleagues

● Warranty tracking online, for your peace of mind

● Technical documentation and training videos

● Latest product information — printers, supplies, accessories, software, etc.

● Supplies Center for all you need to know about ink and paper

By customizing your registration for the products you have purchased and your type of business, and
by setting your communication preferences: you decide the information you need.

Register at HP Designjet Online for the best performance.

HP Designjet Online is available in English, German, French, Italian, Spanish, Portuguese, Japanese,
Korean, Simplified Chinese and Traditional Chinese.

Other sources of information
More information is available from the following sources:

● The Embedded Web Server provides information about your printer status, technical support,
online documentation, etc.—see Tell me about... (Embedded Web Server topics) on page 187.

● The Printer assembly document that came with your printer

● The HP Designjet 4520 Scanner can be found in the Scanner User's Reference Guide.

● All legal information can be found in a separate document.
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